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Overview   

STARSHIP USER’S GUIDE 
OVERVIEW 

 

¤¤  OOVVEERRVVIIEEWW  

StarShip is a complete shipping solution that supports multiple carriers in one 
user interface while storing shipment history in a central location.  You can rate 
shop between available carriers while shipping to find the most economical 
way to ship your packages.  
StarShip was designed to easily integrate with financial systems, and provides 
the most efficient and error-free way to ship your orders.  It gives you real-time 
access to many financial systems on the market today.  Simply type in the order 
number, and StarShip retrieves the ship-to name and address, P.O. Number, 
ship-via, and more.  StarShip even makes your accounting department more 
efficient by automatically updating orders with freight charges and tracking 
information. This real-time integration allows you to invoice orders immediately 
after they are shipped.    

¤¤  AACCCCOOUUNNTTIINNGG  IINNTTEERRFFAACCEESS  

If you purchased an accounting interface option, you received a separate 
interface guide.  Go through that setup after you complete the instructions in 
this guide. 
Not sure if you have the right interface guide?  You can download the correct 
one from the documentation page on our website.  Just look under StarShip, 
and click on your interface.  Or, contact the Sales Department @ (800)462-
4016. 

¤¤  TTEECCHHNNIICCAALL  SSUUPPPPOORRTT  

Voice: 203-574-1884 
Fax: 203-574-1979 
Email: support@vtechnologies.com 
Hours: 8:30 a.m. to 7 p.m. EST, Monday – Friday 
You can also visit our StarShip support page on the web. 
Have a question?  Check out our FAQs page! 

http://www.vtechnologies.com/support_documentation.html
http://www.vtechnologies.com/support_starship.html
http://www.vtechnologies.com/support_starship_faqs.html
"mailto:support@vtechnologies.com?SUBJECT=StarShip Support"
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STARSHIP USER’S GUIDE 
SYSTEM REQUIREMENTS 

 

¤¤  OOVVEERRVVIIEEWW  

Any system running StarShip should meet the following basic requirements: 

¤¤  SSYYSSTTEEMM  RREEQQUUIIRREEMMEENNTTSS  

ü IBM PC or compatible with 133 MHz Pentium or faster 
ü 800x600 or higher resolution display 
ü Windows 95, 98, ME, NT 4.0, 2000, XP 

§ Windows NT 4.0 requires SP5 or higher1 
ü 64 MB RAM minimum (128 MB recommended) 
ü 40 MB available disk space 
ü CD-ROM drive 
ü Microsoft mouse or compatible pointing device 
ü VGA or higher resolution monitor 
ü Modem connected to analog line 
ü Microsoft Internet Explorer v5.0 or higher2 
ü TCP/IP Network protocol with Static IP Addressing3 
ü LAN connection to Internet4 
ü One free serial (COM) port if using electronic scale 
ü One free serial (COM) or parallel (LPT) port for thermal label printer 
ü Functioning modem driver (see Checking the Modem Driver) 

1 Service Pack 5 for NT 4.0 is available on the StarShip Installation CD in:  
\Redist\WinNT4\SP5 

2 Available on the StarShip CD 
3 Applies only if using the FedEx Internet module.  “Static IP Addressing” means 
that the computer’s IP address does not change. If you are unsure about this 
setting, please ask your Network Administrator for assistance. 
4 Applies only if using the FedEx Internet module.  



The Installation CD   

STARSHIP USER’S GUIDE 
THE INSTALLATION CD 

¤¤  TTHHEE  IINNSSTTAALLLLAATTIIOONN  CCDD  

When you insert the StarShip installation CD into your CD drive, this Welcome 
screen automatically appears.   
  

 
 
(If it doesn’t, the Windows auto-run feature is not enabled.  Run setup.exe from 
the CD.). 

 
¤ INSTALL/UPGRADE STARSHIP 

These options launch StarShip’s installation (for new installations) and update 
programs.  
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¤ INSTALL FEDEX ATOM SERVER 

Installs the FedEx ATOM Server, which communicates via Internet with the FedEx 
servers. 

¤ INSTALL ACROBAT READER 

Select this option if you need additional installations of Acrobat Reader.  It is 
required to view the User’s Guide. 

¤ EXPLORE CD 

Opens the CD folders in Windows Explorer. 

¤ USER’S GUIDE 

This option opens the StarShip User’s Guide.  You need Acrobat Reader installed 
in order to view it. 

¤ INSTALL IE 5.5 

Installs Internet Explorer 5.5 (see Requirements). 

¤ EXIT 

This option closes the Welcome screen. 
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STARSHIP USER’S GUIDE 
FEDEX ATOM SERVER INSTALLATION 

 

Overview The FedEx ATOM Server communicates with the FedEx Servers 
over the Internet.  We recommend installing the ATOM server 
before installing StarShip.   The FedEx ATOM Server must be 
installed on a computer accessible to the StarShip workstation.   
If you use a proxy server, please have the proxy server’s IP 
address or name, and port number available. If you don’t 
know this information, ask your Network Administrator before 
beginning this installation. 

If you are not using the FedEx Carrier Module, please skip to 
StarShip Installation. 

 

# ACTION 

1 Insert the StarShip Installation CD into your CD-ROM drive.  When the 
Welcome screen appears, select Install FedEx ATOM Server from the menu. 

2 On the License Agreement window, click I Agree. 

3 Click Next to begin the installation process.  
Note: Internet Access is required on this computer. 

4 Select the location where the FedEx Atom Server will be installed. 

5 If you use a proxy server, enter the following information: 

• Proxy Host: Proxy Server IP Address or Name 

• Proxy Port: Port Number 

Click Next. 
Note: If you aren’t sure about this information, cancel the installation or ask 
your Network Administrator about these settings. 

6 Click Next to begin the installation. 
You can also click the Back button to re-enter any information. 
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# ACTION 

7 When the installation is complete, click Finish. 
 

 
 

8 Click OK to reboot and Cancel to return to Windows without rebooting.  The 
installation is not complete until you reboot. 
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STARSHIP USER’S GUIDE 
STARSHIP - FIRST TIME INSTALLATION 

 

¤¤  OOVVEERRVVIIEEWW  

StarShip runs on the Windows 95, 98, ME, 2000, and NT operating systems.  Go 
through the steps on the following pages to install StarShip. 

Note: If you are shipping with FedEx, be sure to install the FedEx ATOM Server 
before you install StarShip: FedEx ATOM Server installation. You cannot install the 
ATOM server on the same machine as the FedEx SMS Server. 
 

For more information on installing StarShip multiple times on the same PC, see 
the section Multiple Installations on One PC. 

After completing installation and setup on an initial workstation, follow the 
procedure Multi-User Installation to install StarShip on additional workstations. 
 

To run StarShip Installation program: Place the StarShip CD in your CD-ROM 
drive.  If autorun is enabled on your pc, the Welcome screen appears 
automatically.  If not, run setup.exe from the CD.  Select Install StarShip from the 
menu. 

 

¤¤  TTHHEE  LLIICCEENNSSEE  AAGGRREEEEMMEENNTT  

Read the License agreement. Then, click I Agree. 

 

¤¤  WWEELLCCOOMMEE  

This window gives you guidelines about installation. Click Next. 
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¤¤  SSEELLEECCTT  DDEESSTTIINNAATTIIOONN  LLOOCCAATTIIOONN  

Select the directories to which the StarShip program and its data should be 
installed.   Accept the default directories, or use the Browse button to select the 
directories. (see explanation below)  
 

 

The Program Directory defaults to c:\starw.  For best performance, the program 
directory should be on the local hard drive.   
The Data Directory defaults to c:\starw\data.  You should only change the 
data directory in the following cases: 

• If you have a multi-user version of StarShip, the data directory should be 
located on a server drive that can be accessed by all StarShip users.  
For example, f:\starw or f:\starw\data 

• If you are using a Btrieve interface (used in accounting systems such as 
Macola or Platinum) and the accounting system runs in client/server 
mode.  StarShip must be setup to run in client/server mode so the two 
programs can share data.   
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¤¤  SSEELLEECCTT  CCOOMMPPOONNEENNTTSS  

Select the components you want to install. When you click on each item a 
description will display. 
 

 
If the StarShip GTC is located on another computer and you are sharing it 
between workstations, deselect the StarShip GTC checkbox. 

If you want to install the GTC locally, make sure it is selected. 
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¤¤  CCOOMMPPUUTTEERR  NNOOTT  NNEETTWWOORRKKEEDD  

This dialog box appears if setup detects that your computer may not be 
connected to a network. Follow the instructions and either select or deselect 
the check box. 
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¤¤  RREEGGIISSTTRRAATTIIOONN  IINNFFOORRMMAATTIIOONN  

Type in your registration information and click Next. 
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¤¤  RREEGGIISSTTRRAATTIIOONN  AANNDD  OOPPTTIIOONNSS  KKEEYYSS  

Type in the Registration and Option keys you received from the Sales 
department.  If you are installing a Demo copy, type DEMO in both fields.   

Click Next. 
 

 
Note: If you need Registration and Options keys, contact the Sales Department.  
Please have your UPS Shipper Number available. 
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STARSHIP USER’S GUIDE 
MULTI-USER INSTALLATION 

 

 

To add additional users, simply repeat the installation procedure on that user’s 
computer.  Be sure to specify the same, shared Data Directory for all users.  
Existing data is not overwritten when you install a new user. 
When you run StarShip for the first time on a workstation, it prompts you for the 
station number.  Assign each station a sequential number starting from 0.  Once 
assigned, you should flag StarShip not to prompt for the station number in the 
future so the user won’t inadvertently change it.  The station number is stored in 
the starship.ini file in the Windows directory. 
Each user must complete the setup steps in this guide (except Company 
Setup).  If the user does not have a modem, he can skip the UPS OnLine 
setup.  He can still enter shipments, look at shipment history, and track via the 
Internet.  However, he will not be able to upload shipments. 
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STARSHIP USER’S GUIDE 
MULTIPLE INSTALLATIONS ON ONE PC 

  

You can install more than one copy of StarShip on one PC by redirecting the 
StarShip.ini file.  You may want to do this if, for example, you have multiple UPS 
Shipper Numbers.   
When StarShip starts up, it immediately reads the program and data paths from 
the StarShip.ini file (located in c:\windows).  In order for this .ini file to not be 
overwritten, you have to specify a different directory for the .ini file in the 
second installation so that you don’t overwrite the .ini file from the first 
installation. 
These installations may share a data directory. Or, if you have multiple shipper 
numbers, you need separate data directories. 

 

# ACTION 

1 After performing the first StarShip installation, note the program and data 
directories in the spaces shown below.  You can find your directories by 
launching StarShip, and selecting Help > About > More. 
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# ACTION 

2 Next, create a new directory, using Windows Explorer or DOS, which will 
contain the StarShip.ini file.  For example, “Star1”. 
 

 
 

3 Copy the current StarShip.ini file from the correct Windows directory to the 
new directory you just created.  Again, you can do this using Windows 
Explorer or from a DOS prompt. 

 
 

4 Create a desktop shortcut to the first installation of Starship.  Select Start > 
Programs > StarShip for Windows, right-click on StarShip, and select Copy 
from the pop-up menu. 

5 Right-click on your desktop, and select Paste Shortcut from the context 
menu. 
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# ACTION 

6 Right-click on the StarShip shortcut icon, and select Properties.  In the Target 
field, add the path to the copy of the Starship.ini file to the existing target, 
and then add a final backslash.  Click OK. 

 

7 Now you can install StarShip again using different program and data paths.  
Repeat these steps for each additional installation of StarShip. 
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STARSHIP USER’S GUIDE 
UPGRADING STARSHIP 

 

¤¤  OOVVEERRVVIIEEWW  

StarShip runs on the Windows 95, 98, ME, 2000 and NT operating systems.  Go 
through the steps on the following pages to upgrade StarShip. 

Note: If you are shipping with FedEx, be sure to install the FedEx ATOM Server 
before you install StarShip: FedEx ATOM Server installation 
 
 

To run StarShip Installation program: Place the StarShip CD in your CD-ROM 
drive.  If autorun is enabled on your pc, the Welcome screen appears 
automatically.  If not, run setup.exe from the CD.  Select Install/Upgrade 
StarShip from the menu. 

Please note that your installation might vary slightly from these procedures 
depending upon what is installed on your PC and what options you have 
selected. 

 

¤¤  TTHHEE  LLIICCEENNSSEE  AAGGRREEEEMMEENNTT  

Read the License agreement. Then, click I Agree. 

 

¤¤  WWEELLCCOOMMEE  

This window gives you guidelines about installation. Click Next. 
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¤¤  SSEELLEECCTT  DDEESSTTIINNAATTIIOONN  LLOOCCAATTIIOONN  

Select the directories to which the StarShip program and its data should be 
installed.   Accept the default directories, or use the Browse button to select the 
directories. (see explanation below)  
 

 

The Program Directory defaults to c:\starw.  For best performance, the program 
directory should be on the local hard drive.   
The Data Directory defaults to c:\starw\data.  You should only change the 
data directory in the following cases: 

• If you have a multi-user version of StarShip, the data directory should be 
located on a server drive that can be accessed by all StarShip users.  
For example, f:\starw or f:\starw\data 

• If you are using a Btrieve interface (used in accounting systems such as 
Macola or Platinum) and the accounting system runs in client/server 
mode.  StarShip must be setup to run in client/server mode so the two 
programs can share data.   
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¤¤  EEXXIISSTTIINNGG  SSTTAARRSSHHIIPP  IINNSSTTAALLLLAATTIIOONN  FFOOUUNNDD  

When the existing StarShip Installation is found, choose whether to upgrade or 
install over your existing installation. The window explains what each option will 
do. 
 

 

 
Select an installation type below to continue on to the correct procedure: 

 

⇒ Upgrade your existing StarShip installation 

⇒ Install over your existing StarShip installation 
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UPGRADE EXISTING INSTALLATION 
 

¤¤  RREEGGIISSTTRRAATTIIOONN  IINNFFOORRMMAATTIIOONN  

If the data directory you selected contains registration information from a 
previous installation, you’ll see the following window. Click Next. You may also 
click Back to return to the Select Destination Location and enter a different 
data directory. You may be prompted to enter new registration and option 
keys during the installation. 
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¤¤  SSEELLEECCTT  CCOOMMPPOONNEENNTTSS  

Select the components you want to install. When you click on each item a 
description will appear. You’ll only see this dialog box if you’re upgrading from 
a version earlier than StarShip 7.2. 
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¤¤  UUPPSS  DDIIAALL--UUPP  WWAARRNNIINNGG  

In order to commission and ship with UPS, you need to make sure that your 
modem driver is working properly. If this is the GTC workstation where you will 
commission, you’ll receive this dialog box. 
Even if you are unsure about whether or not your modem driver is working, 
check the box and continue. You will have the opportunity to verify your 
modem driver functionality later, after the installation. 
 

 
 

See also Checking the Modem Driver 
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¤¤  CCOOMMPPUUTTEERR  NNOOTT  NNEETTWWOORRKKEEDD  

This dialog box appears if setup detects that your computer may not be 
connected to a network. Follow the instructions and either select or deselect 
the check box. 
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¤¤  GGEENNEERRIICC  TTRRAANNSSAACCTTIIOONN  CCOOOORRDDIINNAATTOORR  ((GGTTCC))  LLOOCCAATTIIOONN  

This dialog box allows you to enter the computer name or IP Address of the 
computer that has the GTC installed on it. 
 

 
(If you previously installed the GTC locally, you can alternately decide to use 
that previous installation by clicking the check box at the bottom of the 
window.) 
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¤¤  LLOOCCAATTIIOONN  OOFF  FFEEDDEEXX  AATTOOMM  SSEERRVVEERR  [[IIFF  AAPPPPLLIICCAABBLLEE]]  

Where did you install the FedEx ATOM Server? 

⇒ The StarShip GTC workstation: Recommended 
You may not see this option if you chose to install the GTC in the Select 
Components dialog box. 

⇒ This workstation:  If the ATOM server is installed on your workstation, 
select this first option. If you see a message saying that the ATOM server 
is not detected, either you need to install it or it is installed on another 
workstation. 

⇒ Another workstation: Select this option if the ATOM server is on a 
different workstation. You’ll need the IP address of that workstation later. 
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¤¤  FFEEDDEEXX  IINNTTEERRNNEETT  CCLLIIEENNTT  SSEETTUUPP  [[IIFF  AAPPPPLLIICCAABBLLEE]]  

If you chose “Another Workstation” in the previous step, you’ll see this window.  

Enter the IP Address of the computer where the FedEx ATOM Server is installed.  
Read the dialog carefully to determine whether or not you should change 
these settings. Click Next. 
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¤¤  SSEELLEECCTT  PPRROOGGRRAAMM  FFOOLLDDEERR  

Select a Program Manager group or accept the default, and click Next. 
 

 

  

¤¤  SSTTAARRTT  IINNSSTTAALLLLAATTIIOONN  

You are ready to being the installation. Click Next to Start. 
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INSTALL OVER EXISTING INSTALLATION 
 

¤¤  SSEELLEECCTT  CCOOMMPPOONNEENNTTSS  

Select the components you want to install. When you click on each item a 
description will display. 
 

 
 

If the StarShip GTC is located on another computer and you are sharing it 
between workstations, deselect the StarShip GTC checkbox. 

If you want to install the GTC locally, make sure it is selected. 
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¤¤  CCOOMMPPUUTTEERR  NNOOTT  NNEETTWWOORRKKEEDD  

This dialog box displays if your computer is not connected to a network. Follow 
the instructions and either select or deselect the check box. 
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¤¤  RREEGGIISSTTRRAATTIIOONN  IINNFFOORRMMAATTIIOONN  ((DDAATTAA  DDIIRREECCTTOORRYY))  

If the data directory you selected contains registration information from a 
previous installation, you’ll see the following window. Click Next. You may also 
click Back to return to the Select Destination Location and enter a different 
data directory. You may be prompted to enter new registration and option 
keys during the installation. 
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¤¤  GGEENNEERRIICC  TTRRAANNSSAACCTTIIOONN  CCOOOORRDDIINNAATTOORR  ((GGTTCC))  LLOOCCAATTIIOONN  

If you chose NOT to install the StarShip GTC, you will see this window. It allows 
you to enter the computer name or IP Address of the computer that has the 
GTC installed on it. You won’t see this dialog box if you chose to install the 
StarShip GTC when you selected the components to install. 
 

 
If you previously installed the GTC locally, you can alternately decide to use 
that previous installation by clicking the check box at the bottom of the 
window. 
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¤¤  IINNSSTTAALLLL  BBTTRRIIEEVVEE    

This installation dialog will tell you if you need to install Btrieve or not. You won’t 
see this window if you are only installing the GTC (if you don’t select StarShip in 
the Components dialog). 
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¤¤  LLOOCCAATTIIOONN  OOFF  TTHHEE  FFEEDDEEXX  AATTOOMM  SSEERRVVEERR  [[IIFF  AAPPPPLLIICCAABBLLEE]]  

Where did you install the FedEx ATOM Server? 

⇒ The StarShip GTC workstation: Recommended 
You may not see this option if you chose to install the GTC in the Select 
Components dialog box. 

⇒ This workstation:  If the ATOM server is installed on your workstation, 
select this first option. If you see a message saying that the ATOM server 
is not detected, either you need to install it or it is installed on another 
workstation. 

⇒ Another workstation: Select this option if the ATOM server is on a 
different workstation. You’ll need the IP address of that workstation later. 
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¤¤  FFEEDDEEXX  IINNTTEERRNNEETT  CCLLIIEENNTT  SSEETTUUPP  [[IIFF  AAPPPPLLIICCAABBLLEE]]  

If you chose “Another Workstation” in the previous step, you’ll see this window.  

Enter the IP Address of the computer where the FedEx ATOM Server is installed.  
Read the dialog carefully to determine whether or not you should change 
these settings. Click Next. 
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¤¤  SSEELLEECCTT  PPRROOGGRRAAMM  FFOOLLDDEERR  

Select a Program Manager group or accept the default, and click Next. 
 

 

  

¤¤  SSTTAARRTT  IINNSSTTAALLLLAATTIIOONN  

You are ready to being the installation. Click Next to Start. 

 
See also Multi-user installations or Multiple Installations on One PC 
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STARSHIP USER’S GUIDE 
CHECKING THE MODEM DRIVER 

 

¤¤  MMOODDEEMM  DDRRIIVVEERR  

The workstation where the GTC is installed needs to have a working modem 
driver in order for you to commission and ship with UPS. This is because StarShip 
uses the new UPSLink TCP/IP to communicate with the UPS data center. 

 

 
¤ USING THE PHONE DIALER TO CHECK THE MODEM DRIVER 

The Windows operating system includes a Phone Dialer program that uses your 
system’s modem driver. To check if the modem driver is working correctly, use 
the Phone Dialer to call any phone number.  
If you are using Windows XP, see the note at the end of this procedure. 

 

# ACTION 

1 From the Windows Start menu, select Programs > Accessories > 
Communications > Phone Dialer. 

2 Click the Dial button. 

3 Type in a phone number. 

4 Enable the Phone Call radio button. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;285920


Checking The Modem Driver   

# ACTION 

5 Click Place Call. 
 

 
 

6 If the phone call goes through successfully, your modem driver is working. 
If not, please contact your system administrator to make sure you have a 
functioning modem driver. 
 

 
 

 

¤ NOTE: WINDOWS XP USERS 

In Windows XP, the Phone Dialer may not be available from the 
Communications menu.  To run Phone Dialer: From the Start Menu, select Run 
and type dialer.exe. Then, press Enter. 
For more information, see Microsoft’s Knowledge Base. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;285920


  

   
   

   
 
 
 
 
 
 
 
 
 

SSSeeetttuuuppp   
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STARSHIP USER’S GUIDE 
RUNNING STARSHIP FOR THE FIRST TIME 

 

Congratulations! You’ve installed StarShip and now you’re ready to get started. 

This chapter addresses the first time operation of StarShip for each of the 
different scenarios under which you may have installed it. 

⇒ If you upgraded from StarShip v 7.2, you can start to ship once you 
open StarShip. You don’t need to perform any of the extra steps that 
the next pages cover. 

⇒ If you performed a new installation or installed over an existing 
installation, you’ll start with the Company Information dialog box once 
you open StarShip. 

⇒ If you upgraded from a version prior to StarShip v 7.2, you’ll start with the 
Test Modem dialog once you open StarShip. 

First, here is a brief overview of launching StarShip: 

 
¤ HOW TO RUN STARSHIP 

# ACTION 

1 From the desktop, double-click the StarShip shortcut icon. Or, from the 
Windows Start menu, select Programs > StarShip > StarShip. 
The StarShip main toolbar appears. 

 

 
 

 

Continue… 
 

End-of-Day Close 
Run 
Reports 

Open 
Customer List 

Exit StarShip 

Ship 
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¤¤  AAFFTTEERR  LLAAUUNNCCHHIINNGG  SSTTAARRSSHHIIPP  

When you first run StarShip, you are prompted to provide your company 
information.  

 
 

⇒ If you are not shipping with UPS OnLine, click Disable UPS OnLine and 
continue on to Setup.  

⇒ If you are shipping with UPS OnLine, continue to the next section. 
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⇒ For UPS OnLine:  StarShip performs a test to make sure it can 
communicate through your modem.  This happens on only the first 
workstation to run StarShip. 

A dialog box appears, telling you the test is taking place. 

• If the test is successful, StarShip attempts to commission.   

 
• If StarShip cannot communicate through the modem, you are 

prompted for a dialing prefix. If you need a prefix in order to 
“dial out,” type the prefix at the prompt and click OK.  StarShip 
then tries to run the modem test again.   

 
When the test is successful, StarShip will try to commission to UPS. 

Note: Alternately, hardware issues may be causing the problem.  
Please make sure that you are connected to a phone line and 
that your modem driver is functioning.  Need more help? See 
the Checking the Modem Driver procedure.     

 

⇒ When UPS Commissioning is successful: 
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¤¤  WWHHEERREE  TTOO  FFIINNDD  HHEELLPP  

This User’s Guide has all the information you need to set up StarShip and start 
shipping! We’ve also provided an Online Help system that you can access from 
within StarShip’s windows or from the StarShip Help menu. 

This button    gives you quick access to context-sensitive help. 

 

 



  

   
   

   
 
 
 
 
 
 
 
 
 

BBBtttrrriiieeevvveee   SSSeeetttuuuppp   
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STARSHIP USER’S GUIDE 
BTRIEVE SETUP 

 
 

Overview You will only need to change the Btrieve settings if: 
 
§ Other programs on this workstation are running Btrieve 

in client/server mode, but you want StarShip to run in 
local mode. 

§ StarShip is linked to your accounting system using a 
Btrieve interface, the accounting system is using 
client/server mode, and the accounting system is not 
installed on this workstation. 

§ You want to run StarShip in client/server mode, and you 
don’t have any other programs on this workstation 
currently running Btrieve in that mode.  (Note: only the 
local Microkernel engine files are distributed with 
StarShip). 
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Local Mode 
 

Follow these instructions to run Btrieve in Local mode. 

 

# ACTION 

1 Click on Start > Programs > StarShip > Btrieve Setup. 

In the Component drop-down list, select MKDE Interface.   

 
 

2 Under Settings, select Local and make sure the Current setting is Yes.  If 
other programs are using Btrieve in Client/Server mode, it is OK to leave 
Requester set to Yes also.   

 
 

3 Click the Save button, then Exit. 
If you receive error messages because Btrieve is not set up correctly, refer 
to the Troubleshooting section for more information. 

 
 

Note: If you had to make any changes to the Btrieve settings, make sure 
the local engine (W32MKDE) is not loaded.  Press Ctrl + Alt + Delete to 
see if it is still in the Task list, then shut down the PC, if necessary 
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Client/Server Mode 
 

Follow these instructions to run Btrieve in Client/Server mode. 

 

# ACTION 

1 Click on Start > Programs > StarShip > Btrieve Setup. 

In the Component drop-down list, select MKDE Interface.   

 
 

2 Under Settings, select Local and make sure the Current setting is No.   

 
 

3 Then, select Requester and make sure the Current setting is Yes. 

 
 

4 Click Save, then Exit, and restart the workstation engine. 

If you receive error messages because Btrieve is not set up correctly, refer 
to the Troubleshooting section for more information. 
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Note: If you had to make any changes to the Btrieve settings, make sure 
the local engine (W32MKDE) is not loaded.  Press Ctrl + Alt + Delete 
to see if it is still in the Task list, then shut down the PC, if necessary 
Make sure that the files W32BTICM.DLL and WBTRV32.DLL are in the 
system directory (c:\windows\system for Windows, or 
c:\winnt\system32 for NT).  This can be found on the server in the 
WIN32\BIN subdirectory. 
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Troubleshooting Btrieve Setup 
 
 

Btrieve Setup 
(Local Mode) 

If Btrieve is not set up correctly, you will receive the 
following error:  

  

 Error 20 creating or opening the general.dat file when 
you first run StarShip.   
From the StarShip file menu, click on Help > About > 
More and make sure that your StarShip data files are 
installed on a local drive or on a server drive accessible 
by this workstation. 
 
You will also see the current version of the Workstation 
engine.  If the Requester version is shown, then Btrieve is 
setup in Client/Server mode.  If you have both Local 
and Requester set to Yes in the Btrieve Setup and the 
data is on a drive accessible to the server, Btrieve will 
automatically load in Client/Server mode. 
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Btrieve Setup  
(Client/Server 
Mode) 

If Btrieve is not set up correctly, one of two things may 
happen: 

  

       A You receive Error 20 creating or opening the 
general.dat file when you first run StarShip.  This usually 
means that Btrieve is set up to use the Requester, but 
can’t.   
From the StarShip file menu, click on Help > About > 
More and make sure that your StarShip data files are 
installed on a server drive accessible by the Server 
Engine. 
You will also see the current version of the Workstation 
engine and the Requester.  If the Requester version is 
not shown, then Btrieve is not properly set up to use the 
Requester.  If the Requester version is N/A, then the 
Communications Module may not be in the Windows 
System directory.   

  

       B StarShip runs fine, but locks others out of your 
accounting software when you are shipping.  This 
means StarShip is running Btrieve in Local mode.  Make 
sure Btrieve is set up correctly.  Make sure the MKDE 
shuts down and restarts after changing the settings.  
Press Ctrl + Alt + Del to see if it is still in the task list. 
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STARSHIP USER’S GUIDE 
GENERAL SETUP 

 

¤¤  CCOOMMPPAANNYY  

Follow these steps to set up or change company information in StarShip.   

 

# ACTION 

1 From the StarShip main menu, select Setup > Company. 

Type in your company information, and click OK.  The PC that ran StarShip 
for the first time entered the company information at startup. However, you 
can change the information on this tab at any time. 
Note: If you plan to use the FedEx Ship Alert option, your e-mail address is 
required on this tab. 
 

 
 

2 StarShip prompts you to load new zone charts.  Click Yes. 

Go on to the Preferences Setup. 
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¤¤  PPRREEFFEERREENNCCEESS  

Follow these steps to set up StarShip preferences. 

 

# ACTION 

1 From the StarShip main menu, select Setup > Preferences.  If you’re already 
in the Setup window, click the Preferences tab.  Customize COD 
processing, archive settings, audit labels, and AutoPrint.  Click on the Help 
button for information about each setting. 
 

 
 

2 Click OK. 

 
 
 

See Also Setting up AutoPrint 
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¤¤  TTHHIIRRDD  PPAARRTTYY  IINNSSUURRAANNCCEE  

Follow these steps to set up third party insurance, such as PIP. 

 

# ACTION 

1 From the StarShip main menu, select Setup > Third Party Insurance. 
Select a carrier from the drop-down list click Use 3rd Party Insurance.  Then 
enter the discount percentage and maximum value covered by the insurer.  
Do this for each carrier for which you want to use Third Party Insurance. 
 

 
 

2 Select the Insurer tab and enter the name and address of the third party 
insurance company. 
 

 
 

3 Click OK. 
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STARSHIP USER’S GUIDE 
UPS SETUP 

 

¤¤  OOVVEERRVVIIEEWW  

This section discusses the settings you configure during UPS Setup.  
When you finish this chapter, if you are using UPS OnLine, see the next chapter 
for additional UPS OnLine Setup. 
 

To access UPS setup, select Carriers > UPS > Properties from StarShip’s main 
menu. 
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¤¤  GGEENNEERRAALL  TTAABB  

Settings: 
⇒ Shipper Number: You cannot change the Shipper Number from this tab.  

You can only change the Shipper Number with a new registration code. 
If the Shipper Number you see is incorrect, contact the Sales 
Department at 800-462-4016 for a new registration code. 

⇒ Disable UPS Online check box: Only check this box if you are not 
shipping with UPS OnLine. If you enable it, a “Manifest” tab replaces 
the “UPS OnLine” tab. Your selection here decides the setup tabs 
you’ll configure.  We’ve separated UPS OnLine into the next chapter 
because it has its own set of tabs. 

⇒ Apply to basic rates: Here you can apply a percentage Surcharge (+) 
or Discount (-) to standard rates. To do so, select one by using the up 
and down arrows and type in the percentage.  This can be useful for 
adding the fuel surcharge. 

These are the UPS Setup tabs with: 

 
Fig. 1: UPS OnLine disabled 

 
Fig. 2: UPS OnLine enabled 
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¤¤  MMAANNIIFFEESSTT  TTAABB  ((IIFF  NNOOTT  SSHHIIPPPPIINNGG  WWIITTHH  UUPPSS  OONNLLIINNEE))  

Settings: 

⇒ Print MaxiCode on Thermal Labels: When checked, the MaxiCode will 
print on thermal shipping labels. To use this option, you must have 6” 
labels and a compatible thermal label printer. 

⇒ Pickup record #s: Standard, Hundredweight, GroundSaver 

If you use a separate pickup record book for Standard, Hundredweight, 
or GroundSaver shipments, enter the number from the next page of 
your pickup book.  When you start a new pickup record book you need 
to enter this number again. 

 
 

¤¤  TTRRAACCKKIINNGG  TTAABB  

StarShip uses the Next Barcode Reference Number (along with your Shipper 
Number and a service code) when creating a unique tracking number for 
each package.  To use more than one workstation, divide the range of 
reference numbers using the following equation: 

w x (10,000,000/n) 
Where w is the workstation number (numbered sequentially from 0) and n is the 
total number of workstations. 

For example, if you have 5 workstations, and you are setting up workstation #2 
right now, then your equation is  

2 x (10,000,000 / 5) 

So, you should enter a Next Barcode Reference Number of 4,000,000. 
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¤¤  HHUUNNDDRREEDDWWEEIIGGHHTT  TTAABB  

UPS Hundredweight allows you to receive discounted rates for shipments 
weighing less than 1,000 pounds.  UPS Hundredweight Service is for multiple-
piece shipments sent to a single address on the same day and offers 
guaranteed, on-schedule delivery to every address within the 48 contiguous 
states. 
 
Settings: 

⇒ Enable Hundredweight: Check the box to enable it. 
⇒ Search Standard Shipments: StarShip will automatically search through 

standard shipments to try to group them into Hundredweight shipments 
prior to printing the manifest report. 

⇒ Search GroundSaver Shipments: Same as above but StarShip searches 
through GroundSaver shipments (if applicable).  

⇒ Contract/Non Contract: Select Contract if you have a Hundredweight 
service contract with UPS and they assigned you a Tier number.  Select 
Non Contract if you do not have a Hundredweight service contract. 

⇒ Tier: If you selected Contract, enter your Tier number (1-7). 
⇒ Hundredweight Shipper # field: Your UPS Hundredweight Shipper #. 

 

Note: Support for the UPS Smart Label is available in v5.5 and higher.  This 
eliminates the need to print the separate COD tag.  COD information will now 
be included on the bar coded shipping label.  Please see Printer Setup for 
instructions on setting up the bar coded shipping label. 
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¤¤  GGRROOUUNNDDSSAAVVEERR  TTAABB  [[IIFF  AAPPPPLLIICCAABBLLEE]]  

You do not need to set up the GroundSaver tab if you are using UPS OnLine. 
 
Settings: 

⇒ Enable GroundSaver Contract Service: Check this box to have StarShip 
automatically print shipments that meet GroundSaver criteria on a 
separate manifest. 

⇒ Allow Call Tags in GroundSaver: Check this box if you want to use call 
tags for GroundSaver shipments. 

 

 
⇒ If you selected to disable UPS OnLine, you will additionally have the 

GroundSaver Shipper Number field: Enter your UPS GroundSaver Shipper 
Number here. 
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¤¤  CCOODD  TTAABB  

If you ship using a Manifest: Type in any text that you would like to appear on 
the COD tags for Guaranteed and/or Standard COD. 
 

 
 

If you ship using UPS OnLine:  Select a COD Control Number from the drop-
down list. For example, Customer + Invoice numbers (Cust + Inv). This value 
cannot exceed 11 characters. 
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¤¤  IINNTTEERRNNAATTIIOONNAALL  TTAABB  

This applies to UPS International shipments. Check the box if applicable. 
 

 

 

 

See also UPS OnLine Setup 
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STARSHIP USER’S GUIDE 
UPS ONLINE SETUP 

 

¤¤  OOVVEERRVVIIEEWW  

UPS OnLine is an electronic data transfer system that allows shippers to upload 
their Package Level Detail (PLD) directly to UPS when they Close instead of 
printing a manifest report.  The PLD can include customer reference fields so 
your customers can easily track their own packages.  StarShip’s UPS OnLine 
feature also makes it easy for you to track packages.   
 
StarShip supports UPS OnLine for all domestic services (including 
Hundredweight) and International shipments. 
 
UPS OnLine is not available in StarShip’s Demo version. 

To access UPS OnLine setup select Carriers > UPS > Properties from StarShip’s 
main menu. Then, click the UPS OnLine tab. 

 
 

¤¤  CCOOMMMMIISSSSIIOONNIINNGG  OOVVEERRVVIIEEWW  

Before uploading shipments to UPS, you must set up the communication 
parameters and commission with UPS.  Once commissioned, the UPS Data 
Center assigns a unique mailbox ID number, registers your shipper number, and 
assigns electronic book and page numbers.  These numbers increment as PLD is 
uploaded to UPS.   
StarShip currently supports uploading via modem only.  Just the computer that 
performs end-of-day close needs access to this modem.  A dedicated phone 
line is not required because the phone line only needs to be available when 
you perform the end-of-day Close procedure and StarShip attempts to dial out.   

“How to” commission is covered in the Communication Tab section, which is 
next. 
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¤¤  CCOOMMMMUUNNIICCAATTIIOONN  TTAABB  

Settings: 
⇒ Phone Prefix: Enter a dial prefix, if needed.  This is the number(s) your 

company needs to dial for an outside line. For example, 9. 
⇒ Tracking/Time in Transit: Choose how you would like StarShip to conduct 

Tracking and Time in Transit queries. 
o Use Modem: StarShip will dial out using your modem;   
o Use Internet: StarShip will perform inquiries via your Internet 

connection. You will need to be connected to the Internet when 
performing the tracking function. 

⇒ Modem: Displays modem type 
⇒ Commission Status: Shows you if commissioning was successful or not. 
⇒ Commission Values: 

o Mailbox ID (system #) identifies your shipments to UPS when you 
upload at the end of the day, and is visible after commissioning.   

o Current Book and Current Page Number are the equivalent of 
an electronic pick-up record book. 

 
You can see this tab successfully commissioned in the next procedure, How to 
Commission. 
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¤ HOW TO COMMISSION 

 

# ACTION 

1 For this procedure, you should be located at the setup screen in Carriers > 
UPS > Properties > UPS OnLine > Communication.   

Fill in the settings according to the field descriptions. 

2 Click the Commission button.   
StarShip dials out to UPS.  Dialing may occur up to 4 or 5 times. 
 
Commission fields are automatically filled in upon successful commissioning 
and the Commission button now reads “Re-Commission.” 

 

 
CCOOMMMMIISSSSIIOONNEEDD  UUPPSS  WWOORRKKSSTTAATTIIOONN  
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¤¤  RREEFFEERREENNCCEE  FIELDS  TTAABB  

 

Reference fields allow the recipient to track incoming packages using the 
reference field (such as their PO#) along with the ship date or your shipper 
number. Specify the shipment fields you want to include as PLD reference fields 
by selecting them from the drop-down lists. Qualifiers are optional 
alphanumeric fields uploaded to UPS; you can use these fields as you wish. 
These fields are uploaded to UPS at end-of-day processing. 
 

⇒ Package Level Reference Fields and qualifiers 
⇒ Shipment Level Reference Fields and qualifiers 
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¤¤  MMIISSCCEELLLLAANNEEOOUUSS  TTAABB  

 

Use the following procedure to set up the Miscellaneous tab. 
 

# ACTION 

1 Select how you would like the  Ship Monitor to log events: 
o 0 – No Events 
o 1 – Critical Events 

o 2 – All Events 

2 Decide how you would like uploading to occur when you post your 
shipments and upload to UPS: 

⇒ On Post, upload to UPS 
o As a background task… 
o Immediately… 

Or, you can select the “Prompt for Upload Method on post” check box to 
be prompted for a method when you perform an end-of-day Post. 

3 Click the Setup End of Day Report/Label button to configure the UPS Pickup 
Summary.  At end-of-day Close, StarShip prints a Pickup Summary report for 
the driver to sign.  This report can print as a bar coded thermal label, a 2-
page report, or both. 

⇒ Pickup Summary Report:  Enter the number of copies you would 
like printed and click the Report Setup button to set up the printer. 
 

⇒ Summary Label: To set up Summary Label printing, click the Print 
Pickup Summary Label check box and enter the number of copies 
you would like printed. Click the Label Setup button to configure 
the printer.  StarShip can print the label to a port or through a 
driver to an Eltron (TLP/LP+ models) or Zebra Z4000 printer.  For 
more information about setting up printers, including Thermal 
settings, see Printer Setup. 
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STARSHIP USER’S GUIDE 
USPS SETUP 

 

Overview StarShip is MAC certified for domestic shipments.  It also 
supports Delivery Confirmation, which is a separate module 
with additional documentation.  You can access that 
documentation by clicking the link below. 

Take me to Delivery Confirmation!   

 

# ACTION 

1 From the StarShip main menu, select Carriers > USPS > Properties.  On the 
General tab: 
• Disable USPS Option: Removes USPS from the Shipping window. 
• Enable Manifesting: Check this if you are manifesting. 
• Use Old Service Names: The Shipping window will display the old USPS 

Service names. 
• Express Mail Service: Select the type of Express Mail rates you receive. 
• Intl Express Mail Service: Select the type of International Express Mail 

rates you receive. 

2 Click on the Manifest tab.  Use the settings explained below to configure it. 
• Post Office of Mailing: This field is required for manifesting.  Enter your 

City, State, and 5-digit ZIP code. 
• Next Sequence Number: Only edit this field if directed by your Post 

Office or V-Technologies Tech Support. 
• Processing Category: Defaults to Parcels. 
• Class of Mail: Defaults to Mixed. 
• Entry Facility: Used for PVDS mailings (Plant-Verified Drop Shipment)  
• Print Form 3877: This form is required for manifesting. 
• Print Manifest for International Shipments: This field is required for 

manifesting International shipments. 
See also  Manifesting with USPS 
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# ACTION 

3 Click on the Supplementary tab.  USPS Permit Number and DUNS Number 
are required for manifesting. 
 

 
 

4 Click the Labels tab.  If you are manifesting, the Print Indicia on Thermal 
Labels setting is automatically checked. 
• Post Office/Agency: Select Agency if you are manifesting official mail. 

• Print ZIP Bar code on thermal labels: for discounted service when 
Manifesting. 

• Default Thermal Label Type: This is the label that’s used when you are 
neither manifesting nor using Delivery Confirmation.  Include Service 
Header indicates that the Service name is included at the top of the 
label. 

5 Click on the Delivery Confirmation tab to configure options for it.  Read the 
Delivery Confirmation chapter to make sure you have completed all the 
necessary steps outlined by the USPS and for more information about 
settings on the Delivery Confirmation tab. 

6 Click OK to exit. 

 
 

See also Manifesting with USPS 

Delivery Confirmation 
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STARSHIP USER’S GUIDE 
FEDEX SETUP OVERVIEW 

 

¤¤  OOVVEERRVVIIEEWW  

 

V-Technologies offers two shipping solutions for FedEx Express and FedEx 
Ground: 
 

⇒ The basic FedEx module, which includes the FedEx Internet shipping 
option.  FedEx Internet allows you to ship your packages through the 
Internet and produce the bar coded shipping labels locally.  You can 
also track FedEx packages over the Internet.  
When you save a shipment, it is processed (in real-time)on the FedEx 
server using your Internet connection.  Shipment processing time 
depends on the speed of both your Internet connection and the 
FedEx servers.  FedEx creates the tracking number and returns the 
information to print the bar code on your local printer.   
You also have the ability to either rate shipments locally or over the 
Internet.   See the Rating Shipments section for more information.  
 
FedEx Internet shipping is available in StarShip v6.4 and higher.  See the 
Limitations section for more information. 
 

⇒ FedEx High Volume, which uses the FedEx Ship Manager (FSM) Server. 
The FedEx Ship Manager Server (FSM Server) is software developed by 
Federal Express. Before, it was known as the “PowerShip Plus Server” or 
“FXRS (FedEx Remote Server).”  This software works as a Server in the 
background to process transactions and generate tracking numbers 
and bar coded shipping labels.  You can also track packages using 
this interface. 
The FSM Server software was previously included as part of a 
hardware/software solution given to shippers who qualified (100+ 
shipments per day).  FedEx now offers this in software-only format, so 
no minimum quantities apply, and it is directly available from  
V-Technologies.   
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Notes: 
Ø FedEx Express: StarShip v6.4 and higher no longer support the FedEx 

PassPort interface.  Additionally, StarShip v7.1 and higher no longer 
support the FedEx Café interface or shipping with Airbills.  If you have 
any questions, please call the Sales Department. 

Ø FedEx Ground: StarShip no longer supports shipping with FedEx Ground 
Manifest or E-PDI. 

 

¤¤  SSHHIIPPPPIINNGG  MMEETTHHOODD  

 

Select your shipping method to continue with setup: 
 
Ø FedEx Internet 
Ø FedEx High Volume – FSM Server 
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STARSHIP USER’S GUIDE 
FEDEX INTERNET SETUP 

 

¤¤  PPRRIIOORR  TTOO  SSEETTTTIINNGG  UUPP  FFEEDDEEXX  IINNTTEERRNNEETT::    

 

Before setting up StarShip to ship using FedEx Internet, you must first 

1. Install the FedEx ATOM Server if you have not done so already. This is a 
separate installation. See the FedEx Atom Server Installation in this guide 
for more information.  You can run FedEx ATOM Server installation 
directly from the StarShip installation CD main menu. 

Note: If you are installing both the ATOM server and the SMS server, you 
cannot install them on the same machine. 

2. Be sure that the ATOM server information on the Internet > Main tab is 
correct before attempting to subscribe your FedEx Meter. You may 
need to adjust the IP address. If you entered this information during the 
StarShip installation, the FedEx Atom Server information is already filled in 
for you. 

3. Subscribe and receive a Meter # from FedEx as shown in the procedure 
that follows.   
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¤¤  RRAATTIINNGG  SSHHIIPPMMEENNTTSS  

In the following setup procedure, you’ll select how you want to rate shipments.  
This overview explains your choices. 

You have two options when rating shipments in StarShip.  You can a) rate 
locally; or b) rate over the Internet.  During setup, you’ll be asked to select a 
method. 

a) Rating locally means that the price of your shipment is based on 
StarShip’s local rates.  If you’re using a financial system, and want the 
published rates written back to it, you should select this option. 

b) Rating over the Internet means that StarShip retrieves your custom FedEx 
rates in real-time, as you process shipments, from the Internet.  With 
Internet rating, you can select to have shipments rated automatically as 
you enter information on the Shipping window.  Or, you can turn off 
automatic rating and click the “Rate on Internet” button on the 
Shipping window when you want to rate the shipment. 

 

The FedEx Internet setup procedure begins on the next page. You’ll need your 
FedEx Account number.  
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# ACTION 

1 From the StarShip main menu, select Carriers > FedEx > Properties.   
To disable any option shown, click its check box. Disable FedEx Express or 
Ground will remove these options from the StarShip Shipping window and 
End-of-Day Close dialog. Also, if you qualified for Home Delivery with FedEx, 
and have a signed contract, you can leave the Disable Home Delivery 
Service option unchecked. 
Select “FedEx Internet” from the Ship Using drop-down list and type in your 
FedEx Account Number.   
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# ACTION 

2 Click the Internet tab and on the Main tab click the Subscribe button to 
retrieve a meter for your account.  When the Confirm dialog box appears, 
click Yes.  In a moment, you’ll receive a Meter # from FedEx.  When your 
request is successful, click OK.  
Note: See note #2 under Prior to Setting Up FedEx Internet before 
subscribing. 
 

                  
 

If any Company information (Setup > Company) is missing, you will receive 
an error message telling you that Company information is incomplete.  You 
must complete that information before you can subscribe. 

 
After successfully subscribing the FedEx Meter, the Meter # is filled in on your 
Internet tab: 
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# ACTION 

3 Select whether or not to rate locally (see Rating Shipments).  If you want to 
rate locally, enable the Rate Using Local Rate Tables check box. 
 
For the Automatically Rate While Processing Shipments check box: 

⇒ When you select “Rate Using Local Tables,” this box is automatically 
checked and grayed out. When rating locally, StarShip will always 
update the rate information as you enter it on the Shipping window 
because it can rate so quickly. 

⇒ When you rate over the Internet, i.e. you don’t select to rate using 
local rate tables, the following occurs on the Shipping window:  If 
you change a field that affects the rate and have provided enough 
information for the recipient address and the package weight, the 
shipment is re-rated over the Internet as changes occur.  Again, this 
only applies if you don’t rate locally and you check “Automatically 
Rate…”. 
Alternatively, you can decide not to Automatically Rate, and 
instead use the Rate on Internet button in the Shipping window to 
rate shipments over the Internet “on the fly.” 

 

 
 

Briefly, the advantage of rating over the Internet is that it allows you to retrieve 
your specific discounted rate from FedEx. However, if you select to 
Automatically Rate While Processing Shipment, you may have an additional 
delay in shipping when extra information needs to be retrieved. However, you 
can disable that option and use the Rate on Internet button when shipping. 
 
For rating locally, you can write back the published rates to your accounting 
system. You also have the advantage that rates appear more quickly on the 
shipping window. 
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# ACTION 

4 Click on the Reference Field tab.  This tab allows you to select which 
shipment fields are used when creating the Reference Notes for each 
FedEx shipment.  If you choose more than one field, they will be separated 
by a hyphen ("-"). 
• Excluded Fields: These fields are excluded from Reference Notes.  To 

include a field, select it and press the > button.  To select more than 
one field simultaneously, use the Ctrl key while clicking on your 
selections. To select all fields, press the  >> button. 

• These fields are included in the Reference Notes.  To move an item 
from Included Fields back to the Excluded Fields, use the < or << 
buttons. 
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# ACTION 

5 Click the Local Rates tab. 
⇒ The Apply to Basic Rates section applies a percent surcharge or 

discount to the rate table.  You can use this section to apply the 
Fuel Surcharge.  You can also increase or decrease the rates as you 
wish, however, we recommend using the Rate Modifier to make 
those changes. 
Note: This section is only enabled if you selected to rate locally in 
Step 1.   
To select Surcharge (+) or Discount (-), click on the up/down arrows, 
and then type in a percentage.  You can modify this setting at any 
time. 

⇒ If shipping with FedEx Ground, make sure the Residential and Rural 
Residential Surcharges are correct. 
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# ACTION 

6 Click the Local Multiweight Rates tab. 
To use Multiweight with FedEx Internet shipping, you must rate locally and 
have enabled the Rate Using Local Tables check box on the Main tab. 
You also have to check the “Enable Multiweight” and “Search Standard 
Shipments” check boxes.  “Search Standard Shipments” will check all 
shipments for one day and perform a Multiweight grouping during End-of-
Day Close if the total weight meets the requirements. 
Review the Multiweight settings. 
 

 
 

7 Click OK. 
You can now begin shipping with FedEx using the Internet. 

 

See also For a list of all fields sent from StarShip to the FedEx API, see the 

FedEx Internet API Fields Table. 

For more about shipping, see FedEx Shipments. 
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STARSHIP USER’S GUIDE 
FEDEX INTERNET FORMS/PRINTERS SETUP 

To configure Forms or Printers for FedEx Express or FedEx Ground: 
 

# ACTION 

1 From the StarShip main menu, select Ship. 

2 In the Shipping window, select FedEx Express or FedEx Ground from the 
Carrier list and then click the Print button (or press F6). 

3 Select the first entry in the Forms dialog box. Using the steps described in the 
Printer Setup chapter, configure Forms and/or Printers. 
 

 

 
StarShip supports printing to both thermal and label printers for FedEx Internet. 
For information about compatible printers, see the Printers Table list, which is 
also in the Printer Setup chapter. 



  

   
   

   
 
 
 
 
 
 
 
 
 

FFFSSSMMM   SSSeeerrrvvveeerrr   SSSeeetttuuuppp   
 

For FedEx High Volume 
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STARSHIP USER’S GUIDE 
FSM SERVER SETUP 

 

¤¤  FFSSMM  SSEERRVVEERR  RREEQQUUIIRREEMMEENNTTSS  

You should ship an average of 10 packages per day via FedEx Express using the 
FSM Server interface. 

  

Server Any system running the FedEx Ship Manager Server should meet 
the following basic requirements: 
ü Intel Pentium II 350 MHZ or higher 
ü FSM Server version 0612 
ü Windows NT or 2000 
ü Java Runtime Environment 
ü Dedicated Connection (LAN or modem) 
ü 10/100 Ethernet Adapter 
ü High speed CD-ROM drive 
ü Floppy Disk Drive 
ü pcAnywhere version 8.0 or higher* 
ü NetBEUI protocol 
ü 15 “ Monitor with minimum resolution of 1024x768 
ü Eltron Thermal Label Printer (can be on the workstation 

or the server) 
ü 4.2 GB of disk space 
ü Surge Protector 

*Note: Version 10.0 or higher required when using Windows 2000 
with Service Pack 2. 

  

Workstation Shipping workstations require the following: 
ü NetBEUI protocol 
ü StarShip version 7.3b 
ü Eltron Thermal Label Printer (on workstation or Server) 
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¤¤  IINNSSTTAALLLLAATTIIOONN  AANNDD  SSEETTUUPP  OOVVEERRVVIIEEWW  

 
 

In order to install and set up the FSM Server to work with StarShip, follow these 
steps in order: 

1. Obtain a meter number. 

2. Create the FEDEXUSER Administrator account in Windows. 

3. Install the Java Runtime 1.3.1 Environment. 

4. Install FSM Server software. 

Before you begin, please read the Installation notes for additional 
information. 

5. Configure the FSM Server software: 

a. Add a Master Meter number. 

b. Set up reports. 

6. Perform a Data Demand Download. 

7. Set up StarShip. 

Additionally, you can set up documents and commodities for International 
shipments: 

8. International Setup 

 

We recommend printing out this list for reference. 
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¤¤  OOBBTTAAIINN  AA  MMEETTEERR  NNUUMMBBEERR  

 

You can perform these steps online if you have access to the Internet. If you do 
not have Internet access, you may complete the necessary forms on pages 3 
and 4 of the FedEx Customer StartUp Kit. 

 
 

# ACTION 

1 Open Internet Explorer or your preferred web browser.  In the Address field, 
type www.fedex.com/us/ssp. 
 

2 On the Customer Registration screen, type in your FedEx Account Number 
and your Zip/Postal Code as indicated. Press Continue. 

3 At the License Agreement screen, click the I Agree radio button, and press 
Continue.  You may print out the License Agreement for your records by 
clicking the Print button. 

4 Next, type in your customer information, and press Continue. Bold fields are 
required. 

5 On the FedEx Services Software Provider Information screen, select V-
Tech/StarShip from the Provider/Software drop-down list.   Then enter the 
following information: 

• Contact: Ann Smith 
• Contact Phone: 203-574-1837 x210 
• Contact Email: asmith@vtechnologies.com 

6 Answer “Yes” or “No” to the question “Is the third-party device replacing a 
FedEx device at your location?”  If you answered Yes, type in your meter 
number.    

7 Click Submit. 

http://www.fedex.com/us/ssp
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¤¤  CCRREEAATTEE  TTHHEE  FFEEDDEEXXUUSSEERR  AADDMMIINNIISSTTRRAATTOORR  AACCCCOOUUNNTT  

 

You must create an administrator account, normally called FEDEXUSER, on the 
FSM Server PC.  This account is then granted “Log On as a Service” user rights.  
These steps explain how to create and configure this account. 

If you are using Windows 2000, please follow this separate set of instructions:  

Create FEDEXUSER for Windows 2000 

 
¤ CREATE FEDEX USER FOR WINDOWS NT 

 

# ACTION 

1 On the Windows desktop, select Start > Programs > Administrative Tools. 
Note: For Windows 2000, select Start > Settings > Control Panel > 
Administrative Tools. 
 

2 Double-click User Manager for Domains and select the User menu bar. 

3  Select New User. 

4 For Username:, type FEDEXUSER. 

Type in the Full Name and Description (optional). 

5 For Password:, type in and confirm the password FEDEXUSER. 

6 Deselect the User Must Change Password at Next Logon option. 

7 Select the Password Never Expires option. 

8 Click the Groups button. 

9 Highlight Administrators in the Not member of box if it is not already 
highlighted. 

10 Click the Add button to move Administrators to the Member of box. 

11 Click OK. 
You should now see FEDEXUSER under Username in the User Manager box.  
You should also now be back in the User Manager for Domains window. 
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# ACTION 

12 Next, we will give this account the right to log on as a service. 

Click Policies on the menu bar. 

13 Select User Rights. 

14 Select the Show Advanced User Rights option, located at the bottom of the 
User Rights Policy window. 

15 In the Rights field, select Log On as a Service from the drop-down list. 

16 Click the Add button, and then click Show Users. 

17 Choose FEDEXUSER and add it. 

18 Click OK to accept the selection. 

19 Select Exit from the User menu to close the User Manager. 
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¤ CREATE FEDEX USER FOR WINDOWS 2000 

 

# ACTION 

1 On the Windows desktop, select Start > Settings > Control Panel > 
Administrative Tools. 

2 Double-click Computer Management. 

3 In the Tree tab, under System Tools, click on Local Users and Groups. Then, 
click the Users folder. 

4 From the Action menu, select New User.  In the New User dialog, type 
FEDEXUSER in the User name field.  Full name and Description are optional. 

5 Type FEDEXUSER as the password and type it again to confirm. 

6 Deselect the User must change password at next logon check box. 

7 Check the Password never expires check box. 

8 Click the Create button. Then, click Close. 

9 Go back to Local Users and Groups and click the Groups folder. 

10 Double-click Administrators in the right pane. 

11 Click the Add… button.  Scroll down and select FEDEXUSER so that it is 
highlighted, and click Add.  Then click OK. 
You should now see FEDEXUSER in the Administrators list. 

12 Click OK. 

13  Next, we’ll give assign User Rights to the FEDEXUSER account.  Close the 
Computer Management window by clicking the “x” in the top right corner.  
Back in the Administrative Tools window, double-click Local Security Policy. 

14 On the Tree tab, expand Local Policies by clicking on the “+” next to it, and 
select the User Rights Assignment folder. 

15 In the right pane’s Policy list, double-click Log on as a service. 

16 Click the Add… button. Scroll down, highlight FEDEXUSER by clicking on it, 
and click the Add button. Then click OK. 
Now you should see FEDEXUSER in the Log on as a service list. 

17 Click OK. 
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¤¤  IINNSSTTAALLLL  JJAAVVAA  RRUUNNTTIIMMEE  

FSM Server 0611 requires the installation of the Java Runtime Environment 1.3.1. 

Follow the link below to download the installation program, and continue with 
the steps outlined in this procedure. 

 

# ACTION 

1 Open Internet Explorer or your preferred web browser.  In the Address field, 
type http://java.sun.com/j2se/1.3/download.html. You may also click the 
link above to automatically launch this page in your browser. 
 

2 Select the version and click Continue. 
 

 
 

3 If you agree with the terms, accept the License Agreement. 

4 Select a download site and click its FTP Download button. 

5 Select “Save this program to disk,” click OK, and select the local folder 
where you want to save the installation program. 

http://java.sun.com/j2se/1.3/download.html
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# ACTION 

6 Run the installation program and go through the dialogs. 

⇒ If you agree, accept the terms of the License Agreement. 

⇒ Choose a destination location for the installed program. 

The directory may look like this: 

c:\Program Files\JavaSoft\JRE\1.3.1_07 

⇒ Select your Internet browser. 

⇒ Complete the installation. 

7 Navigate to the folder where you just installed the Java Runtime 
Environment and select it. For example, select the “1.3.1_07” folder. 
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# ACTION 

8 Right-click on the folder and select Copy. Then, paste the folder into the 
same directory. 
 

 
 

9 Click once on the copied folder and rename it to “1.3.1”. 
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¤¤  FFEEDDEEXX  SSHHIIPP  MMAANNAAGGEERR  SSEERRVVEERR  IINNSSTTAALLLLAATTIIOONN  

 

Before starting the FSM Server installation, please read the following notes: 

• The FSM Server cannot be installed on the same PC as the FedEx ATOM 
Server.  If you do so, the FSM Server installation detects the presence of 
the ATOM Server and you receive an error message. 

• If Dial-Up Networking (Remote Access Services - RAS) is not installed on 
the PC, you must install it before starting the FXRS Installation.  See 
Appendix C of this User’s Guide for detailed instructions. 

• Once you select options on an FSM Server installation screen, you 
cannot go back to change them. Be sure that you have entered the 
correct information before proceeding.   

• During the installation, the PC may reboot a number of times.  Be sure to 
save any data and close other open programs. 

• You should be logged on to the computer as FEDEXUSER. 

• Check that you have at least 4.2 GB of disk space. 

The following steps show you how to install the FSM Server software.  If you are 
upgrading from a previous version, please see the Upgrading the FSM Server 
procedure. You should exit all other Windows programs before starting the 
installation. 
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# ACTION 

1 Insert the FSM Server CD into the CD-ROM drive.  When the Welcome dialog 
box appears click on Install FedEx Server. 
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# ACTION 

2 When the FedEx Ship Manager Server dialog box appears, click Next. 
 

 
 

3 Installation files are copied to the pc.  You may be warned of an 
impending reboot of your computer. If so, click OK and allow your PC to 
reboot.  
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# ACTION 

4 When the FXRS installation continues, it copies program files, and you can 
monitor its progress. 
 

 
 

5 On this window, you’re required to enter the password that you created for 
the FEDEXUSER account.  Type in the password and then type it again in the 
Confirm field.    

Click Next. 

6 FedEx Services are installed. 
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# ACTION 

7 Select the numeric format of your Meter and Invoices.  Click Next. 
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# ACTION 

8 If you are sure that this is the correct format, click Yes. If not, clicking No 
returns you to Step 5 where you can confirm your selection. 
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# ACTION 

9 Next, select SSP/SOFTWARE ONLY.  Click Next 

 

 
 

10 Next, select either RTF or TXT as the format to use for reports. 
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# ACTION 

11 In the Device ID field, type in the Meter number you received in the Obtain 
a Meter Number procedure.  Leave Device Type as default.  Enter the 
origin phone number.  If you are not connected to a Local Area Network, 
uncheck the LAN Connected option. Also, select a LAN Type. 

Configure Proxy Settings, if necessary.  Click OK. 
 

 
 

The installation completes and your PC will reboot. 
Now, please continue to the FXRS Configuration – Set Up Master Meter section. 
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¤¤  UUPPGGRRAADDIINNGG  TTHHEE  FFSSMM  SSEERRVVEERR  

 

Follow this procedure if you are upgrading from a previous version of the FedEx 
Ship Manager Server 

 

# ACTION 

1 Insert the FSM Server CD into the CD-ROM drive.  When the Welcome dialog 
box appears click on Install FedEx Server. 
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# ACTION 

2 When the FedEx Ship Manager Server dialog box appears, click Next. 
 

 
 

3 Installation files are copied to the PC.  You may be warned of an 
impending reboot of your computer. If so, click OK and allow your PC to 
reboot.  
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# ACTION 

4 When the FXRS installation continues, it copies program files, and you can 
monitor its progress. 
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# ACTION 

5 Setup detects your previous installation, and you must select to either 
Upgrade (previous data is saved) or perform a Clean Load (all data 
deleted). Select Upgrade and click Next. 
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# ACTION 

6 Setup continues copying files. 

You then receive a Reboot warning. Click Yes. 
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# ACTION 

7 After the system reboots, the upgrade process continues. Next, you are 
required to enter the password for FedEx Services (the FEDEXUSER 
password). Click Next. 
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# ACTION 

8 On the Communication Settings dialog box: 
⇒ In the Device ID field, type in the Meter number you received in the 

Obtain a Meter Number procedure.  The Device Type cannot be 
changed. 

⇒ Enter the origin phone number.   
⇒ If you are not connected to a Local Area Network, uncheck the 

LAN Connected option. Select a LAN Type. 

⇒ Configure Proxy Settings, if necessary.  Click OK. 
 

 
 

9 When installation is complete, click Yes to reboot. 
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¤¤  FFXXRRSS  CCOONNFFIIGGUURRAATTIIOONN  ––  SSEETT  UUPP  MMAASSTTEERR  MMEETTEERR  

 

Run the FXRS Configuration Program to set up the master meter number. 

 

# ACTION 

1 From the Start menu, select Programs > FedEx Ship Manager Server > FXRS 
Configuration.  
 

 
 

2 Click Access Privileges and enter the  access password. 
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# ACTION 

3 Click the Add New Meter button.  
 

 
 

4 Type in the meter number you received from FedEx in the Obtain a Meter 
Number procedure.  Click OK. 
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# ACTION 

5 Fill in the remaining fields and click OK. Bold fields are required. If text 
becomes red after you tab out of a field, the data is incorrect and you 
should re-enter it. Below is an example: 
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¤¤  DDAATTAA  DDEEMMAANNDD  DDOOWWNNLLOOAADD  

 

Overview Every first Monday of the month, the server will dial into the 
FedEx mainframe and download the current URSA file.  Rates 
and tracking numbers also trigger their own automatic 
download as certain flags or dates occur.  
Therefore, this procedure only needs to be performed once, or 
if your monthly download fails.   

 
 

# ACTION 

1 Select Start > Programs > FedEx Ship Manager Server > FXRS Demand 
Download. 
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# ACTION 

2 Enable the Domestic Rates, International Rates (if used), and Tracking 
Numbers check boxes by clicking on them. (We’ll do the URSA Table 
download in another step.) 
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# ACTION 

3 Click Start. 
 

 
 

4 When the download is complete, click Exit and then enable the check box 
for the URSA Table Download. Click Start to begin this download.  This will 
take about 10 – 15 minutes. 

5 When the download is complete, click Exit. 
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¤¤  FFXXRRSS  CCOONNFFIIGGUURRAATTIIOONN  --  RREEPPOORRTTSS  SSEETTUUPP  

 

Overview This section shows you how to set up reports with the FXRS 
Configuration tool.  

 

# ACTION 

1 On the desktop, click Start > Programs > FedEx Ship Manager Server > FXRS 
Configuration. 
 

 
 

2 Click on the Reports Setting tab. 
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# ACTION 

3 In the directory field, enter a location to store reports.  You can also 
configure report printer settings by clicking on the printer button. 
 

 
 

4 If you would like to copy the report print settings to other meters, click the 
Copy To All Meters button. The following dialog box appears. Click Yes. 
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¤¤  SSTTAARRSSHHIIPP  SSEETTUUPP  

 

Follow the steps in this chapter to set up StarShip.  Each tab has its own section 
and is described in detail. 

 
¤ GENERAL TAB 

 

# ACTION 

1 From the StarShip main toolbar, select Carriers > FedEx > Properties. 

2 From the General tab, select Ship Using: FedEx Server. 
To disable any option shown, click its check box. Disable FedEx Express or 
Ground will remove these options from the StarShip Shipping window and 
End-of-Day Close dialog. Also, if you qualified for Home Delivery with FedEx, 
and have a signed contract, you can leave the Disable Home Delivery 
Service option unchecked. 

Enter your FedEx Account Number so you can track shipments. Your Meter 
Number is used for actually shipping. 
 

 
  

3 Click the Server tab. Seven sub-tabs become visible; each is described in 
the following sections. 
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¤ SERVER – COMMUNICATION TAB 

 

This tab displays settings that allow StarShip to communicate with the FedEx 
Server. You don’t need to change fields on this tab if the settings are correct. 

 
 

# ACTION 

1 Click the Server Communication tab.  The following information appears: 
⇒ the IP address of the machine that has the FXRS software running on 

it. You can also enter the machine name or click Browse to choose 
the machine from the network. 

⇒ the port number used to communicate with the FedEx Server, which 
is usually 2000. If you are unable to communicate, verify that this 
setting matches the setting on the FXRS Configuration > Systems 
Setting tab. 
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¤ SERVER - METERS 

 

Click the Meters tab to select the "default" meter, which is the meter that is 
used by default when adding shipments in the StarShip Shipping window. The 
buttons on the right hand side of the Meters tab apply to the currently selected 
meter.  

Tip: You can change the default meter “on the fly” from the Details tab on the 
Shipping window.   

 

# ACTION 

1 To add a your primary Meter Number, click Add Meter.  Type the Meter 
Number in the dialog box and click OK. To add additional Meter numbers, 
repeat this step. 
 

 
 

The following are descriptions of other actions that can be performed from the 
Meters tab: 

 

Remove Meter Deletes the currently selected Meter number from StarShip’s 
meter list. 

  

Query Server Use this button to refresh info that has been changed in FXRS 
Configuration. 
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Get Close 
Status 

Last close time for the selected Meter or its current status. 

  

Get Shipment 
List 

This button displays the FedEx Server Shipment List window. It 
allows you to view currently open Domestic or International 
Shipments, and deleted Domestic or International shipments. 

Select from the radio buttons at the top of the window to 
change the shipments that are displayed. 

Limitations: Be aware that FedEx Server currently returns Sender 
Address 1 in the Recipient Address 1 field. 

Below is an example of the Shipment List dialog box: 
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Close Meter When you perform end-of-day Close in StarShip, the Close 
transaction occurs for every meter that has shipments in the 
current shipment file.  Use this button if a close transaction 
fails during normal Close and you want to resend it. 
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¤ SERVER - PRINTING 

When shipping with the FedEx Server, StarShip does not print labels, forms, or 
reports directly.  It sends the printer names and label types defined on this tab 
to the FedEx Server, which performs the printing. 

General Printing Notes 

You should turn off Print on Save in the StarShip Shipping window so that none 
of the local shipping labels or waybill forms print from within StarShip (unless you 
have an additional form such as an audit label that you want to print).  To do 
this, select FedEx as the Carrier in the Shipping window, and click Print.  Select 
the form(s) and uncheck Print on Save. 
Network Printing Notes: 
 

• The FedEx Server must be able to access printers you select on the 
network. Use Windows Explorer to verify that the printer is accessible 
from the FedEx Server PC.  

• When specifying a network printer, the computer and printer names 
may not contain any blanks.  

To print on a network printer, both the FedEx Server PC and the PC with the 
printer attached must have the NetBEUI protocol installed. 

The next steps show you how to set up the Printing tab: 
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# ACTION 

1 Click the Printing tab.  In the Label Printer fields, type the printer location 
and name (in UNC format) of the label printer that the FedEx Server will use 
for Express and/or Ground.  You may also click Browse, select My Network 
Places, and select a printer from the network. (See Network Printing Notes) 

In the Label Printer Type fields, select the type of thermal labels to print. 
 

 
 
Note: Step 2 shows you an example of the Browse window. 
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# ACTION 

2 Do the same for the Form Printer, Laser Printer, if applicable. Or, click the 
Browse button to search for the printer in an Explorer-type window. 

The report printer should be set up from the FXRS Configuration tool.  See 
Reports Setup for more information. 
 

 
 



FSM Server Setup   

¤ SERVER - DANGEROUS GOODS 

This tab allows you to configure Dangerous Goods settings.   

 

# ACTION 

1 Click the Dangerous Goods tab and configure these settings. 
• Packing Type: Enter the packing type of the goods being shipped. 

Required for dangerous goods shipments, unless the dangerous 
goods class is radioactive. 

• Packing Instructions: The packing instruction number from column G, 
I, or K of the IATA DG Regulations Manual. Default is 904. 

• Packing Group: Dangerous Goods/Dry Ice Packing Group 
Valid values: I – Packing Group I, II – Packing Group II, III – Packing 
Group III. Defaults to III.  Entry must be in Roman Numerals. 

• Name of Signatory: Enter the name of the signatory for the 
shipment. 

• Title of Signatory: Enter the Title of Signatory for the shipment. 
Required if IATA regulations apply. 

• Place of Signatory: Enter the place of signatory for the shipment. 
Minimum of City. 

• Responsible Party: Contact person  
• Phone Number: Contact person’s phone number 

Note: Dry Ice or Dangerous Goods settings must be configured here before 
trying to select the Dry Ice option from the Shipping window or the following 
error message appears: 
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¤ SERVER - MISCELLANEOUS 

This tab configures FedEx Express and Ground rates, and other miscellaneous 
settings. 

 

# ACTION 

1 Click the Miscellaneous tab.   

If you do not want to give your FedEx rate discounts to customers, deselect 
the check box. More information is available about modified rates in the 
Rate Utility chapter. 
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# ACTION 

2 When checked, the Use Electronic COD for Ground COD shipments setting 
causes Electronic COD to be enabled by default for FedEx Ground COD 
shipments under Package Options in the Shipping window. You can 
change this value from the Ship screen under Package Options > C.O.D.  

 
 

 
 

Note: You must enable the ECOD option for your meter in the FXRS 
Configuration tool or you will receive an error when you save the COD 
shipment. This option is located on the Meter Settings tab under Ground 
Options: 
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# ACTION 

3 Default Sender to Meter Address set in FXRS Configuration: 

When checked, the Sender address on the StarShip Shipping window 
defaults to the address last retrieved from the server. If it is not checked, 
Starship uses the Company address. If you saved a Sender address with 
your default Shipping window values, that address is used.  

4 COD Remittance Address Use: 

Select the address where funds that are collected for COD shipments are 
sent. 

⇒ Company Address: The company and address information you 
entered in Setup > Company (in StarShip). 

⇒ Sender Address: The address listed on the Sender tab on the 
Shipping window, which may vary from shipment to shipment. 

5 Ground Option/Surcharge: 

This grid allows StarShip to separate individual surcharges from the total 
surcharge amount in order to populate the Shipping window correctly for 
FedEx Ground shipments. These values are initially set to the standard rates. 
Click the “Query server to update surcharge values” button to acquire the 
latest surcharge values. 
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¤ SERVER - EXPRESS REFERENCE 

 

This tab allows you to select which shipment fields are used when creating the 
Reference Notes for each FedEx Express shipment.  If you choose more than 
one field, they will be separated by a hyphen ("-"). 

 
 

# ACTION 

1 Click the Express Reference tab.  From the Excluded Fields column, select 
the fields you want to include and click the > button.  To select more than 
one field at once, use the Ctrl key while clicking your selections.  To include 
all fields in the Excluded Fields list, click the >> button. 
 

 
 

2 To move an item from Included back to Excluded, use the < and << 
buttons. 
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¤ SERVER – GROUND REFERENCE 

 

This tab allows you to configure Package and Shipment Level Reference, with 
options for Multiweight and tracking. 

 

# ACTION 

1 Click the Ground Reference tab. The first section deals with Shipment Level 
Reference. Use these field descriptions to make your selections. 

⇒ PO Number: Field sent as PO Number for the Shipment Level. 
Cannot have both shipment and package level PO Number. This 
value will only be sent if the value assigned for package level PO is 
blank. 

⇒ Invoice Number: Field sent as Invoice Number for the Shipment 
Level reference. Cannot have both shipment and package level 
Invoice Number. This value will only be sent if the value assigned for 
package level Invoice is blank. 

⇒ Customer Ref: Field sent as Customer Reference for the Shipment 
Level reference. Cannot have both shipment and package level 
Customer Ref. This value will only be sent if the value assigned for 
package level Customer Ref is blank. 

2 The second section deals with Package Level Reference. These settings are 
used if there is only one package in the shipment or you have set the 
Shipment Level Reference to “None”. 

⇒ PO Number: Field sent as PO Number for the Package Level 
reference. 

⇒ Invoice Number: Field sent as Invoice Number for the Package Level 
reference. 

⇒ Customer Ref: Field sent as Customer Reference for the Package 
Level reference 

3 Finally, configure these settings: 
⇒ Package ID on Multiweight Reports: Choose PO Number, Invoice 

Number, or Customer Reference. 
⇒ Package level reference used for tracking: Choose a combination 

of two reference values. 
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STARSHIP USER’S GUIDE 
FEDEX SHIP MANAGER SERVER TROUBLESHOOTING 

 

If you encounter problems, FedEx may need access to the PC in order to solve 
them.  If so, use this section to set up the pcAnywhere software and launch the 
FedEx session. 

¤¤  PPCCAANNYYWWHHEERREE  SSEETTUUPP  

# ACTION 

1 From the Start menu, select Programs > Symantec pcAnywhere.  

2 Verify that “Hosts” is selected on the toolbar, and then double-click Add 
Host. 
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# ACTION 

3 In the New Host window, check Modem in the Device List. It is OK to leave 
TCP/IP checked. 

4 Click the Callers tab, and then click the New Item icon. 

5 In the New Caller window type in FEDEXUSER as both the login and 
password. This is the login that the FedEx Representative will use to log in to 
your computer.  
 

 
 

6 Click OK. Beneath the icon for the new host you just set up, type in FXRS to 
name this connection. 
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# ACTION 

7 If you would like to set up the PC to record the pcAnywhere sessions, select 
Tools > Options and check the “Record host session for later playback” 
setting. 

8 Right-click on the FXRS icon, and select Launch Host from the pop-up 
menu. 
 

 
 

 You will see an icon in your system tray indicating pcAnywhere is waiting for 
a connection.  The machine is now ready for FedEx to configure it. 
 
Please continue to the next section, Launching a FedEx Session. 
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¤¤  LLAAUUNNCCHHIINNGG  AA  FFEEDDEEXX  SSEESSSSIIOONN  

 

Overview This procedure allows FedEx to configure your PC for shipping 
with FSM Server.  Before beginning, make sure FSM Server CD is 
still in the drive. 

 

# ACTION 

1 Contact your V-Technologies support technician.  
Please have the following information ready: 

• FedEx Meter Number 
• Phone number connected to the modem into which FedEx will dial 
• Directory location on your server where Reports should be stored 
• Whether you will be shipping International 
• Name and Phone Number of contact person at your location 

 

2 When the FedEx representative dials in, the icon will change indicating an 
active session. You’ll also see the FedEx activity on your screen. 

 
 

3 When finished, the FedEx representative will disconnect from the PC. 
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STARSHIP USER’S GUIDE 
AIRBORNE EXPRESS SETUP 

 

Overview The standard Airborne Express module includes: 
 

• The Airbills option:  
Supports published rates and prints to tractor-feed 
Airbills;  

• The Airborne Linkage option:  
Supports custom rates, upload files for billing, and 
printing bar-coded shipping labels to a thermal printer.  
Currently allows you to ship domestic and to Puerto 
Rico and the Virgin Islands.   
Note: If you ship International, including Canada, you 
will need to set up and use airbills for your international 
shipments. 
 

Click on the appropriate link below depending upon your 
shipping method: 

 

⇒ Ship Using Airbills 

⇒ Ship Using Airborne Linkage 
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Set Up Airbills 
 

Overview Follow this procedure if you want to ship using Airbills.  

 

# ACTION 

1 From the StarShip main menu, select Carriers > AEX > Properties.  On the 
General tab, configure the following settings: 
• Disable Airborne Express Option: Removes Airborne Express from the 

Shipping window. 
• Account Number: Type in your Airborne Express Account Number. 
• Ship Domestic Using: Select Tractor-Feed Airbills from the drop-down list. 
• Maximum Weight for Next Afternoon Service: The current default weight 

is listed.  You can edit this information later if the weight limit for this 
service changes. 

2 Click on the Airbills tab and configure it as follows: 
• Apply to basic rates: Applies a percent surcharge or discount to the 

rate table. To select a Surcharge (+) or Discount (-), click the up/down 
arrows and type in a percentage. You can modify this setting at any 
time.  You should use this setting for the fuel surcharge.  The fuel 
surcharge can change on a monthly basis -- check the Airborne Express 
web site for the latest percentage. 

• Domestic Airbills, Domestic COD Airbills, and International Airbills:  
Provide the next tracking number for each type of Airbill in each field. 

 

3 Click OK to exit. 
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Set Up Airborne Linkage 
 

Overview Follow this setup to ship with the Airborne Linkage.  With the 
Airborne Linkage option, you can install rate, routing, and time in 
transit files directly from Airborne.  Other features include rating 
shipments, printing bar-coded thermal shipping labels, and 
generating upload files for billing. 

Software requirement:  

• StarShip v7.2 or higher 

Hardware requirements:  

• thermal label printer (see Printer Setup) 

• Internet access   

 

In order to use the Airborne Linkage option, you must: 

 
1. Complete the Airborne Linkage Request Form. 
2. Obtain the Customer Linkage Setup Sheet. This 

information is provided by Airborne. 
3. Download rate, route and transit time files to the StarShip 

PC and save them to a directory of your choice. If you 
received these files on a diskette from Airborne, have the 
diskette handy. 
You can also download these files from the Airborne 
Express website. 

4. Set up StarShip. 
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Set up 
StarShip 

Follow these steps to configure StarShip to use the Airborne 
Linkage option. 
Note: Even if you are using the Airborne Linkage option to ship, 
you must configure Airbills if you plan to process International 
shipments. 

 

# ACTION 

1 From the StarShip main menu, select Carriers > AEX > Properties.  On the 
General tab, configure the following settings: 
• Disable Airborne Express Option: Removes Airborne Express from the 

Shipping window. 
• Account Number: Type in your Airborne Express Account Number. 
• Ship Domestic Using: Select Airborne Linkage from the drop-down list. 
• Maximum Weight for Next Afternoon Service: The current default weight 

is listed.  You can edit this information later if the weight limit for this 
service changes. 

2 Click the Airbills tab if you will be processing International shipments and 
configure the following settings:   
• Apply to basic rates: Applies a percent surcharge or discount to the 

rate table. To select a Surcharge (+) or Discount (-), click the up/down 
arrows and type in a percentage. You can modify this setting at any 
time.  You should use this setting for the fuel surcharge.  The fuel 
surcharge can change on a monthly basis -- check the Airborne Express 
web site for the latest percentage. 
Note: Surcharges for Linkage are defined by Airborne in the Rate File. 

• International Airbills:  Provide the next tracking number for International 
Airbills. 

3 Click on the Airborne Linkage tab.  On the Setup Sheet sub-tab, type in the 
information from your Customer Linkage Setup sheet. 
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# ACTION 

4 Click the Rate Files sub-tab.  You should have already downloaded or 
received the Rate files from Airborne. Press the corresponding button to 
load each of the following files: 

a) Air/Ground File: Click Load New Rate File.  Then, navigate to the 
directory where you saved the rate file and select it.  Click Open.  

 
If you have successfully loaded the file, the following status message 
appears: 

 
 

Repeat this for the remaining files: 

b) Route File: Click Load New Route File.  You can navigate to the 
directory where you stored the route file and select it. Click Open. 

 
 

c) Time in Transit File: Click Load New Time in Transit File. You can 
navigate to the directory where you stored the Time in Transit file 
and select it. Click Open. 
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# ACTION 

5 For each type of file, you can enable the “I have been notified by 
Airborne…” check box and enter a date for the current file to expire.  
Airborne will notify you when a new file is required. 

To enter a date you can either type the date directly into the field or click 
the arrow and select a date from the pop-up calendar. 
 

 
 

6 Click the Additional Label Info tab.  This is the information that will appear 
on the thermal shipping labels in the Additional Info area. 

For each additional field that you would like to appear, type in a text label 
and select which shipment field information to include from the drop-down 
list. 
 

 
  

7 Click on the Remittance Information tab and enter the Name and Title for 
the Airborne Representative from your Customer Linkage Setup Sheet.   
 

 
 

8 Click OK to exit setup. 
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Additional Information for Airborne Linkage 
 

Printer 
Setup 

The Airborne Linkage option supports printing of bar coded 
thermal shipping labels to the following printers: 

• Eltron TLP/LP + 
• Zebra S500/Z4000 

See the general Printer Setup section for instructions about how 
to set up your printer and configure thermal settings in StarShip. 

  

Updating 
Rate Files 

Airborne will notify you with the date that new Rate Files will be 
distributed.  When you have this information, go to Carriers > AEX 
> Properties, click on the Airborne Linkage tab and then the Rate 
Files tab. Click on the relevant Rate File button, for example 
“Route File,” and set the expiration date to the date that 
Airborne gave to you.   
 

 
 
Later, when you receive the new files from Airborne, load the 
new rate files as we showed you in Step 4 of Airborne Linkage 
setup. 
Note: If a new Rate File has not been installed as of the 
expiration date, StarShip will no longer allow the user to ship 
Airborne. 
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STARSHIP USER’S GUIDE 
SPEE-DEE SETUP 

 

Overview Follow these instructions to set up the Spee-Dee carrier. 

 

# ACTION 

1 From the StarShip main menu, select Carriers > Spee-Dee > Properties. 
On the General tab, type in your Account Number.  You can also select a 
default carrier if the ZIP code is not serviced by Spee-Dee.   
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# ACTION 

2 Click the Tracking Labels tab.  Configure it using the setting descriptions 
below. 

 
 

• Increment Tracking Numbers: Check this box for StarShip to 
automatically roll the tracking numbers as shipments are saved. 

• Print Address on Thermal Label: Check this box if you want the return 
and Ship To address to print on the thermal shipping label for Spee-
Dee. When not checked, only the tracking bar code will print. 

• Next Barcode Reference Number: To be set for the printing of bar 
coded labels.   

• Configure Next Barcode Reference Number: To use more than one 
workstation, divide the range of tracking numbers using the following 
equation: 
w x (100,000,000/n) 
Where w is the workstation number (numbered sequentially from 0) 
and n is the total number of workstations. 

3 Click the Rates tab.  The Rates tab applies a percent surcharge or discount 
to the rate table.  You can modify this percentage at any time. 

 

4 Click OK to exit. 
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STARSHIP USER’S GUIDE 
INTERNATIONAL SETUP 

 
¤¤  OOVVEERRVVIIEEWW  

Before you can process International shipments, you must configure StarShip as 
shown in the following steps. This chapter includes general and carrier specific 
instructions for setting up and maintaining International Commodities and 
Documents. 

 

¤¤  CCOOMMMMOODDIITTIIEESS  

StarShip maintains a list of the commodities you ship for international shipments. 
Adding entries to the commodities list allows you to easily ship commodities 
multiple times.   

 
¤ ADD COMMODITIES 

 

# ACTION 

1 From the StarShip main toolbar, select Setup > International > Commodities. 

 
 

This Commodities window is also accessible from the StarShip Shipping 
window when you process an International shipment.  Click here for more 
information. 
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# ACTION 

2 Enter the Commodity ID, which is the unique identifier for this Commodity 
entry.  

 
When adding a new commodity, the status bar reads “NEW.” 
 

 Use the following descriptions of the fields on each tab to create new 
commodities. Blue fields are required: 

 

General tab • Description: Description of the Commodity 

• Unit of Measure: The unit of measure for the 
commodity.  

• Unit Value: This is the selling price, or cost if not 
sold, of the commodity. This is also the unit value 
of a commodity on the Commercial Invoice. 

• Currency Code: Three-character currency code 
used to represent global currencies. 

• Unit Weight: Unit weight of the commodity 
corresponding to the Unit of Measure. 
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Continued … 

• Harmonized Code: This is the 10-digit Schedule B 
Number or Harmonized Tariff Schedule Number 
for the commodity being exported. 

• Country of Manufacture: Select the country 
from the drop-down list. 

• Part Number: Additional information regarding 
this particular commoditiy. 

• Marks/Numbers: An identifying mark or number 
used on the packaging of a shipment to help 
customers identify a particular shipment. 

  

FedEx SED Select Shipper's Export Declaration (SED) Type: 
Ship Using Commerce Export License: 

• Export License Number: Commerce Export License 
Number for this commodity. 

• Expiration Date: The date on which the validated 
license number expires. 

• ECCN: The applicable Export Control Classification 
Number. 

Ship Using License Exception: 
• License Exception Symbol: A license exception is a 

specific grant of authority by the government to 
exporters for certain categories of products that 
would otherwise require an export license. Select 
from the drop-down list. 

• ECCN: The applicable Export Control Classification 
Number. 

Ship Using SED Exemption 
• FTSR Exemption Number: The Shipper’s Export 

Declaration (SED) Exemption ID number for the 
shipment. 

Ship Using None 
• SED not required or Shipper prepares SED 
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UPS SED SED Required: When checked, fill in these fields: 
• Export License Number: Commerce Export License 

Number 
• Expiration Date: The date on which the validated 

license number expires. 
• ECCN: The applicable Export Control Classification 

Number. 
• Schedule B Units/UOM: Report whole units (s) as 

specified in the Schedule B code. You can select 
Units of Measure from the drop-down list. 

• Schedule B Code: U.S. Export Commodity Code that 
represents the commodity contained in the invoice 
line, as indicated on the SED. 
 

License Exception: When checked, fill in these fields: 
• License Exception: A license exception is a specific 

grant of authority by the government to exporters for 
certain categories of products that would otherwise 
require an export license. Select an entry from the 
drop-down list. 

• ECCN: The applicable Export Control Classification 
Number. 

• Schedule B Units/UOM: Report whole units (s) as 
specified in the Schedule B code. You can select 
Units of Measure from the drop-down list. 

• Schedule B Code: U.S. Export Commodity Code that 
represents the commodity contained in the invoice 
line, as indicated on the SED. 
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UPS 
Certificate of 
Origin 

Certificate of Origin:  Choose the type that applies to this 
commodity - Standard, NAFTA, or None 
NAFTA information: 

• Net Cost Method: This method calculates the 
regional value content as a percentage of the net 
cost to produce the good. Net cost represents all of 
the costs incurred by the producer minus expenses 
for sales promotion (including marketing and after-
sales service), royalties, shipping and packing costs 
and non-allowable interest costs.   

o From [date] To [date]: A Certificate of Origin 
may cover goods imported over not more 
than a twelve-month period. 

• Producer: Select the producer type for this good. 
• Preference Criterion: There are six preference criteria, 

A through F.  Refer to Article 401 of the NAFTA and 
Annex 401. 

 

For more information, visit NAFTA on the web. 

http://www.nafta-customs.org/
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¤ MODIFY/DELETE COMMODITIES 

You can also modify or delete entries in the commodities list.   

 

# ACTION 

1 From the StarShip main toolbar, select Setup > International > Commodities. 

 
 

This Commodities window is also accessible from the StarShip Shipping 
window when you process an International shipment.  Click here for more 
information. 
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# ACTION 

2 Enter the Commodity ID and press Tab.  You can also press Open to browse 
a list of commodities, or use the navigation arrow buttons to page through 
available commodities. 
 

 
When editing a commodity, the Status bar reads “EDIT”. 

3 Make any necessary edits to the information for this commodity and press 
Save.  If you would like to delete this commodity entry, press the Delete 
button. 
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¤¤  DDOOCCUUMMEENNTTSS  

StarShip maintains a list of the documents you ship for documents-only 
international shipments.  Adding entries to the documents list allows you to 
easily ship documents multiple times.     

 

¤ ADD DOCUMENTS 
 

# ACTION 

1 From the StarShip main toolbar, select Setup > International > Documents. 

 
 

This Documents window is also accessible from the Shipping window while 
processing an International shipment.  Click here for more information. 
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# ACTION 

2 Type in the  
• Document ID: Unique identifier for this document entry. 
• Description: Description of this document. 
• Country of Manufacture: Select a country from the drop-down list. 

 
When adding a new document, the status bar reads “NEW.” 

3 Press Save. 
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¤ MODIFY/DELETE DOCUMENTS 

You can also modify or delete entries in the documents list.   
 

# ACTION 

1 From the StarShip main toolbar, select Setup > International > Documents. 

This Documents window is also accessible from the StarShip Shipping 
window when you process a documents-only International shipment.  Click 
here for more information. 

2 Enter the Document ID and press Tab.  You can also press Open to browse 
a list of documents, or use the navigation arrow buttons to page through 
available documents. 
 

 
When editing a document, the Status bar reads “EDIT”. 

3 Edit the information for this document and press Save.  To delete this 
document, press the Delete button. 

 

 

See also  International Shipments 
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STARSHIP USER’S GUIDE 
HAZARDOUS MATERIALS PROFILES MAINTENANCE 

 

¤¤  OOVVEERRVVIIEEWW  

The Hazardous Materials Profiles Maintenance allows you to maintain 
hazardous materials data for UPS and FedEx. 

¤¤  UUPPSS  NNOOTTEESS  

UPS/Masterform: 
If you are using the Masterform interface in conjuction with UPS, please refer to 
the  Masterform Interface guide you received for Setup and Shipping 
procedures. You can also download this interface guide (making sure to save it 
to your main StarShip directory) on the V-Technologies website. 
UPS/Other Interface: 
You are free to use any UPS approved hazardous materials software to 
generate your hazardous documentation.  However, you have to enter the 
Hazardous Materials information for UPS, as shown in this chapter, so that the 
proper information can be generated for those documents.  

¤¤  HHAAZZAARRDDOOUUSS  MMAATTEERRIIAALLSS  PPRROOFFIILLEESS  IINNTTEERRFFAACCEE  

To access the Hazardous Materials database, go to the StarShip main menu 
and select Setup > Hazardous Materials > Hazardous Materials Profiles. 
Use the Navigation toolbar to create new entries, open existing entries, save a 
new entry, delete an entry, or exit the Maintenance dialog. The arrow buttons 
will bring you to the first, previous, next, and last entry, respectively. 
 

 
 
Begin by entering the HazMat Profile ID and then continue to the next sections. 

http://www.vtechnologies.com/support_documentation.html
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¤ GENERAL (UPS) TAB 

These are the field descriptions for the General(UPS) tab. Blue fields are 
required. 
 

⇒ Regulation Set: The Regulatory set associated with every regulated 
shipment. Valid values are: 
 
o "ADR" = Europe to Europe Ground Movement 
o "CFR" = HazMat regulated by US Dept of Transportation 
o "IATA"= All Worldwide Air movement 
o "TDG"= Canada to Canada ground movement 

 
⇒ Proper Shipping Name: The proper shipping name assigned to every 

regulated good. 
 

⇒ Class or Division Number: U.S DOT Hazard Class or Division; Describes 
the nature of a regulated good. Refer to “Code of Federal 
Regulations 49, 172.101 – Hazardous Materials Table” and/or UPS 
Chemical Table in “Guide for Shipping Ground and Air Hazardous 
Materials.” Available at www.ups.com/using/services/accs/hzm-
guide.html). 

 
⇒ Units: The unit of measure used for the mass capacity of a regulated 

substance. 
 

⇒ Quantity: The mass/capacity of a regulated substance. 
 

⇒ Package Type: Required if Regulation Set ="IATA." The type of 
package used to contain the regulated good.  Each hazardous 
material has an associated package authorization reference that 
relates to the specific section of 49 CFR 173, which lists the authorized 
inner and outer componenets of performance packaging. 

 
⇒ Package Instructions: A code that identifies the IATA Packing 

Instruction from column G, I, or K of the IATA DG Regulations Manual 
for a dangerous good. Required if Regulation Set ="IATA".  

www.ups.com/using/services/accs/hzmguide.html
www.ups.com/using/services/accs/hzmguide.html


Hazardous Materials Profiles Maintenance   

 
⇒ Emergency Phone Number: 24 Hour Emergency phone number 

information. Required when Regulation Set = TDG.  
 

⇒ Identification Number: The identification number assigned to a specific 
regulated good. See CFR 49 and/or UPS HazMat Guide. 

 
⇒ Packing Group/Type: This number indicates the potential degree of 

danger associated with the transportation of this regulated good. The 
highest group is Group I (great danger); Group II is next (medium 
danger), while Group III chemicals present the lowest hazard (minor 
danger). See CFR 49 and/or UPSHazMat Guide. 

 

 
 

UPS Notes: 
⇒ With the exception of shipments containing dry ice, hazardous 

materials packages must not exceed 70 lbs gross weight. Lower limits 
apply to certain materials. 

⇒ UPS requires shippers to affix an authorized UPS Shipping Paper to 
each hazardous material package and to complete an entry in the 
UPS Shipper’s Certification of Hazardous Materials for each package. 
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¤¤  FFEEDDEEXX  DDAANNGGEERROOUUSS  GGOOOODDSS  

 
The following are field descriptions for the Hazardous Materials FedEx tab. Blue 
fields are required. 
 
This information is also accessible from the Shipping window while processing 
Dangerous Goods shipments. For more information about Dangerous Goods 
shipments with FedEx, see the Shipments section 
 

⇒ Dangerous Goods Type: Selections are 
 
o Not Infectious or Radioactive 
o Infectious – if selected, the A81 Indicator check box is enabled. 

 
⇒ Technical Name: Technical description of the dangerous goods being 

shipped. Note: Required if the proper shipping name of the dangerous 
good ends in ‘ * ’ in the IATA Dangerous Goods Regulations Manual.  

 
⇒ UN ID Number: Enter the UN ID number of the DG that is being 

shipped. 
 

⇒ Authorization: The authorization of the DG being shipped. 
 

⇒ Additional Handling Info: Additional handling information that may 
apply to a dangerous goods shipment only. 

 
⇒ Aircraft Only: Required if a Cargo Aircraft packing instruction from IATA 

DG Regulations Manual is used.   
 
 
 
 
 
Continued… 



Hazardous Materials Profiles Maintenance   

 
⇒ A1, A2, A51, A109 Flag: Check to indicate dangerous goods are being 

shipped under one of the special provisions (A1, A2, A51, A109) listed 
in the IATA Regulations Manual.  

 
⇒ A81 Indicator: Select if shipping infectious dangerous goods. 

 

 

 

 

See also:  
⇒ UPS Hazardous Shipments 
⇒ FedEx Internet – Dangerous Goods Shipments 
⇒ FedEx Server – Dangerous Goods Shipments 
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STARSHIP USER’S GUIDE 
PRINTER SETUP 

 

¤¤  OOVVEERRVVIIEEWW  

Follow these instructions to set up StarShip printers for carriers.  See the Printers 
Table for an explanation of compatible printers. 
In StarShip, you set up printers for each carrier individually.  You can print 
thermal bar-coded shipping labels for UPS Domestic and International, FedEx 
Express and Ground, USPS, and Spee-Dee shipments.   

 

# ACTION 

1 From the StarShip main toolbar, click the Ship button to access the Shipping 
window. Then, select a carrier from the carrier drop-down list, and press F6 
or the Print button.   

                                    
 

2 When the carrier-specific Forms dialog box appears, select the form you 
want to set up, and click the Printers button. 

 
Note: The first row of the Carrier Forms box is reserved for COD labels (except 
when shipping with FedEx Express, FedEx Ground, or UPS).   Do not edit this form 
name.  
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# ACTION 

3 Select to Print Direct to Port or Print through Driver. 
  

 
 

For Print Direct to Port: 
These printers can be set on a parallel (LPT) or COM port.  If you select a 
COM port, click the Ports button.  Set up the parameters as follows: 
 

OPTION FOR ELTRON FOR ZEBRA 
Baud Rate 9600 9600 

Parity None Even 

Data Bits 8 7 

Stop Bits 1 1 

  
For Print through Driver: 
Select the location of the printer in the Print To: drop-down list.  In order to 
do this, you had to add the printer in your Add Printers function in Windows.  
If you haven’t done this, exit Starship, add the printer in Windows, and then 
return to StarShip.   
The correct driver for that printer must also be installed on the server to 
which you are printing or on your local machine. 
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# ACTION 

4 To print to a thermal printer, select the Thermal Barcode Printer check box. 

 
For printing of bar coded shipping labels, StarShip supports the Eltron and 
Zebra thermal printers, depending upon the selected carrier.   

5 Now select a printer from the Printer drop-down list.  If you selected Thermal 
Barcode Printer, only the thermal printers appear in the Printer drop-down 
list. To set up a thermal barcode printer, click the Thermal Settings button. 
 

 
 

For field descriptions, see Thermal Settings on the next page. 
 



Printer Setup   

# ACTION 
Thermal Settings: 

• Print Darkness – Can be set to Default.  When using Eltron printers with 
Eltron direct thermal labels, the following values passed UPS testing:  LP 
Series – Darkness = 5; TLP/LP+ Series – Darkness = 10 

• Print Speed - Can be set to Default.  When using Eltron printers with Eltron 
direct thermal labels, the following values passed UPS testing:  LP Series – 
Speed = 2; TLP/LP+ Series – Speed = 2 

• Label Size - To print UPS Maxi Codes label size must be 4x6”.  4x7” labels 
with a tear off audit label are also supported. 
Note: Press the Set Memory button after making changes, if applicable. If 
the function is supported, the button will be available (not “grayed out”). 

• Left Nudge/Top Nudge - These values control where the label prints in 
case the label stock is not feeding perfectly on “center.” 

• Orientation – Whether the top or the bottom of the label is printed first. 

5 If you did not select the Thermal Barcode Printer check box, click the Printer 
Setup button to set up the printer, if necessary. 
Important: Shipping labels for all carriers, except FedEx Express and FedEx 
Ground when using the Internet module, must be printed on a supported 
Thermal printer. 

6 Click OK, and Exit. 
Repeat these steps  for each carrier. 

 

See also Print on Save and Print on Save in Edit mode/Deferring 
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Printers Table The following table lists compatible printers. 

 

 

PRINTER SERIES SAMPLE MODELS NOTES 
Eltron TLP/LP+ Series TLP/LP 2642, 2742, 

Orion 
TLP/LP 2642 requires 256K of 
memory to print Maxi Code labels 
for UPS.  Other models listed have 
256K standard. 
These model numbers may now 
be offered under the Zebra brand 
name. 

Eltron LP LP 2042, 2542 With Maxi Code firmware: prints 
Maxi Codes, but not labels for 
other carriers.   
Without Maxi Code firmware: 
prints older UPS label format.  
Does not support FedEx Ground 
128 labels.  Prints FedEx Ground 
I2of5 bar codes. 
Please note that these printers are 
less than adequate for complying 
with carrier regulations regarding 
labels in relation to formatting 
and content. 

Zebra S300 Zebra S300 Does not support Maxi Codes 

Zebra S500 Zebra S500, T300,  
Z4000 

Supports Maxi Codes and latest  
FedEx Ground format. 
These printers do not support the 
FedEx Internet module. 
Zebra printer types compatible 
with these models are supported 
for FedEx Express when using the 
FMS Server module. 
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¤¤  PPRRIINNTT  OONN  SSAAVVEE  

 

To enable automatic printing of forms or labels when you save a new shipment, 
follow these instructions. 

 

# ACTION 

1 From the Shipping window, select a carrier from the carrier drop-down list, 
and press F6 or the Print button.  

2 Check the “Print on Save” check box next to the form or label. 
 

 
 

 
 

See also Print on Save when Editing/Deferring 
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¤¤  PPRRIINNTT  OONN  SSAAVVEE  IINN  EEDDIITT  MMOODDEE//DDEEFFEERRRRIINNGG  

StarShip, by default, will only print forms and labels automatically when you 
save a new shipment. StarShip can also automatically print your forms or labels 
when you save a shipment that you edited in the Shipping window. From the 
StarShip main menu, select Setup > Preferences, click the Print on Save tab and 
enable the first check box, Print on Save when Editing, if it is not already 
checked.  

You can also print when saving deferred or undeferred shipments. 
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STARSHIP USER’S GUIDE 
ELECTRONIC SCALE SETUP 

 

Overview If you have the electronic scale interface option, StarShip can 
automatically read the package weight from the scale when 
you process shipments.  The Scale Interface option is free when 
you purchase a scale from V-Technologies.  To check if the 
option is installed, select Setup > Registration from the StarShip 
main menu.   

The scale must be connected to a serial (COM) port on your 
computer.  You can configure the interface by following the 
steps below. 

 

# ACTION 

1 From the StarShip main toolbar, select Ship.  Then, select Settings > Scale 

from the Shipping window menu.  Or, click the   button. 

Click the Enable Scale check box. 
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# ACTION 

2 Click the Setup button.   Configure the settings using the descriptions below. 

 
Scale Type Select the make/model of your scale. 

COM Port Select the COM port that your scale is 
connected to. 

Communication 
parameters (Baud Rate, 
Parity, etc.) 

Please review the Factory settings for all 
supported scales, shown in the table below. 

 
 

SCALE TYPE BAUD RATE PARITY DATA BITS STOP BITS 
Transcell SP Series 2400 None 8 1 

Toledo 8213 9600 Even 7 1 

Weightronix 1200 Odd 8 1 

Micro General 1270 9600 Even 7 1 

MOS 105405 2400 None 8 1 

Fairbanks 9600 Odd 7 2 

Detecto AS-
400D/420D 

1200 None 8 1 

NCI 3835* 4800 Even 7 1 

* choose Weightronix scale type 
 
3 Click Query to test the setup, and then click OK. 

 



  

   
   

   
 
 
 
 
 
 
 
 
 

SSShhhiiippppppiiinnnggg   
 

 

 
 
 
 
 

   
 



The Shipping Window   

STARSHIP USER’S GUIDE 
THE SHIPPING WINDOW 

 
 

Overview Before we talk about how to ship with StarShip, let’s go over 
the Shipping window, which has an updated interface.   

A general note about the Shipping window -- required fields 
appear in blue. 

  

Interface 
Notes 

Ø If you use the StarShip link for MAS 90 or MAS 200 3.60 and 
higher, you access the Shipping window from the MAS 
90/MAS 200 Shipping Data Entry screen.  For more 
information, please review the Setting Up the StarShip Link 
for MAS 90 and MAS 200 3.60 and higher document. 
 

Ø If you use Business Works, review the Setting Up the 
BusinessWorks interface document. 
 

Ø If you use Service Pro, review the Setting Up the ADE 
Interface document. 
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Shipping Window Description 
 

Window 
Description 

This chapter goes through each section of the Shipping 
window and discusses its functionality. 

 

Toolbar The Shipping window toolbar allows you to access these 
functions: 

 

 

Creates a New Shipment.  Launches the New Shipment dialog 
box. 

 

 
Opens a pending shipment that you saved in StarShip. 

 

 
Saves a shipment. 

 

Copies the properties of the current package to a new 
package. 

 

 
Deletes a package or shipment. 

 

 
Defers the shipment. 

 

 
Prints out the shipping label. 

 

 
Allows you to search for and view past shipments. 
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Allows you to calculate Time-in-Transit for UPS. 

 Gives you a package count. 

 Gives you an itemized list of all packages in a shipment. 

 

 
Navigates to the first package in a shipment. 

 

 
Navigates to the previous package in a shipment. 

 

Navigates to the next package in a shipment or adds a new 
package to your current shipment. 

 

 
Navigates to the last package in a shipment. 

 

 
Closes the Shipping window. 

 
 

See also Calculating Time-in-Transit (UPS) 
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Recipient 
tab 

The recipient tab displays customer and address information of 
the shipment recipient.  If manually entering a recipient name, 
StarShip will automatically add it to the Customer List if you 
enter a customer ID plus other required information. 

 

 
 

Note: Required fields are indicated by blue text. 

  

See also Add Records to the Customer List 

When you call 
up an order in 
StarShip, the 
recipient 
information 
populates the 
Recipient tab. 
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Sender tab Click on the Sender tab label to access it.  The Sender tab 
displays your company information (from Setup > Company), 
which appears as the return address on your shipping labels. 

 

 
 

You can add Sender records if you wish to have different 
sender information printed on the return address. 

  

See also Company Setup 

Add Sender Records 

Click to add 
senders. 



The Shipping Window   

Reference 
tab 

The Reference tab shows information, related to the shipment, 
which is uploaded to UPS OnLine WorldShip (if applicable).  
Recipients can use this information to track their packages 
using a P.O Number. 

 
 

You can also customize the Reference tab to display 5 User 
Definable fields that you can name and map to show 
information from fields in your financial system.  

  

See also Customize the Reference Tab 
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Service Tab The Service tab displays package information about the carrier 
and service for the selected package.  It contains the 
package weight and the Billing information that displays in the 
Bill tab(s). 
 

 

  

See also Change the Billing (Billing Field) 

Create a New Shipment 
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Detail Tab The Detail tab displays fields for tracking information, package 
contents and label comments.  Also displayed are your 
shipping (record) method, the expected delivery date for the 
package, and the date on which the package shipped, if 
applicable. 

 

 

  

See also  Track a Package 
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Package 
Options 

Click on an option to see its properties or enter additional 
information.  The option cost is also listed.  If an option is 
“grayed out,” it is not available for the currently selected 
carrier and service.  See the carrier-specific chapters for more 
information about package options. 
 

 

  
Shipment 
Options 

The same rules for package options apply here, but they apply 
to the whole shipment.  Shipment options also include a 
Handling Fee, which is calculated by StarShip based on the 
information you enter on this tab.  To set a default Handling 
Fee, type in the fee and press Shift + F5. 
 

 
 

               Tip You can save screen defaults by pressing Shift + F5. 
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Bill Sender 
 
 
 
 
 
 
 
 
 

The Bill Sender tab shows charges for freight options, or 
accessorial charges, based on the Package/Shipment options 
you select.  Also listed are the current package total (if the 
shipment has multiple packages) and the shipment total. 

If you are using the Rate Utility and want to display both (or 
either of) the Modified and Standard rates, or if both types of 
rates are already visible in your “Bill” tabs, click here for more 
information. 
 

 
 

Bill 
Recipient 

If you choose to bill freight to the recipient, freight charges 
appear on the Bill Recipient tab.  Click on the tab label to 
switch tabs. You can change the billing per package. 
 

 
 

You can also bill freight to a Third Party, Credit Card, or 
Consignee.  Whomever you select in the Billing field will appear 
in a second Bill tab.  

Note: When billing to recipient and using premier services such 
as Early A.M, you may notice charges in the "Bill Sender tab".  
This may occur if you have accessorials (such as additional 
handling or COD) attached to the shipment.  In some cases 
the carrier does not bill accessorial charges to your recipient. 

See also Change the Billing; or Display Standard and/or Modified Rates 
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STARSHIP USER’S GUIDE 
SHIPPING PROCEDURES 

 
 

Overview Now that you are more familiar with StarShip’s interface, follow 
the general procedures in this section to learn how to process 
and work with shipments. 

Remember, StarShip may look or act differently depending 
upon your interface and/or financial system.  Always refer to 
your interface-specific guide for detailed information. 
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Link to a Source Document 
 

Overview The New Shipment dialog box allows you to select a source 
document to ship against.  If you would like to ship without a 
source document, see Ship Without a Source Document. ☺ 

Click the Document drop-down list to select the document to 
ship against.  Selections are usually Order, Customer or Invoice 
records, or the StarShip Customer and Deferred lists. 
 

 
 

When connecting to orders/invoices, you can populate the 
Shipping window by typing or scanning the number  while in 
the Key field.  Then press Continue.  Or, browse all records for 
by clicking the “ …” button. 

 

1) Select 
    Source 

2) Browse 
    Records 

You can 
change the 
“Search By” 

Pick 
record 

Click OK 
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Ship Without a Source Document 
 
 

Overview With StarShip, you can ship on the fly without a source 
document.  When the New Shipment dialog box appears, 
simply click Cancel and begin typing right in the Shipping 
window.  A few notes: 
 

Ø If you type in a unique Customer ID and the current 
source is set to Customer List, StarShip adds that 
customer to StarShip’s Customer List.  
See Add Records to the Customer List for instructions. 
 

Ø After you save a shipment, the New Shipment dialog 
box appears.  Click Cancel if you don’t want to select 
a source document. 

 
Ø At the New Shipment dialog box, select “None” from 

the source Document drop-down list. 

  

New 
Source 

When you select to ship without a source, the next time you 
click the New button, the New Shipment dialog box may not 
appear.  To launch the New Shipment dialog box, select File > 
New Source in the Shipping window. 
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Create a New Shipment 
 

When you create a shipment, the status bar at the bottom of the window says 
“New.”   

 

 

# ACTION 

1 Press the New button.  When the New Shipment dialog box appears, select 
a Document.  If you don’t want to select a source document, click Cancel.  
 

See also 
Link to a Source Document 

Ship Without a Source Document 
 

2 Enter the weight, or use a scale to read package weight.  Also, enter any 
other required shipment information.  

3 Select Package Options. 

4 Add as many  packages as you need by clicking Next, repeating steps 2-3. 

When you are done, click Save. 

Note: If the New Shipment dialog box does not appear when you click the New 
button, select File > New Source in the Shipping window. 

 
 

See also Create a COD shipment 
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Create a COD Shipment 
 

Overview This procedure shows you how to bring up a COD order in 
StarShip and process it. 

 
 

# ACTION 

1 Press the New button.  When the New Shipment dialog box appears, select 
the order you want to ship COD.  If you don’t want to select a source 
document, click Cancel. 
See also 
Link to a Source Document 

Ship Without a Source Document 

If you selected an existing order, the order populates the Shipping window.   
If you have the appropriate fields mapped in the financial system setup, COD 
terms and amounts will also automatically populate the Package and Shipment 
options.  If not, you can select COD options manually.  

2 Decide how you want to apply the COD amount(s). 

a) If you want to apply a unique COD amount to each package, 
begin with package 1, making sure the Package Options tab is 
selected.  Now type the COD amount in the Package Base Amount 
field.  Click the Next button and repeat for each package. 
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# ACTION 
b) If you want to distribute the total COD amount equally to each 

package, click on the Shipment Options tab and enter the total 
amount for all packages in the Total Base Amount field.   

Click on Divide Amount Equally to automatically distribute this 
amount across the packages: 
 

 
 

c) If you want to group all COD amounts for the shipment on the last 
package, then click on the Shipment Options tab and enter the 
total amount for all packages in the Total Base Amount field. 

Click on Group amount on last package to automatically apply the 
total COD amount to the last package in the shipment: 
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# ACTION 

3 You can add freight charges to the base COD amount on the Shipment 
Options tab.  If your state requires freight tax, type the percentage in the 
Freight Tax Rate field.  The freight is added to the Total Base Amount. 
 

 
 

See also Refer to your financial system interface setup guide for 
information on mapping the COD field in interface setup. 

You can download these guides from the V-Technologies web 
site documentation page.  

 

 

http://www.vtechnologies.com/support_documentation.html
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Open and Edit a Pending Shipment 
 

When you open a pending shipment, StarShip brings it up in Edit mode.  The 
mode is visible at the bottom left corner of the Shipping window. 

 

 

# ACTION 
1111    Press the Open button.  When the Open Shipment dialog box appears, 

select your shipment and click OK. 

 
 

 
 

               Tip Change the Search By criterion to customize how shipments 
are listed. 
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Delete a Shipment 
 

Deleting an item or shipment will completely remove that record from the 
StarShip database.  You can delete: 

§ an item, which means the current package in a shipment that contains 
more than one package. 

§ the shipment, meaning the entire shipment whether it contains one or 
more packages. 

 

# ACTION 

1 On the StarShip Shipping window, click the Open button.  When the Open 
Shipment dialog box appears, select your shipment and click OK. 
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# ACTION 

2 The Shipment information populates the window.  Next, click the Delete 
button. Select whether to delete the current package or the entire 
shipment.  Then click OK. 
 

 
 

 

See also Defer a shipment 
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Defer a Shipment 
 

Deferring a shipment means that you place it on the Deferred list so that you 
can ship it at a later time.  You can view a list of your deferred shipments, by 
carrier, at any time. 

 

# ACTION 

1 On the StarShip Shipping window, click the Open button.  When the Open 
Shipment dialog box appears, select your shipment and click OK. 

 

2 The shipment information populates the window.  Click the Defer button.  
Confirm that you want to defer this shipment by clicking Yes. 
 

 
 

 

See also View Deferred Shipments 
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View Deferred Shipments 
 

You can view the number and weight of deferred shipments, according to the 
carrier, from the Shipping window. 
 

# ACTION 

1 On the StarShip Shipping window, select Deferred Shipments from the View 
menu.  Then, select a carrier from the drop down list.  The total pieces and 
total weight of the deferred shipments appears. 
 

 
 

2 Click OK when you are done.  Or, click the Undefer All button to undefer all 
shipments for that carrier.  You see a status bar that tells you when 
processing is complete.  Click OK. 
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¤¤  AACCCCEESSSS  CCOOMMMMOODDIITTIIEESS  FFRROOMM  TTHHEE  SSHHIIPPPPIINNGG  WWIINNDDOOWW  

 

You can access commodities from the Shipping window when you are 
processing an International shipment. 

 

 

# ACTION 

1 On the Shipping Window, while entering the International shipment, click on 
the International tab.   

2 Make sure Documents Only is not checked. 

 
3 

Next to the Commodity Count field, click the  button.  This brings up the 
International Commodities window, which is used to maintain the 
commodities for the current shipment only.   

4 Press F5 to save. 

Note: To maintain the commodity list, click the  button next to the 
Commodity ID field in the International Commodities window. 
 

 
 

 

See also     International Commodities Setup 

SHIPPING PROCEDURES 
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¤¤  AACCCCEESSSS  DDOOCCUUMMEENNTTSS  FFRROOMM  TTHHEE  SSHHIIPPPPIINNGG  WWIINNDDOOWW  

 

You can access documents from the Shipping window when you are 
processing an International shipment. 

 

# ACTION 

1 On the Shipping Window, while entering the International shipment, click on 
the International tab.   

2 Make sure Documents Only is checked. 

 
3 

Next to the Documents Count field, click the  button.  This brings up the 
International Documents window, which is used to maintain the documents 
for the current shipment only.   

4 Press F5 to save. 

Note: To maintain the document list, click the  button next to the Document 
ID field in the International Documents window.  

 

  
 

 
 
 

See also     International Documents Setup 
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STARSHIP USER’S GUIDE 
CUSTOMIZE SHIPPING 

 
 

Overview You can customize StarShip’s environment to make shipping 
easier.  For example, adding sender records on the Sender tab 
makes drop shipping simple. 

Also, if you are using a financial system, check in your financial 
system interface guide for additional ways to customize 
StarShip. 
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Add Sender Records 
 

If you drop ship and want to use different return addresses, StarShip maintains a 
database of sender records you can select from.  To add records:  

 

# ACTION 
1111    

On the Sender tab, click the    button. 

2222    When the Maintain Shipper Information dialog box appears, press the  “+” 
button.  Type in a unique sender ID, and the remaining address information. 
Then click Save. 

 
 

3333    Use the toolbar to navigate records.  The “ –“ button deletes records. 

 
 

See also  Setup > Accounting Interfaces > Drop Ship Fields 
 
 
 



Customize Shipping   

Select Another Sender Record 
 

To select from sender records you’ve added:  

 

# ACTION 
1111    On the Shipping window, click the Sender tab. 

2222    From the ID drop-down list, select the ID for the sender record you want to 
use. 

 
The new sender record populates the sender tab. 
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Customize the Reference Tab 
 

You can customize the reference tab to display the field information you 
choose. 

 

# ACTION 

1 To customize field names on the Reference tab, click the Customize button.   

2 In the blank field next to “User Definable Field 1”  (or any of the other ones), 
type the new field name. 

 
 

3 Click OK. 

Note: In order for the correct information to populate the fields you customize, 
you must map those fields in your financial system setup.   
 
See the interface guide specific to your financial system for more information.  
You can download interface guides from the V-Technologies documentation 
page on the Internet. 

 
 
 
 

http://www.vtechnologies.com/support_documentation.html
http://www.vtechnologies.com/support_documentation.html
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Change the Billing 
 

Billing Field Freight is billed to the selection in the Billing field.  Selections in 
the Billing field drop-down list change depending upon the 
carrier and service you have selected.  The following steps 
show you how to change the freight billing on an order. 

 
 

# ACTION 

1 On the StarShip shipping screen, with your order open, go to the Billing field.  
Click on the arrow next to the field to open the drop-down list.  Select to 
whom you want to bill the freight for this package. 
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# ACTION 
2222    You’ll notice that the Accnt: field now appears next to the Billing Field.  This 

space is provided for the account information for the parties being billed. 

To enter this information click on the Browse button    and type the 
appropriate information into the dialog box. 

For example, select "Recipient" and the account dialog box automatically 
appears. 

 
Or, if I had selected “Third Party,” I would type in the following information: 

 
Another option is “Consignee.”  You may select either Consignee or 
Consignee/Third Party, and enter the appropriate information. 

 
 



  

   
   

   
 
 
 
 
 
 
 
 
 

UUUPPPSSS   
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STARSHIP USER’S GUIDE 
UPS SHIPMENTS 

 

¤¤  OOVVEERRVVIIEEWW  

This chapter explains shipping options that are specific to UPS shipments.   

 
 
¤ DOMESTIC SERVICES 

 

UPS Domestic offers the following services for domestic shipments.  

SERVICE DESCRIPTION 
Ground Guaranteed day of delivery from all addresses in the 48 

contiguous states of the U.S., Puerto Rico, and Hawaii to 
every address in the 48 contiguous states.  For more 
information on service availability, visit the UPS website. 

3 Day Select Guaranteed delivery within three business days to and from 
every U.S. address in the 48 contiguous states.   

2nd Day Air Guaranteed on-time delivery to every address throughout 
the U.S. and Puerto Rico by the end of the second business 
day. For more information on service availability, visit the 
UPS website. 

2nd Day Air 
A.M. 

Guaranteed delivery to commercial destinations by 12:00 
noon on the second business day to commercial 
destinations. For more information on service availability, 
visit the UPS website. 

Next Day Air Guaranteed delivery by 10:30 a.m., 12:00 noon, or the end 
of the next business day depending on location. Delivery by 
noon or 1:30 p.m. on Saturday. Deliveries to Hawaii make 
take an extra day. Deliveries to remote locations in Alaska 
may take an additional 1-5 days. For more information on 
service availability, visit the UPS website. 



UPS Shipments 

 

 
 

SERVICE DESCRIPTION 
Next Day Air 
Saver 

Guaranteed delivery by 3:00 p.m. to commercial 
destinations where UPS Next Day Air delivery is committed 
by 10:30 a.m. Guaranteed delivery by 4:30 p.m. to 
commercial destinations where UPS Next Day Air delivery is 
committed by 12:00 noon. Shipments to most residential 
locations within the Next Day Air Saver area are delivered 
by end of day.  

Next Day Air 
Early A.M. 

Guaranteed weekday delivery to major cities in the 
contiguous 48 states by 8:00 a.m. Delivery by 8:30 a.m. to 
most other U.S. cities, including Anchorage, Alaska. 
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¤ INTERNATIONAL SERVICES 

UPS offers the following services for International shipments.   

 

 
 
 
 
 
 
 
 
 

SERVICE DESCRIPTION 
UPS Worldwide 
Express PlusSM 

Guaranteed door-to-door and customs-cleared delivery of 
your urgent documents and packages by 8:30 a.m. on the 
second business day. A surcharge applies. 

UPS Worldwide 
ExpressSM 

Guaranteed next day delivery by 10:30 a.m. to major 
metropolitan areas in Canada, and by the end of the 
business day to most other Canadian destinations. 
Guaranteed second day delivery by 10:30 a.m. to major 
business centers in more than 700 cities across Europe, and 
by end of day to most other destinations. Letter and 
document delivery is guaranteed by end of next business 
day to major business centers in Europe, Asia, and Central 
and South America, when you call for an early pickup. 

UPS Worldwide 
ExpeditedSM 

Most shipments to Canada and Mexico are delivered within 
three business days. Most shipments to major destinations in 
Europe and Asia are delivered within four business days. 

UPS Standard to 
Canada 

UPS Standard to Canada offers guaranteed fully tracked 
ground delivery for your routine shipments. Guaranteed, 
fully tracked, door-to-door ground delivery from the 48 
contiguous states to all addresses in the 10 Canadian 
provinces. 
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¤ UPS SERVICE OPTIONS 

 
COD Driver collects payment for your goods upon delivery. You can 

select "Guaranteed" (certified check, money order or cashier's 
check) or "Standard" (any form of payment). 

     
Restrictions 

~ UPS will not accept cash (currency) in any amount for a 
COD package. 

~ Service fee applies. 

~ Only available for shipments to the U.S. and Puerto Rico. 

~ COD tags are only used when you are not shipping with 
UPS OnLine. Electronic COD is used for UPS OnLine. 

  Delivery 
Confirmation 

There are special handling fees that apply to U.S. domestic 
packages (150 lbs. or less) containing dangerous goods. 
Surcharges are based on classification and type of special 
handling required, including whether the items need to be 
accessible during shipment. 

     
Restrictions 

~ Not available with COD shipments. 

~ Not available for International shipments. 

  Saturday 
Pickup 

With UPS Saturday Pickup, your packages arrive with the same 
time commitment as those shipped on Friday.  Saturday 
pickup of domestic overnight and two-day air packages is 
available from most U.S. locations. Saturday shipments receive 
the same delivery time commitments as shipments picked up 
on Friday. 

     
Restrictions 

~ Not available with in Hawaii. 

~ Not available for UPS 3 Day Select or UPS Ground. 

~ Not available for International shipments. 
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Saturday 
Delivery 

Available to all destinations where UPS Next Day Air Early 
A.M.® service is available Monday through Friday. Saturday 
Delivery is guaranteed for arrival by 9:00 or 9:30 a.m., one hour 
later than the weekday guaranteed delivery time. Available 
to all destinations where the weekday guaranteed delivery 
time for UPS Next Day Air® is either 10:30 a.m. or 12:00 noon. 
Saturday Delivery guarantees arrival by 12:00 noon or 1:30 
p.m., one and one-half hours later than the weekday 
guaranteed delivery time. UPS Worldwide Express PlusSM and 
UPS Worldwide ExpressSM shipments to Canada, Germany, and 
the United Kingdom are delivered on Saturday in major 
metropolitan areas. 

Restrictions ~ Delivery time will vary depending on the destination postal 
code. 

~ Only available for UPS Next Day Air® and UPS Next Day Air® 
Early A.M.® 

~ Only available for UPS Worldwide Express PlusSM and UPS 
Worldwide ExpressSM.  

~ For Freight Collect shipments, the charge will be billed to 
the consignee. 

  Hazardous UPS transports your hazardous materials (U.S. and Puerto Rico) 
and International Dangerous Goods safely and securely. 

Restrictions ~ See the UPS website’s Hazardous Materials page for more 
information and instructions. 

~ Only the Dangerous Goods option is available for 
International shipments. 
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Returns Plus The UPS driver brings the package to your customer with a 

return label. See the UPS website for more information. 
 

Restrictions ~ Not available with COD, Delivery Confirmation, or 
Hazardous shipments.  

~ Third Party and Freight collect billing options are not 
available with Return Services. 

~ Third party and Freight collect may not be billed to the 
Shipper's UPS account number. 

~ Not available for International shipments. 

  Additional 
Handling 

Available for all UPS Services. 

     
Restrictions 

~ Not available for letters. 
~ Not available for International shipments. 

  Adult 
Signature 
Required 

Use in conjunction with Delivery Confirmation. Provides 
automatic confirmation with a printed copy of the adult 
recipient's digital signature. The adult must be at least 21 years 
of age. 

Restrictions ~ Not available for International shipments.  
~ Not available with Returns Plus. 

  Verbal 
Confirmation  

A UPS representative will promptly call you after the delivery of 
your UPS Next Day Air Early A.M.® shipment to confirm its 
arrival. 

Restrictions ~ Only available for UPS Next Day Air Early A.M.®  

  Ship 
Notification 1 
and 2 

Ship Notification Includes when billing information was 
received from shipper and scheduled date of arrival 
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Hundred-
weight 

The UPS Hundredweight (100WT) contract service provides 
discounts to large shipments to the same customer.   

Restrictions ~ Not available for UPS Next Day Air Early A.M. 

  Excess Value 
Insurance 

Each UPS domestic or International package shipment is 
automatically protected by UPS against loss or damage up to 
a value of US$100. Excess Value Insurance provides protection 
above US$100. 

Restrictions ~ Does not provide any protection for packages or letters 
that have an actual value in excess of US$50,000 even if a 
lesser amount is specified in the Insured Value field. 

~ International air shipments may be governed by the 
Warsaw Convention, including its liability limitations. 

  10 KG Box® 

25 KG Box® 
The UPS 10 KG Box® and the UPS 25 KG Box® offer a simple, 
convenient, door-to-door, fixed-rate shipping solution for 
express shipments up to 10 kg (22 lbs) and 25 kg (55 lbs).  

Restrictions ~ Only available for UPS Worldwide ExpressSM and UPS 
Worldwide Express PlusSM shipments. 
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¤¤  SSHHIIPPPPIINNGG  WWIITTHH  UUPPSS  

This chapter explains shipping options that are specific to UPS shipments.  For 
more information about UPS OnLine, see UPS Online setup.  To ship with UPS: 

 

# ACTION 

1 Launch StarShip by clicking on its desktop icon.  Then, click the Ship button. 
 

 
 

2 From the Shipping window, select UPS from the carrier drop-down list.  You 
can also select from different services and options. 

 
 

3 Enter a weight, and select any other options (described in this section).  

When you are done, click the  button to process another package or 

click    to save the shipment. 

See also    Calculating Time-in-Transit 



UPS Shipments   

¤ UPS ONLINE 

UPS OnLine is an electronic data transfer system that allows you to upload 
Package Level Detail (PLD) directly to UPS when you Close instead of printing a 
manifest report.  The PLD can include customer reference fields so that your 
customers can easily track their own packages. StarShip’s UPS OnLine feature 
allows you to track packages individually or in “batch” mode.  You can also 
print a report of late deliveries to receive any refunds due from UPS.   
StarShip supports UPS OnLine for all domestic and International services 
(including Hundredweight).   

See also UPS OnLine Setup 

 
¤ ADDITIONAL HANDLING 

The Additional Handling fee must be added to the freight charges if non-
standard packaging is used.   
 
To select Additional Handling, click the Additional Handling check box under 
Package Options. 
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¤ BILLING METHOD 

In the Billing drop-down list, you can select Sender, Recipient, Third-Party, or 

Consignee.  If you select something other than Sender, press the  button to 
enter the appropriate account information. 

For more information on modifications to the billing method, see Change the 
Billing. 

UPS Online 

If you have the UPS OnLine feature enabled, you do not have to prepare any 
special documentation for shipments that are not billed to you.  The billing 
information for Recipient, Third Party, and Consignee will be uploaded with the 
PLD (Package Level Detail) at the end of the day. 

Manifest 
If you are printing a manifest, Consignee Billing is not supported.  UPS does not 
allow shipments that are billed to Recipient or Third Party to appear on the 
manifest. 

• For domestic air shipments, the Record Method will automatically switch 
to “Shipping Document” if the Billing field is anything other than 
“Sender.”   

• For domestic UPS Ground or UPS 3 Day Select shipments, the Record 
Method will automatically switch to “Other” if the Billing field is not 
“Sender”.  Usually a hand-written pick up record book is used for these 
shipments. 

• For international shipments, the Record Method will automatically switch 
to “Waybill” if the Billing field is anything other than “Sender.”   
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¤ DIMENSIONAL WEIGHT 

For UPS air shipments (including UPS 3 Day Select), the freight is sometimes 
calculated using dimensional weight instead of the actual package weight.  
The dimensional weight will be used if: 

• The package is at least 1 cubic foot (or 1728 cubic inches) in size. 
• The dimensional weight is greater than the actual weight. 

The dimensional weight is calculated based on the package dimensions and a 
factor which applies a minimum weight per volume: 
 
Dimensional Weight   = Length x Height x Width (in inches)    
          Dimensional Weight Factor 
Domestic Dimensional Weight Factor = 194 cubic inches per pound; 
International Dimensional Weight Factor = 166 cubic inches per pound 
You can enter the length, width, and height, and StarShip calculates the 
dimensional weight for you.  StarShip will automatically apply the dimensional 
weight to the freight calculation if applicable.   

 
How to maintain box information 
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¤ MAINTAIN BOX INFORMATION 

 

StarShip can maintain a database of dimensional box information.  Click the 

 button next to the Dimensions field and type in the box data.  To save the 
information, click Save. Use the arrow buttons at the top of the dialog box to 
navigate through your saved entries: first, previous, next, and last, respectively. 
 

 
 

 
¤ OVERSIZE 

Packages that are being shipped UPS Ground or UPS 3 Day Select, and weigh 
less than 30 lbs. but measure over 80” in length and girth combined, should be 
designated as Oversize. 
Shipments that are Oversize 1 or Oversize 2 are rated at a higher weight than 
their actual weight. You must enter all of the package dimensions in order for 
the Oversize 1 or 2 to be calculated.  
Oversize 1 - Package is less than 30 lbs and greater than 84" in combined 
length and girth (L + 2xH + 2xW). Will be rated at 30 lbs. 
Oversize 2 - Package is less than 70 lbs and greater than 108" in combined 
length and girth (L + 2xH + 2xW). Will be rated at 70 lbs. 
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¤ GROUNDSAVER 

The GroundSaver contract service is a discount program provided to high 
volume ground shippers.  StarShip does not compute the discount for these 
shipments.  Instead, qualified shipments are printed on a separate manifest so 
that UPS can determine the discount from your current volume. 
 
There is no command to select UPS GroundSaver.  If you have the UPS 
GroundSaver option (sold separately), StarShip will automatically determine if 
the current shipment complies with the GroundSaver requirements.  Note that 
the service menu will show “GroundSaver” instead of “Ground.”   
 
If you do not have UPS OnLine enabled, GroundSaver shipments will be 
printed on the GroundSaver manifest.   
 
You can disable GroundSaver by selecting Carriers > UPS > Properties from the 
main StarShip menu. 
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¤ HUNDREDWEIGHT 

The UPS Hundredweight (100WT) contract service provides discounts to large 
shipments to the same customer.  StarShip will compute the discounts 
automatically.  If you are not using UPS OnLine, Hundredweight shipments will 
print on a separate manifest.  UPS domestic Hundredweight is available for 
Recipient and Third Party billing options. 
The minimum total weight requirements for a UPS 100WT shipment are: 

• Ground (and 3 Day Select): 200 lbs 
• Air: 100 lbs 

Note that the maximum weight per package of 150 lbs still applies to 100WT 
shipments. 
 
There are three ways to enter UPS Hundredweight shipments: 
1. Entering Shipments as Hundredweight 
If you think that the shipment will meet the 100WT requirements You can select 
Hundredweight service by clicking on the 100WT button.  If the shipment 
consists of multiple packages you can enter them in two ways: 

• Enter each package separately. 
• If all packages in the shipment or in a subset of the shipment have 

the same shipping options, you can save the group as one 
package detail entry.  Simply enter the number of packages in the 
group in the Pkgs field to the right of the 100WT button.  Then enter 
the total combined weight in the Weight field. 

 
Note: StarShip will let you save a shipment or package as 100WT even if it does 
not meet the minimum weight requirements.  If StarShip is unable to group this 
shipment with other shipments to the same customer (see below), you will get a 
message when you print the manifest.  If the shipment contains multi-piece 
items (Pkgs > 1) then you will have to edit the shipment to convert it to a 
standard shipment.  If the shipment only contains single piece items, StarShip 
will automatically convert it to a standard shipment. 
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2. Automatic Grouping (Real-Time) 
As you enter package information for a Shipment, StarShip can automatically 
check to see if the combined weight of the packages which are being shipped 
using the same service meet the 100WT minimum weight requirements and 
would be less expensive to send 100WT.  If both of these criterion are met you 
get a prompt asking if the shipment should be converted to 100WT.  Note that 
you must have the shipment grouping feature for 100WT turned ON for real-time 
grouping to work (see Setup). 
 
 
3. Automatic Grouping (End of Day) 
When you Post (if using UPS OnLine) or print the manifest, StarShip can 
automatically search for shipments which have the same consignee and ship 
via values and meet minimum weight requirements when combined.  You can 
turn the grouping feature on or off (see Setup). 
Setup 
You can enter your Hundredweight Tier and define which shipments should be 
automatically converted to Hundredweight by selecting Carriers > UPS > 
Properties from the main StarShip menu. 
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¤ INTERNATIONAL WAYBILLS 

UPS International Waybills can be used to document international shipments.  
Waybills can be printed on a tractor feed printer as shipments are processed or 
in batch mode at the end of the day (see Batch Print Shipments). 
Manifesting 
If you are not using the UPS OnLine feature, some international shipments can 
be manifested and some require a Waybill.  When the Country field in the 
Consignee address is not “USA,” “U.S.A.,” “United States” or blank, you can 
select “Waybill,” “Manifest”, or “Other” from the Record Method field. 
 
Waybills must be used for the following types of shipments: 

• Standard shipments to Mexico 
• International Shipments with a Billing Type other than Prepaid. 
• Multiple Package international shipments (excluding standard Canada 

shipments where Hundredweight can be used). 
You can include the following types of shipments on the Manifest or you can 
elect to use a Waybill: 

• Standard to Canada. 
• UPS ExpressSM or UPS ExpeditedSM Shipments to any country. 
• International Shipments for which the Dimensional Weight is greater 

than the Actual Weight. 
Multiple Packages on One Waybill 
You can ship multiple packages on one UPS Waybill, and is usually cheaper to 
do so.  Click Multi-Pc then enter the total number of pieces.  Then enter the 
TOTAL weight in the weight field.  
The average weight per package (total weight divided by number of 
packages) may not exceed 150 lbs. 
Note: if you enter the Waybill packages as separate items within the shipment, 
StarShip will print separate Waybills for each item and will not group the 
packages when calculating the freight. 

  



UPS Shipments   

¤ TRACKING NUMBERS 

With Bar Coded Shipping Labels 
If you are printing shipping labels on a thermal printer, then the Tracking 
Number field will be calculated for you based on the Next Bar Code Reference 
Number and it cannot be modified from the shipment screen.  You can update 
the Next Bar Code Reference Number by selecting Carriers then UPS from the 
main menu. 
With Pre-printed Tracking Labels 
If you are not printed bar coded shipping labels, then you will need to use pre-
printed tracking label provided by UPS.   
 
The correct tracking number should be stored with each shipment so that it will 
be available should you need to trace it.  StarShip will automatically increment 
the tracking number from the last one saved for each service.  You will initialize 
the tracking sequence for each service when you save a shipment with the 
correct tracking number.  You can also set the next tracking number by 
selecting Carriers > UPS > Properties from StarShip’s main menu. 
 

 
 

Multi-User Setup 
Note:  If you have the multi-user version of StarShip, each workstation must use a 
separate roll of labels since the next tracking number information is stored 
separately for each workstation.  Refer to Adding Users for details. 
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¤¤  UUPPSS  HHAAZZAARRDDOOUUSS  

You can maintain a database of hazardous goods for UPS using the Hazardous 
Materials Profile Maintenance feature. 
Follow these steps to process Hazardous shipments: 

 

 

# ACTION 

1 On the StarShip Shipping window, enter the shipment information.                              

2 On the Package Options tab, select Hazardous. 
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# ACTION 

3 From the Profile drop-down list, select one of the Hazardous Materials Profiles 

you previously set up. Click the “ ” button next to the field to verify or 
change the settings (for this shipment) for this dangerous good. 

 
 

The Hazardous Materials dialog box appears. When you are done, click OK. 
 

 
 

Note: You cannot add profiles or perform maintenance from this dialog box.  
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# ACTION 

4 Make sure the Quantity, Units, and number of packages containing this 
good are specified. 
These buttons allow you to add more dangerous goods to the package and 
to navigate the goods in the package. They are previous, add, delete, and 
next, respectively. 
 

 
 

5 Add as many packages as necessary, then press Save or F5 to save the 
shipment. 

 



UPS Shipments   

¤¤  CCAALLCCUULLAATTIINNGG  TTIIMMEE--IINN--TTRRAANNSSIITT  

 

The StarShip Time-in-Transit feature calculates the time it will take a UPS Ground 
shipment to arrive from any origin to any destination.  This feature is only 
available if you set up UPS OnLine (Carriers > UPS > Properties > UPS OnLine). 

 
¤ UPS ONLINE SETUP NOTES 

Time-in-Transit calculations can occur via Modem or Internet.  Make your 
selection in UPS OnLine setup on the Communication tab. To use this feature, 
you must have an Internet connection via Dial-Up or LAN. 
 

 

To use Time-in-Transit, follow this procedure.  It assumes that you are processing 
a shipment in StarShip and have at least a destination city and zip code, and 
package weight entered. 

 

# ACTION 

1 On the Shipping window, enter at least the destination city and zip code, 
and a package weight, for the current shipment. 

2 Select UPS and Ground in the Carrier and Service fields, respectively. 

3 Press the Transit button.  The Transit information appears to the right of the 
Service field, highlighted in yellow. 
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STARSHIP USER’S GUIDE 
REPRINT THE UPS SUMMARY LABEL 

 

Overview Follow this procedure to reprint the summary label after end-
of-day close. 

 

# ACTION 

1 From the StarShip main toolbar, select Carriers > UPS > UPS OnLine History. 

2 Highlight the date for which you’d like to reprint the summary label. 

3 Press the Print Summary button 

4 Click OK.  When you see the preview, click the Save button to print the 
report, or click the Close button to skip printing. 
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STARSHIP USER’S GUIDE 
BUSINESS RULES FOR USPS 

 

This chart shows what options are available for each USPS service.  The section that follows the chart 
explains rules and conditions.  The Delivery Confirmation option has its own section.  

 

CARRIER OPTIONS 

 Ret 
Rcpt 

Registered Certified Surcharge Delivery 
Confirmation 

Spec 
Handl 

Ret Rec 
for 

Mchdse 

Restricted 

First 
Class 

 X X X  X  X 

Parcel 
Post 

     X X  

Priority  X X  X X X X 

Express X        

Media 
Mail 

     X X  

C
A

R
R

IE
R

 S
ER

V
IC

ES
 

Bound 
Printed 
Matter 

     X X  

 
*Note: Delivery Confirmation is also available for Standard Mail (B).
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Return 
Receipt 

Return receipt service provides you with evidence of 
delivery; after delivery, the receipt is mailed back to you.   

In addition to being available for the services shown in the 
previous chart, it is available for Package Services when 
purchased at the time of mailing with one of the following 
services: Certified mail, COD, Insurance (for more than $50), 
and Registered mail. 

Additional Services: If you already purchased return receipt 
service with one of the services listed above, then one or 
more of these special services can be combined:  Delivery 
Confirmation (Priority Mail and Package Services only), (PAL) 
Parcel Airlift Service (Priority Mail and Package Services only), 
Restricted delivery, Signature Confirmation (Priority Mail and 
Package Services only), and Special Handling. 

  

Registered Registered Mail service provides you with a mailing receipt, 
and the Postal Service maintains a delivery record.   

The face (address-side) of the registered article must be at 
least 5 inches long and 3 ½ inches high, regardless of 
thickness.  Items returned under merchandise return service 
may be registered without prepayment of postage and fees. 

Additional Services: With registered mail, you can also 
purchase restricted delivery service or a return receipt.   

And, you can combine COD, Delivery Confirmation, and 
Signature Confirmation services with registered mail. 

Note: Articles with a declared value of more than $25,000 
can be registered, but compensation for loss or damage is 
limited to $25,000. 

Registered Mail must have a bar-coded red Label 200. 
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Certified Mail Certified Mail can only be mailable matter on which postage 
is paid at a First-Class mail rate (including Priority Mail).  It 
must bear a green bar-coded Form 3800, which can also be 
privately printed (if eligible).  See your DMM for details. 

Additional Services: Purchasing certified mail service allows 
customers to then purchase restricted delivery service or a 
return receipt. 

  

Surcharge For additional surcharges, please refer to the USPS DMM 
manual. 

  

Delivery 
Confirmation 

Please see the section, “USPS Delivery Confirmation,” for 
more information. 

  

Special 
Handling 

Special handling service provides preferential handling for 
materials that require extra care, but does not automatically 
provide insurance for the article(s).  It also does not provide 
preferential delivery. 

Additional services: You can combine the following services 
with special handling: COD, Delivery Confirmation, 
Insurance, PAL (for Package Services only), Return receipt for 
merchandise, and Signature Confirmation. 
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Return 
Receipt for 
Merchandise 

Return receipt for merchandise service is a type of return 
receipt that provides you with a mailing receipt and a return 
receipt. 

As indicated in the chart overview, this service is available for 
merchandise sent Priority Mail, as well as Standard Mail 
pieces subject to the residual shape surcharge, and 
Package Services. 

Additional Services: You can combine the following services 
with return receipt for merchandise: Delivery Confirmation, 
Insurance (up to $50), Parcel airlift (PAL), and Special 
handling. 

  

Restricted Restricted delivery service allows you direct delivery only to 
the addressee or the addressee’s authorized agent.  The 
addressee must be an individual (or natural person) specified 
by name. 

In addition to being available for First-Class Mail and Priority 
Mail, Restricted delivery service is available for Package 
Services sent COD, insured for more than $50, registered, or 
certified. 

Additional Services: You can combine the following services 
with Restricted delivery: Delivery Confirmation, Parcel airlift 
(PAL), Signature Confirmation, and Special Handling.  You 
can also get a return receipt by checking the appropriate 
box on Form 3811. 
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STARSHIP USER’S GUIDE 
USPS DELIVERY CONFIRMATION 

 

System 
Requirements 

In order to use StarShip’s USPS Delivery Confirmation module, 
your system must meet the following requirements: 

ü Windows 9x/NT 4.0 

ü StarShip for Win 9x/NT Version 4.3 or higher 

ü StarShip USPS module with Delivery Confirmation 

ü Eltron TLP/LP+ label printer using 4” x 5” or longer label 
stock 

ü Modem connected to analog telephone line 

  

Overview Delivery Confirmation adds delivery information to Priority 
and Standard Mail (B) shipments.  By using StarShip to 
process your Delivery Confirmation shipments, you can save 
the usual fees charged by the post office for “Retail Service.” 

The StarShip Delivery Confirmation module prints bar coded 
shipping labels for each USPS parcel with that option 
selected.  During your end-of-day closeout procedure, 
StarShip uploads the delivery confirmation file directly to the 
USPS data center using your modem.  It also downloads the 
delivery information file, and updates the Inquiry database 
with delivery status.  To get delivery information from the USPS 
website, go to www.usps.gov/cttgate. 

Note: This module is meant for delivery confirmation only, 
and does not include in-transit tracking information. 

  

Delivery 
Confirmation 
Checklist 

We recommend that you review the Delivery Confirmation 
Checklist provided by USPS, which you can access by 
clicking here, before you continue. 

 
 

http://www.usps.gov/cttgate
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Delivery Confirmation Setup 
 
 

Before you can ship using the Delivery Confirmation module, you have to perform a 
few steps. 

 
 

# ACTION 

1 Fill out the required forms. 
First, complete two forms for the U.S Post Office.  You can get these forms by 
clicking on the links below: 
ü PS 1357 – Request for Computer Access; 
ü PS 5051 – Telecommunications Service Request 

After you submit these two forms, the NCSC sends you this information: 
ü Two (2) account numbers w/passwords (one for PPP, and one for FTP host 

access) 
ü Certification Test Instruction Guide 
ü Your DUNS Number (if you don’t know it) 
ü Developer I.D Code 

2 Set up and test the USPS dial-up connection. 
Contact USPS technical support @ 877-264-9693 (Option 2), and request that they 
walk you through at least one PPP dial-up connection setup (under Windows 
9x/NT) with the USPS host computer.  Also, make sure they help you to test the dial-
up connection to ensure a correct connection to the USPS host.   
Note: StarShip assumes that you have a properly functioning dial-up connection 
already established with the USPS host. 
 
Next, check the following setting to be sure it is properly set. 

a) From your desktop, double-click the My Computer icon. 
b) Double-click Dial-Up Networking. 
c) Right-click on the USPS dial-up connection you just configured. 
d) Select Properties from the pop-up menu, and then click the Server Types 

tab. 
e) Make sure the Log on to network check box is not checked. 
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# ACTION 

3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Configure StarShip. 
In StarShip, select Carriers > USPS > Properties, and click the Delivery Confirmation 
tab.  Configure the following settings: 
 

• Check the Enable USPS Delivery Confirmation check box. 
• If this PC has a dial-up connection to the USPS host, check the This 

Workstation has PPP Dial-Up to USPS Host check box.  You can only perform 
the end-of-day closeout on the PC with a dial-up connection to the USPS 
host. 

• Check the Automatically Select Delivery Confirmation for Standard Mail (B) 
check box if you want StarShip to do so. 

• Enter the User ID, Password, and DUNS Number that the NCSC supplied to 
you. 

• USPS requires you to assign each package a unique number.  If more than 
one PC will be processing Delivery Confirmation shipments, you have to 
divide the workstations like this: 

  
W x (1,000,000 / N) 
W is the StarShip workstation number (numbered sequentially from 0) 
N is the total number of workstations 
 
Then, place this number in the spaces provided for both E-File Sequence # 
and Package Sequence #. 
 

• Configure the label printer. 
 
a) From the StarShip shipping screen, select USPS as the carrier, and click 

the Print button. 
b) Highlight the shipping label (second line from top), and click the 

 button. 
c) In the Setup Printer dialog box, select Eltron TLP/LP+, and the port to 

which it is connected.  Also check the Fast print direct to port option. 
Note: Delivery Confirmation labels must be a minimum of 5” long. 
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# ACTION 
3  (cont.)  

 Your Setup Printer dialog box should look similar to this: 
 

 
 Click OK when you are done.  Then, click Exit. 

4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obtain Site Certification from the NCSC. 
This certification is used primarily to verify the electronic file (of daily shipments), 
and the bar-coded Delivery Confirmation labels.  When you are certified, you 
receive PS Form 3152, Delivery Confirmation Certification, which is used when 
tendering Delivery Confirmation mail to the postal service. 
Follow these steps to print the sample Delivery Confirmation labels, and upload the 
shipment file to the USPS host.  For your convenience, we’ve included over 100 
Delivery Confirmation sample shipments.  Do these steps on a workstation that has 
the USPS dial-up connection, and can print to an Eltron TLP/LP+ label printer. 

a) From the main StarShip menu, select File > Open.  Then select sampdch.h.  
When this dialog box appears, click Yes. 

 
 

 StarShip recalculates freight charges/tracking numbers for each shipment. 
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# ACTION 
4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(cont.) 
 

b) Click the Close button.  When the Close – StarShip dialog box appears, 

select USPS from the drop-down list.  Click the    button.  

Highlight the USPS Thermal Shipping Label and click  .  Check Print 
by Invoice, and select a range of at least 20 invoices.   

 The post office requires the submission of 20 labels per printer.  So, if you are 
 printing to 3 Eltron printers, you must submit 60 labels. 
c) Fill out the “Delivery Confirmation Submission of Customer Printed Labels for 

Printer Certification” form.  Mail it with the printed labels to the specified 
address. 

d) Perform end-of-day closeout on the sample shipments so you can upload 
them to the USPS host.  This doesn’t affect your current shipments or add 
sample shipments to your actual shipment history. 
 
When all users have exited StarShip, select Close from the main menu.  
Select USPS as the carrier. 
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# ACTION 
4 (cont.) 

 
 Click Post, and then Start.   

 

 
If everything works properly, a USPS end-of-day label prints and the DCM will 
upload the Delivery Confirmation file to the USPS host. 
Click Exit. 
e) Select File > Current from the StarShip menu.  This closes the sample file and 

returns you to the current shipment file. 
Note: It is important that you switch to the current shipment file so that your 
real shipments (for your end-of-day closeout) are saved. 
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The Delivery Confirmation Manager 
 

Overview The Delivery Confirmation Manager software runs outside of StarShip.  It 
uploads the Delivery Confirmation electronic file to the USPS host, and 
downloads the delivery information file used to update the StarShip Inquiry 
database. 

The DCM automatically runs (in the background) on the PC where you 
checked the Workstation has PPP Dial-Up to USPS Host check box (You can 
access this in USPS > Properties > Delivery Confirmation). 

  

How does 
it work? 

Shortly after the end-of-day closeout, the DCM checks for a Delivery 
Confirmation file, which is created by StarShip.  If it finds a file, the DCM 
uploads it to the USPS host. 

About one hour subsequent to the upload, the DCM dials into the USPS host 
to retrieve the file upload status.  This file tells DCM if the Delivery 
Confirmation file uploaded correctly. 

Then, at a preset time (usually after midnight), the DCM dials into the USPS 
host and downloads the Delivery Information file.  Each time you open 
StarShip, or, when you select “Inquiry,” StarShip searches for a new Delivery 
Information file; if StarShip finds the file, it updates the Inquiry database with 
the new delivery information. 
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DCM 
Configuration 

When the DCM is running, its icon appears in your Windows system tray 
(shown left).  Right-click on the icon, and select Properties from the 
pop-up menu.  The dialog box has 3 tabs, each described in this 
section. 

  

Scheduler tab You can set up times/intervals for performing each DCM function. 

 
 

a) Shipment Information Upload – Controls the Retry times and 
intervals that the DCM uses when sending the shipment file to 
the USPS host during end-of-day closeout. 

b) Transfer Status Download – Controls the Retry times and 
intervals that the DCM uses when downloading the transfer 
status file from the USPS host during end-of-day closeout. 

c) Delivery Confirmation Download – Controls the download 
time, retry times, and intervals the DCM uses when 
downloading the delivery shipment file from the USPS host. 
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Connection tab Select the PPP Dial-Up connection to the USPS host that you previously 
set up (with USPS technical support guidance).  The drop-down list 
displays all the dial-up connections available on your PC. 
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Last Action tab You can view the status, date, and time of the last DCM operations 
performed. 
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Shipping with USPS Delivery Confirmation 

 

Overview Delivery Confirmation is available for Priority Mail and Standard Mail (B).  
StarShip automatically selects Delivery Confirmation for every Priority Mail 
package you ship because there is no charge.   

There is, however, a $0.12 charge when using Delivery Confirmation with 
Standard Mail (B).  Therefore, StarShip does not automatically select it for 
those packages.  If you would like Starship to do so, set up Delivery 
Confirmation as shown in the set up procedure (click here to view).  You will 
notice a $0.12 charge added to the freight. 

  

Shipping When you save a USPS Delivery Confirmation shipment, a bar code label 
prints from your Eltron TLP/LP+ printer.  Place this label on the package to 
receive Delivery Confirmation. 
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End-of-day 
Closeout 

Perform the end-of-day closeout on a workstation with a USPS dial-up 
connection, and with “This Workstation has PPP Dial-Up….” selected in the 
USPS Delivery Confirmation properties. 

During the end-of-day closeout, StarShip creates a file that contains 
shipping information for all USPS Delivery Confirmation shipments 
processed that day.  The DCM transparently uploads the file to the USPS 
host. 

 

Note: Be sure not to turn off this computer! Later, it dials into the USPS and 
downloads the transfer status information. 

 

A label with the electronic file number barcode automatically prints.  
After you receive certification, place this label on the Form 3152 and 
submit it to the Post Office with your packages. 
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Obtaining 
Delivery 
Information 

You can check Delivery Confirmation on a package in two ways: 

1. Press the Inquiry button in StarShip. 

Access the shipment, and the delivery status appears at the top of 
the Inquiry screen. 

 
 

2. Go to the USPS web site. 

Enter the tracking number, which you can find in the StarShip 
Inquiry, to track or get confirmation on a package. 

 

  

http://www.usps.gov/cttgate
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Inquiry vs. 
Web site 

There is no advantage when you use the USPS web site instead of 
StarShip Inquiry.  The Post Office updates their delivery information only 
once every day.  Starship’s delivery information file has the same 
information that is on the USPS web site.  Unlike UPS and FedEx, delivery 
information is not updated real-time.  And, the disadvantage to using 
the web site is that you have to know the package’s tracking number.  
When you look up delivery information from the StarShip Inquiry 
database, you can look the package up with whatever information you 
have, such as customer name or order number. 

  

Upload 
Failures 

If a file fails to upload to the USPS host, or one fails to receive a transfer 
acknowledgement, the following dialog box appears: 

 

 
 

To resend the failed files, click the Resend Files button. 
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Delivery 
Confirmation 
History 

You can check past Delivery Confirmation file uploads.  From StarShip, 
select Carriers > USPS > Delivery Confirmation History.  You see this dialog 
box: 

 
 

You can re-print an end-of-day bar code label if there was a problem 
printing it during the end-of-day closeout.  Select it and click the Print 
Bar Code button. 

  

Manual 
Upload & 
Download 

File upload and download operations are usually automatically carried 
out by the DCM.  If it failed on each of the retries, you must manually 
perform the failed operation.  To do this, access the Last Action tab in 
the DCM and select the appropriate Manual Upload or Manual 
Download button for the action you want to perform. 
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Diagnostics The DCM has a Diagnostics button.  When you click it, three more tabs 
are enabled: Event Log, Current Tasks, and Uploads. 

 

 
 

You should only enter the Diagnostics mode under the guidance of V-
Technologies technical support personnel.  To close Diagnostics, click 
the Diagnostics Off button. 
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Recovering 
Databases 

If a file becomes corrupt, due to a disk or network problem, or 
whatever the reason, StarShip displays an error message relating to 
the problem and the file.  If such an error occurs, you may have to 
perform a recovery procedure on the damaged database. 

To do this, select File > File Recovery from the StarShip menu.  The two 
databases associated with Delivery Confirmation are USPS Tracking 
and USPS Upload History; select one from the Database drop-down 
list.   

 

 
 

Click the Recover button.  If Recovery also generates error messages, 
you must use the file rebuild function.  If the recovery works, you see 
the following message: 
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Rebuild 
Upload History 

If one of the history files cannot be recovered, you can rebuild it from 
related files.  From the StarShip main menu, select File > File Rebuild. 

In the Database drop-down list, select the database you want to 
rebuild – USPS Tracking or USPS Upload History.  Select the date range, 
and then click the Rebuild button. 
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STARSHIP USER’S GUIDE 
MANIFESTING WITH USPS 

 

Overview StarShip is MAC approved for domestic shipments.  This 
certification is obtained on a national level and requires that 
StarShip complies with the latest specifications for the 
manifest and labels. 

Before you can begin manifesting, you must go through 
each step in this section. 

International 
Mailings 

You can manifest international mailings, but the StarShip 
manifest feature does not support or adhere to the current 
USPS international specifications for manifesting.  You can, 
however, use the 3600 forms that StarShip provides you with 
internally. And, for example, you can print out generic labels 
on which you can then place postage for international 
shipments.  

  

Step 1 Talk to your local Post Office representative to verify that you 
are eligible to use the Manifest Mailing System.  According to 
the USPS specification, a mailer must send 200 pieces or 50 
pounds of mail to be eligible. 

  

Step 2 Fill out the Manifest Mailing System Application.  Click on the 
link below to access a USPS document that provides 
valuable information about manifesting, as well as the 
necessary application form: 

Guide to the Manifest Mailing System 

 To return to the StarShip User’s Guide, click Back to StarShip 
User’s Guide in the contents list. 
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Step 3 Set up the StarShip USPS properties for manifesting, as shown in 
the following steps. 

 

# ACTION 

1 Launch StarShip.  From the Carriers menu, select USPS > Properties. 
 

 
 

2 In the USPS Setup dialog box, select the Manifest tab.  Fill in the fields as 
described in the following table, and click OK. 
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USPS Manifest Tab fields: 

FIELD EXPLANATION EXAMPLE 

Post Office of Mailing field - Type in 
the City, State, and 5-digit Zip Code 

 

 
 

Next Sequence Number – Only edit 
this field if directed by your Post 
Office or V-Technologies Technical 
Support. 

 

 

Processing Category – This field 
defaults to Parcels. 

 

 
 

Class of Mail – This fields defaults to 
Mixed. 

 

 
 

Print Form 3877 – USPS requires this 
form for manifesting. 

 

 
 

Print Manifest for International 
Shipments – This form is required for 
manifesting international shipments. 
See Note on International 
Shipments. 

 

 
 
 

Require USPS...  - The Post Office 
requires article numbers for Insured, 
Registered, and COD shipments.  If 
checked, you must enter the article 
number while processing shipments. 

 

 
 
  

Print PS Forms – These are required 
for manifesting. 
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Step 4 Create test packages, and submit the manifest and labels to 
the post office. 

 



  

   
   

   
 
 
 
 
 
 
 
 
 

FFFeeedddEEExxx   
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STARSHIP USER’S GUIDE 
FEDEX SHIPMENTS OVERVIEW 

 

¤¤  FFEEDDEEXX  EEXXPPRREESSSS  

¤ DOMESTIC SERVICES 

FedEx Express offers the following services for domestic shipments.  For Freight 
Shipments, see the FedEx Express Freight Size and Weight Restrictions for more 
information. 

 

 
Note: Read the Limitations section for your shipping method for more information 
about services and options that have limitations or are not supported. 
 

SERVICE DESCRIPTION 
Express Saver Delivery within 3 business days by 4:30pm (by 7pm to 

residential addresses). 

2Day Delivery by 4:30 pm the 2nd business day to most US 
locations (by 7pm to residential addresses). 

Standard 
Overnight 

Delivery by 3pm Mon-Fri to most US addresses (by 4:30 pm 
to more remote areas). 

Priority 
Overnight 

Weekday delivery is by 10:30am to most U.S. addresses (by 
4:30 pm to more remote areas). 

First Overnight Reaches major metropolitan areas by 8am, Monday 
through Friday. 

1Day Freight Next-business-day delivery by 10:30 a.m. for most shipments; 
by noon for many others. Continental U.S. and Alaska.  

2Day Freight Delivery by noon for most shipments; by 3 p.m. in many 
other parts of the U.S. Delivery to all 50 states; Hawaii service 
is to/from Oahu only. 

3Day Freight By 3 p.m. in 3 business days for most shipments. Monday - 
Friday. No Alaska or Hawaii service. No Saturday service. 

http://www.fedex.com/us/services/waystoship/freightrestrictions.html
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¤ INTERNATIONAL SERVICES 

FedEx Express offers the following services for International shipments.   

Blue text below indicates a link to the appropriate page on FedEx’s website. 

 

 
 
 
 
 
 
 

SERVICE DESCRIPTION 
International 
Priority 

Time-definite delivery typically in 1, 2 or 3 business days.  
Reach major cities in Europe by 10:30 a.m. typically in 2 
business days. 

International 
Economy 

Delivery typically in 4-5 business days (2-3 to Canada, 3 to 
Mexico), Monday – Friday, to 190 countries. 

International First Delivery by 8 a.m. in 2 business days. 
Inbound delivery to selected US ZIP codes from nearly 50 
countries and Caribbean islands in 1 or 2 business days, by 8 
or 8:30 a.m. Monday – Friday. Delivery to Basel, Brussels, 
Frankfurt, London, Milan and Paris. Door-to-door, customs-
cleared service. 

International 
Priority Freight 

Time-definite delivery in 1 - 3 business days to more than 50 
countries. Monday – Friday to major world markets. See the 
FedEx International Priority Freight page on the FedEx 
website for more information about delivery areas, 
package weight, extras and special instructions. 

International 
Economy 
Freight 

Time-definite service, typically within 5 business days, 
Monday – Friday, to more than 45 countries. See the FedEx 
International Economy Freight page on the FedEx website 
for more information about delivery areas, package weight, 
extras and special instructions. 

http://www.fedex.com/us/services/waystoship/intlexpress/priority.html?link=4
http://www.fedex.com/us/services/waystoship/intlexpress/economy.html?link=4
http://www.fedex.com/us/services/waystoship/intlexpress/first.html?link=4
http://www.fedex.com/us/services/waystoship/intlexpressfreight/priority.html?link=4
http://www.fedex.com/us/services/waystoship/intlexpressfreight/economy.html?link=4
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¤ FEDEX SERVICE OPTIONS 

 
COD Driver collects cash or check on Delivery. You can select 

"Guaranteed" (certified check, money order or cashier's 
check) or "Standard" (any form of payment). 
 

     
Restrictions 

~ COD and Dangerous Goods are mutually exclusive. 

~ COD and Bill Recipient (Collect) are mutually exclusive. 

~ Not available with International shipments. 

  Dangerous 
Goods 

There are special handling fees that apply to U.S. domestic 
packages (150 lbs. or less) containing dangerous goods. 
Surcharges are based on classification and type of special 
handling required, including whether the items need to be 
accessible during shipment. 

     
Restrictions 

~ Restrictions vary for the shipping of dangerous goods 
based on the FedEx Services. See the FedEx Dangerous 
Goods Shipping information on the FedEx website for more 
information. 

  Signature 
Release 

When checked, the driver may leave the package without a 
signature.  You must have received a Release Authorization 
code from FedEx, which you enter while shipping on the 
Package Options tab. 

  Ship Alert  
1 & 2 

FedEx sends a fax or e-mail to notify a contact that the 
shipment has been sent. Ship Alert 2 uses a second contact. 
 

Restrictions ~ Not available when shipping with FedEx Server. 

 

 

 

 

  

http://www.fedex.com/us/services/options/dangerousgoods/special.html?link=4
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Future Day 
Ship 

Specify a future date for the shipment. 
 

Restrictions ~ Date cannot be more than 10 days from the day you 
process the shipment. 

  Saturday 
Delivery 

FedEx delivers the shipment on Saturday. For FedEx 
International Priority, Saturday delivery is available for 
shipments from the U.S. to select points in Canada by 5 p.m., 
and a special handling fee will apply. For more information, 
see the Saturday Services page on FedEx’s website. 

     
Restrictions 

~ Not available for First Overnight, Standard Overnight, or 
Express Saver. 

~ Saturday delivery is not offered for FedEx International First, 
FedEx International Economy, or International Express 
Freight services except in countries where Saturday is a 
regular business day. 

  Saturday 
Pickup 

FedEx will pick up the shipment on Saturday. Shipments to 
international destinations may be picked up in the U.S. on 
Saturday in certain primary service areas (see FedEx Express 
Worldwide Directory) for a special handling fee. There is no 
additional charge to drop off your shipments on Saturday at a 
FedEx location. See the Saturday Services page on FedEx’s 
website for more information. 

  Hold at 
Location  

The recipient will pick up the package at the specific FedEx 
World Service Center. 

  Additional 
Handling 

The Additional Handling surcharge applies to packages that 
need special handling. The surcharge applies to any package 
greater than 60" in length or greater 130" in length and girth 
combined.  
 

    
Restrictions 

~ Not available when shipping with FedEx Internet 
~ Does not apply to shipments to and from Puerto Rico  
~ Not available for FedEx First Overnight 

http://www.fedex.com/us/services/options/express/saturdayservices.html
http://www.fedex.com/us/services/options/express/saturdayservices.html
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Delivery Area 
Surcharge 

This Surcharge is automatically added to the basic freight 
charges if the ZIP Code is in a list provided by FedEx. 
 

Restrictions ~ Only for Standard Overnight, Priority, Express Saver, or 2 
Day  

~ Not applicable with Hold At Location option. 

 

  Dry Ice Inaccessible Dangerous Goods may be shipped by way of 
most FedEx Express services. When the Dry Ice package option 
is checked on the Shipping window, you must enter the dry 
ice weight in kilograms. 

Restrictions ~ FedEx First Overnight accepts dry ice only 

  Priority Alert Priority Alert is a FedEx program that requires enrollment by the 
shipper. Contact your FedEx Sales Representative to enroll in 
this service. 

Restrictions ~ Priority Alert is for single piece shipments only. 

  Inside Pickup 
and Delivery 

When service is provided beyond the tailgate or sidewalk for 
32 kg or more, an additional flat charge per delivery. 

Restrictions ~ Available only with Freight services. 

  Alcohol FedEx will accept shipments of alcohol (beer, wine and spirits) 
when both the shipper and recipient are either a licensed 
wholesaler, licensed dealer, licensed distributor, licensed 
manufacturer or licensed importer. 

Restrictions ~ See the FedEx Express Terms and Conditions for Alcoholic 
Beverages on the FedEx website for domestic and 
international restrictions. 

~ FedEx Internet does not support Special Service - Alcohol. 
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¤¤  FFEEDDEEXX  GGRROOUUNNDD  SSHHIIPPPPIINNGG  OOVVEERRVVIIEEWW  

¤ SERVICES 

FedEx Ground offers the following domestic and international services: 

 

 
 
Note: Read the Limitations section for your shipping method for more information 
about services and options that have limitations or are not supported. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SERVICE DESCRIPTION 
Ground Standard Service for FedEx Ground 

Home Delivery FedEx Ground Home Delivery service is provided to high-
volume shippers to residential locations.  
The maximum weight for a package is 70 lbs.  

See Home Delivery in the FedEx Shipments section for more 
information about requirements and limitations. 

Canada 
Ground 

By 5 p.m. in 3 - 7 business days to Canada. 
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¤ FEDEX GROUND SERVICE OPTIONS 

 
COD Driver collects cash or check on delivery. You can select 

"Guaranteed" (certified check, money order, or cashier's 
check), "Standard" (any form of payment), or "Cash Only" 
(currency) collection. 
 

     Restrictions ~ Not available with the Call Tag service. 

~ Not available with Home Delivery. 

~ Not allowed when Billing to Recipient. 

  Acknowledge 
Deliv. 

Delivery is acknowledged. 
 

     Restrictions ~ Not available for International shipments. 

~ Not available with the Call Tag service. 

  Call Tag Requests that FedEx picks up the package at the address 
specified in the Recipient tab (in the StarShip Shipping 
window). 
 

     Restrictions ~ Not available when shipping COD. 

~ Not available with Home Delivery. 

~ Not available for International shipments. 

~ Not allowed with Auto Proof of Delivery. 
 

  Hazardous Shipment contains hazardous materials. 

     Restrictions ~ Not available with Home Delivery. 

~ Not available for International shipments. 

~ Not available when shipping with FedEx Internet 
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Additional 
Handling 

The Additional Handling surcharge applies to packages that 
need special handling. The surcharge applies to any package 
greater than 60" in length or greater 130 in length and girth 
combined.  
 

     Restrictions ~ Not available for International shipments.  

  Ship Alert  FedEx sends a fax or e-mail to notify a contact that the 
shipment has been sent. 
 

     Restrictions ~ Only available when shipping with FedEx Internet. 

  Auto Proof of 
Deliv 

FedEx sends a delivery signature to the shipper. Choose fax or 
e-mail. 

  Future Day 
Ship 

Specify a future date for the shipment; allows you to 
preprocess shipments. 
 

  

     Restrictions ~ Date cannot be more than 10 days from the day you 
process the shipment. 

  Signature 
Required 

FedEx Home Delivery Signature Required. 
 

     Restrictions ~ Only available with Home Delivery. 

~ Fee per package unless you select the Delivery Options > 
By Appointment option. 
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Delivery 
Options 

Premium Delivery Options for Home Delivery. Check Delivery 
Options in Package Options tab, then choose one of the 
following settings: 

Date Certain: Requires that you specify a date for delivery. 
The date can be from Monday through Saturday, 
excluding holidays. It cannot be before the standard 
transit time, and no later than 2 weeks after standard 
transit time. 
 
Evening: Delivery will occur between 5 p.m. and 8 p.m. 
 
Appointment: FedEx will contact the recipient to schedule 
delivery (Mon-Sat 9am-8pm excluding holidays). Signature 
Required is automatically included at no charge. 

 

     Restrictions ~ Only available with Home Delivery. 

~ The three settings above are mutually exclusive. 
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¤¤  FFEEDDEEXX  SSHHIIPPPPIINNGG  OOPPTTIIOONNSS  

This section describes general shipment options available for FedEx shipments. 
See the general Shipping chapter of the User’s Guide for a review of each tab 
and field on the Shipping window. 
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¤ BILLING METHOD 

In the Billing drop-down list, you can select Sender, Recipient, Third-Party, or 
Credit Card.  If you select something other than Sender, type in the account 

number or press the  button to enter account information. 

 
The Bill tab(s) consists of four calculations and reflects the Billing method: 

• Delivery Charges - This is freight charges + Additional Handling1. 

• Accessorial Charges -These are the fuel surcharge2 + handling fee + 
package options. See below for FSM Server notes. 

• Package/Shipment Total - These are the two amounts above added 
together to give you a cost summary for the package and shipment. 

 
1FSM Server Shipping: Package Service Cost = Freight + Dynamic Fuel Surcharge + 
OffShore Surcharge + Delivery Area Surcharge + Outside Delivery Area Surcharge 
+ Alaska Surcharge + Hawaii Surcharge + Residential Surcharge + Outside Pickup Area 
Surcharge + Rural Residential Surcharge - Total Discount Amount*. For more information, 
see the FedEx FSM Server setup. 
Package Accessorial Charges = options charges + handling fee 

* Total Discount Amount is always subtracted from the Standard Rate, but ONLY 
subtracted from the Modified Rate IF "Apply FedEx Discounts to Modified Rate (i.e. rate 
charged to your customers)" is checked. 

2 Internet Shipping: StarShip adds the fuel surcharge to accessorial charges only if you 
rate using the Internet. If you rate locally, StarShip adds it to the Package Service Cost. 
The FedEx fuel surcharge is set up in the Carriers > FedEx > Properties > Internet > Local 
Rates tab.  For more information, see FedEx Internet Setup. 

Click here to add Exp. 
Date or Acct. #. 



FedEx Shipments Overview   

¤ DIMENSIONAL WEIGHT 

For some FedEx shipments, freight is calculated using dimensional weight 
instead of the actual package weight.  The dimensional weight is used if: 

• The package is greater than 1 cubic foot (or 1728 cubic inches) in size. 
• The dimensional weight is greater than the actual weight. 

FedEx calculates dimensional for domestic shipments, and shipments between 
the U.S and Puerto Rico, using this equation: 
Dimensional Weight   = Length x Height x Width (in inches)    

194 
(For international shipments, divide by 166.) 
 
You can enter the length, width, and height, and StarShip calculates the 
dimensional weight for you.  StarShip will automatically apply the dimensional 
weight to the freight calculation if applicable.   
 

 
See also Maintain Box Information 
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¤ MAINTAIN BOX INFORMATION 

 

To keep track of box information, click the  button and type in the box data.  
To save the information, click Save. 
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¤¤  AADDDDIITTIIOONNAALL  FFEEDDEEXX  SSHHIIPPPPIINNGG  OOPPTTIIOONNSS  FFOORR  FFEEDDEEXX  GGRROOUUNNDD  

 

This section describes additional shipping options available for FedEx Ground 
shipments on the StarShip Shipping window.  

 
¤ HOME DELIVERY 

If you ship high volume to residential locations, you can qualify for the FedEx 
Ground Home Delivery service. If you already have a Home Delivery 
agreement with FedEx, be sure you did not check the  "Disable Home Delivery 
Service" check box during FedEx setup (Main Menu > Carriers > FedEx > 
Properties).  
 

To ship with Home Delivery, enable the “Residential” check box on the Shipping 
window.  The Service field automatically changes to Home Delivery.   
 

 
 

In addition, when the Zip code you entered is considered rural, the Residential 
check box changes to “Rural Resid” as seen below: 
 

 
Limitations: 

• Home Delivery shipments cannot be COD.   
If you select COD, the Service field automatically reverts to Ground. 

• The Zip Code entered in the shipping window must be in the list of Zip 
codes eligible for Home Delivery.   

• The maximum weight for FedEx Ground Home Delivery package is 70 
lbs. 
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¤ OVERSIZE 

FedEx considers an Oversize 1 package one that: 
• weighs less than thirty (30) pounds 
• measures greater than eighty-four (84) inches and equal to or less than 

108 inches in combined length and girth 
The transportation charges for an Oversize 1 package are the same as a thirty 
(30) pound package being transported under the same circumstances. 
FedEx considers an Oversize 2 package one that: 

• weighs less than fifty (50) pounds 
• measures greater than 108 inches in combined length and girth 

The transportation charges for an Oversize 2 package will be the same as a fifty 
(50) pound package being transported under the same circumstances. 
Enter the L, W, and H dimensions of the package; StarShip automatically 
classifies your package as Oversize 1 or 2. 
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¤ MULTIWEIGHT 

The FedEx Ground Multiweight (MWT) contract service provides discounts on 
large shipments to the same customer. StarShip calculates the discounts and 
displays them on the Bill To tab in the Shipping window.  If you use a manifest, it 
also prints MWT shipments on a separate manifest.  The minimum total weight 
requirements for a FedEx Ground MWT shipment are customer dependent. 
Note: If you are using FedEx Internet to ship, you must rate locally in order to 
ship Multiweight. 
 
StarShip checks for Multiweight in two ways: 
1. Automatic Grouping (Real-Time) 
As you type in package weight for packages in a shipment, StarShip 
automatically checks the combined weight of the packages (using the same 
service) to see if the MWT minimum weight requirements are met. If so, and if it’s 
less expensive to send MWT, it applies the discount to the Package Service 
Cost.  You must have enabled the Search Standard Shipments check box in 
Multiweight Setup. 
2. Automatic Grouping (End of Day) 
StarShip also searches shipments for MWT qualifications when you perform the 
end of day closeout procedure.  
 
The procedure that follows shows you how to create a Multiweight shipment. 

  

 The next page shows you how to process a Multiweight 
shipment.   >> 
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¤ PROCESS A MULTIWEIGHT SHIPMENT 

 

# ACTION 

1 Create a new shipment using FedEx Ground as the Service. 
Enter the package weight or read it using a scale, and add any other 
information. 
  

2 Now, you can enter additional packages in two ways: 
 

• Click the Repeat button to create an identical copy (including 
weight) of the first package; Enter the number of identical 
packages you want to create in the dialog box. 

 
• Click the Next button and enter or read the package weight. 

 

3 As you enter the package weights, StarShip applies the Multiweight rates to 
the Package Service Cost. 
 

 
 
When you are done entering packages, click the Save button to save the 
shipment. 

See also Displaying Modified and/or Standard rates in the Bill tab(s) 
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¤¤  FFEEDDEEXX  PPAACCKKAAGGEE  OOPPTTIIOONNSS  ((GGEENNEERRAALL))  

This section describes general Package options available for FedEx shipments 
on the StarShip Shipping window.  

¤ OVERVIEW 

When you click on a Package Option, the tab displays fields and settings 
specific to that option.  Enter any additional information; required fields are 
shown in blue.  The cost for each option also appears in the top right corner. 

Any options that are “greyed out” are not available. 
 

 
For more information about FedEX service options, please refer to the FedEx 
Shipments Overview. 
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¤¤  AADDDDIITTIIOONNAALL  FFEEDDEEXX  PPAACCKKAAGGEE  OOPPTTIIOONNSS  FFOORR  FFEEDDEEXX  GGRROOUUNNDD  

¤ ADDITIONAL HANDLING 

 

Additional Handling is billed by FedEx; this is not to be confused with the 
Handling Fee, which is found on the Shipment Options tab. 

 
¤ DELIVERY OPTIONS 

Premium Delivery Options for Home Delivery. Check Delivery Options in 
Package Options tab, then choose one of the following settings: 

⇒ Date Certain: Requires that you specify a date for delivery. The date 
can be from Monday through Saturday, excluding holidays. It cannot 
be before the standard transit time, and no later than 2 weeks after 
standard transit time. 

⇒ Evening: Delivery will occur between 5 p.m. and 8 p.m. 

⇒ Appointment: FedEx will contact the recipient to schedule delivery 
(Mon-Sat 9am-8pm excluding holidays). Signature Required is 
automatically included at no charge. 

See also For general information about COD fields, see Create a 
COD Shipment. 

For more information about the handling fees and 
Shipment Options, see the general Shipment Options 
section. 
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STARSHIP USER’S GUIDE 
SHIPPING WITH FEDEX INTERNET 

 

¤¤  OOVVEERRVVIIEEWW  

This chapter discusses shipping procedures and limitations when shipping with 
FedEx Express and FedEx Ground using the Internet shipping method. 

Ø Rate using the Internet 

Ø Rate Shopping 

Ø Process a shipment 

Ø After you process… 

Includes information about printing shipping labels 

Ø Edit/Delete/Defer Shipments 

Ø Dangerous Goods (FedEx Express), Hazardous (FedEx Ground) 

Ø Limitations 

  

See also For FedEx Service and Package options, refer to the FedEx 
Shipments Overview. 

For information about tracking packages, see Track a Package. 
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¤¤  RRAATTEE  UUSSIINNGG  TTHHEE  IINNTTEERRNNEETT  

 

You can get a rate quote on the Internet for any shipment you are processing 
by clicking the Rate on Internet button.  It is located direclty next to the Rate 
Shop button (visible only if Automatic rating is disabled). 

You must enter enough information on the Shipping window for a rate to be 
calculated before the rate button becomes enabled. It is higlighted in blue 
when enabled.  You can usually rate with just a zip code and package weight. 

After you enter the shipment information, click the Rate on Internet button.   

 
In a few seconds, depending upon the speed of your Internet connection, the 
Bill tab(s) is populated with the Package Service Cost and Accessorial Charges. 
 

 
 

You can use the Rate on Internet button as many times as you want, and any 
time you change shipment information that may affect the rate. 

See also Displaying Modified and/or Standard rates in the Bill tab(s) 
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¤¤  RRAATTEE  SSHHOOPPPPIINNGG  

 
 

With Internet shipping, FedEx does not allow side-by-side comparison of their 
rates with those of other carriers.  You can, however, rate shop between FedEx 
services.  To do this, select FedEx Express as the carrier and then click the Rate 
Shop button.  You see a list of all the FedEx services and their prices, depending 
upon the shipment information you entered on the Shipping window. 
 

 
 

                                  
 

Note: If you have a carrier other than FedEx selected on the Shipping window, 
and you click Rate Shop, FedEx does not appear in the Rate Shop list. 
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¤¤  PPRROOCCEESSSS  AA  SSHHIIPPMMEENNTT  

 

# ACTION 

1 From the StarShip main toolbar, click the Ship button.                               

2 Select a source document. If you are not using a source document, type in 
the recipient information. 

See also  
⇒ Link to a Source Document 
⇒ Ship without a Source Document 

3 From the Shipping window, select FedEx Express or Ground from the Carrier 
drop-down list.  From the Service drop-down list, select a FedEx service. 

                 
 

4 Select Package Options. 

5 Enter the weight, or use a scale to read package weight.  Also, enter any 
other required shipment information.  Add as many  packages as you need 
by clicking Next.   When you are done, click Save to save the shipment. 

                   
 

              
Ship Tip 

For identical packages, you can use the Repeat button to 
make exact copies of a package and quickly process the 
shipment. 
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¤¤  AAFFTTEERR  YYOOUU  PPRROOCCEESSSS……  

When you save a shipment, StarShip sends the shipment directly to FedEx via 
the Internet.  If successful, the shipment is recorded against your account for 
billing.  FedEx returns label and tracking information, which is stored in a data 
file on your PC.  The shipping label prints out if you enabled Print on Save. 
You can also print the labels later by opening the shipment in StarShip and 
clicking the Print button.  Select the shipping label you set up, then click Print. 
 

 
 

StarShip also stores the shipment information in the current shipment file, and 
writes the shipment information to your financial system (if you are using a 
financial system interface). 

See also Printer Setup 

Print on Save 
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¤¤  EEDDIITT  OORR  DDEELLEETTEE//DDEEFFEERR  AA  SSHHIIPPMMEENNTT  

 

Once you process a shipment, it is stored on the FedEx server.  So, when you 
edit, defer, or delete a shipment, StarShip must void the shipment on the FedEx 
server, and resend your new information (if editing). 
This causes processing speed to be slower. 
 
When you edit and resave a shipment in StarShip, it is deleted and resaved to 
FedEx over the Internet, in real-time. 
 

When you delete or defer a shipment in StarShip, it is deleted from FedEx over 
the Internet in real-time.   

 
Note: The immediate reply that you receive from the FedEx server after a delete 
is processed is only an acknowledgment that FedEx received the transaction.  
The actual acceptance or rejection of the delete request occurs within 24 
hours. 

 
 

See also For general information about performing these procedures, 
see: 

Open and Edit a Pending Shipment 

Delete a Shipment 

Defer a Shipment 
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¤¤  SSHHIIPPPPIINNGG  DDAANNGGEERROOUUSS  GGOOOODDSS  ––  FFEEDDEEXX  EEXXPPRREESSSS  

This option allows you to specify Inaccessible or Accessible items. 

⇒ Accessible: Certain dangerous goods that must be accessible during 
transit.  Accessible dangerous goods can only be shipped Priority 
Overnight. 

⇒ Inaccessible: Dangerous goods that do not need to be accessible 
during transit. 

 

 
 

⇒ Dry Ice: When dry ice is checked, you must enter the dry ice weight in 
kilograms. 
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¤¤  LLIIMMIITTAATTIIOONNSS  

 

These are the limitations for the FedEx Internet module: 

• International shipments are currently not supported via Internet.   

• The FedEx Internet API does not support multiple packages.  In StarShip, 
it looks like you create a multi-package shipment; however, each 
package is sent to FedEx as a separate shipment.   

Note: A recipient can accept any package in a StarShip shipment that 
does not have the COD option checked at the package level, under 
Package options. 

• The following services and options are not supported: 

Ø Special Services – Alcohol 

Ø FedEx Express SameDay 

Ø FedEx Express Freight (1Day, 2Day, 3Day Freight) 

Ø Hundredweight (per-pound) rates  

For multiple package shipments with a total of greater than100 
lbs to one destination. 

• If you are using FedEx Internet to ship, you must rate locally in order to 
ship Multiweight.  See Multiweight setup for more information.  

• IMPORTANT: FedEx accepts delete requests (voids) for 
packages shipped the same day.  Delete requests are only accepted 
until midnight.  Deferring a shipment is also considered a delete request. 

Note: If you perform a delete, there is a normal count discrepancy that 
occurs on the end-of-day manifest.  

• Internet shipping is not supported if you import into the current shipment 
file. 

• Shipment processing may be slower depending upon these factors: 

Ø The speed of your connection to the Internet 

Ø The speed of the FedEx servers 

Ø Time of day (traffic on the Internet) 

Ø Type of processing (saving, editing or deleting shipments) 
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STARSHIP USER’S GUIDE 
SHIPPING WITH FSM SERVER 

 

¤¤  OOVVEERRVVIIEEWW  

This chapter discusses shipping procedures and limitations when shipping with 
FedEx Express and FedEx Ground using the FSM Server shipping method. 

 

Ø Process a shipment 

Ø Printing shipping labels 

Ø Dangerous Goods (FedEx Express), Hazardous (FedEx Ground) 

Ø Limitations 

  

See also For FedEx Service and Package options, refer to the FedEx 
Shipments Overview. 

For information about tracking packages, see Track a Package. 
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¤¤  PPRROOCCEESSSS  AA  SSHHIIPPMMEENNTT  

 

# ACTION 

1 From the StarShip main toolbar, click the Ship button.                               

2 Select a source document. If you are not using a source document, type in 
the recipient information. 

See also  
⇒ Link to a Source Document 
⇒ Ship without a Source Document 

3 From the Shipping window, select FedEx Express or Ground from the Carrier 
drop-down list.  From the Service drop-down list, select a FedEx service. 

                 
 

4 Select Package Options. 

5 Enter the weight, or use a scale to read package weight.  Also, enter any 
other required shipment information.  Add as many  packages as you need 
by clicking Next.   When you are done, click Save to save the shipment. 

                   
 

              
Ship Tip 

For identical packages, use the Repeat button to make 
exact copies of a package and quickly process the 
shipment. 
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¤¤  PPRRIINNTTIINNGG  SSHHIIPPPPIINNGG  LLAABBEELLSS  

Shipping labels are generated by the FedEx Server. You set up shipping labels 
on the Printing tab under Carriers > FedEx > Properties > Server. 
With FedEx Server, you can print FedEx Express labels to an Eltron, Zebra, or 
Laser printer.  For FedEx Ground you can only print to an Eltron thermal printer. 
If you click the Print button while processing a shipment in the Shipping window, 
you will receive the following dialog box: 
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¤¤  DDAANNGGEERROOUUSS  GGOOOODDSS  ––  FFEEDDEEXX  EEXXPPRREESSSS  

Dangerous Goods settings for FedEx Server are accessible from Carriers > 
FedEx > Properties > Server > Dangerous Goods tab. You can also maintain a 
database of dangerous goods using the Hazardous Materials Profile 
Maintenance feature. 
Follow these steps to ship dangerous goods.  For FedEx Ground, just select the 
Hazardous check box on the Package Options tab. 

 

 

# ACTION 

1 On the StarShip Shipping window, enter the shipment information.                              

2 On the Package Options tab, select Dangerous Goods. 
 

 
 



Shipping with FSM Server   

# ACTION 

3 From the Profile drop-down list, select one of the Dangerous Goods Profiles 

you previously set up. Click the “ ” button next to the field to verify or 
change the settings (for this shipment) for this dangerous good. 

 
 

The Hazardous Materials dialog box appears. When you are done, click OK. 
 

 
 

Note: You cannot add profiles or perform maintenance from this dialog box.  

4 Make sure the Quantity, Units, and number of packages containing this 
good are specified. 
These buttons allow you to add more dangerous goods to the package and 
to navigate the goods in the package. They are previous, add, delete, and 
next, respectively. 
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# ACTION 

5 Click the Shipment Options tab and select Dangerous Goods. Use these field 
definitions to configure the settings, if applicable: 
More DG than Pkgs: When there are more dangerous goods than packages, 
you must specify: 

⇒ Not Applicable 
⇒ All Packed In One 
⇒ Overpack 

Outer Container Pack Type: Required when All Packed in One is selected. 
Number of All in One/Overpacks: Enter a number. 
Consignment of All in One/Overpacks: Check to enable consignment. 

6 Name of Signatory: This information comes over from the Server - Dangerous 

Goods tab in FedEx setup. Click the “ “ button to change or add any 
information (for this shipment). 
 

 
 

The Dangerous Goods Contacts dialog box appears. Verify or modify any 
information and click OK. 
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# ACTION 

7 Add as many packages as necessary, then press Save or F5 to save the 
shipment. 

  

Read about Shipping limitations 
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¤¤  LLIIMMIITTAATTIIOONNSS  

 

These are the limitations and supported shipping options for the FSM Server 
module.   
 
Supported Options: 

 
• FedEx Express Domestic and International shipments, including Freight 

Services.  
• FedEx Ground Domestic, including Home Delivery. 
• FedEx Ground International, but only to Canada. 
• Both FedEx Express and FedEx Ground support shipment of Dangerous 

Goods, with the following notes: 
⇒ Express: Radioactive goods not supported. 
⇒ Ground: No commodity information is required. 

• Alcohol is supported, however there are known issues in 0611. 
• Insight supports e-mail only, and not pager or fax. 

 
Limitations: The following options are not supported -  
 

• Emerge is not supported 
• Sunday Delivery (discontinued by FedEx August 2001) 
• FedEx Extra Hours (discontinued by FedEx December 2001) 
• Freight SLAC and Booking Number for freight services.  
• International Importer of Record (IOR) fields.  
• International Intermediate Consignee fields.  
• International Exporter/Principal Party of Interest (PPI) fields.  
• International weight in KGS  
• International currency other than US Dollars  
• Shipments originating from outside the continental US (Puerto Rico, 

Hawaii, Alaska) 

 



  

   
   

   
 
 
 
 
 
 
 
 
 

AAAiiirrrbbbooorrrnnneee   EEExxxppprrreeessssss   
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 STARSHIP USER’S GUIDE 
AIRBORNE EXPRESS SHIPPING OVERVIEW 

 

Services Airborne Express offers the following services for shipments.  
For more information on Airborne's delivery areas and a 
complete listing of Cities Served, refer to the Airborne Express 
United States Service Guide: 

 
 

SERVICE DESCRIPTION 
Ground Delivery in 1 to 5 business days.  Total shipment weight 

cannot exceed 150 lbs. Available between points in the 
contiguous United States only. 

Second Day Delivery by 5:00 pm on the second business day to 
Airborne’s primary delivery areas. Total shipment weight 
cannot exceed 150 lbs. 

Next Afternoon Delivery by 3:00 pm on the next business day to primary 
delivery areas.  Total shipment weight cannot exceed 5 
lbs. 

Note: Next Afternoon Service is only available to BOLD 
RED zip codes as defined by Airborne’s service guide. 

Express Delivery by 12:00 pm on the next business day to 
primary delivery areas.  Total shipment weight cannot 
exceed 150 lbs.   

International  -
Express 

Door-to-door delivery of documents and packages 
weighing up to 32 kg (70 lbs.) per piece to more than 
200 countries, usually within 24-96 hours (including 
customs clearance). 
Note: Not available for Airborne Linkage.  
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Airborne Express Service Options 
 
COD Driver collects cashier's check, money order, company check, 

or personal check upon delivery. Options are "Guaranteed" 
(certified check, money order or cashier's check) or 
"Standard" (any form of payment). 

     Restrictions ~ COD and Hazardous options are mutually exclusive. 

~ COD not available for International Express shipments. 

  
Saturday 
Delivery 

Saturday delivery to most major U.S metropolitan areas.  
Service charges apply depending upon the delivery area. 

     Restrictions ~ Only available for Express Delivery Service. 

~ See Airborne’s service guide for delivery area restrictions. 

  
Saturday 
Pickup 

For cities that have Saturday Delivery Service available. 
Service charges apply depending upon the delivery area. 

Restrictions ~ Not available for Ground Delivery Service. 

  
Hazardous Shipment of hazardous materials that require special handling.  

Service charges apply.  

     Restrictions ~ Not available when shipping COD. See Airborne’s website 
for additional restrictions. 

~ Not available when using the Letter or Lab Pack 
packaging types when shipping with Airborne Linkage. 

  
Hold at 
Airborne 

Recipient can pick up the package at the local Airborne 
terminal. 

       
Proof of 
Delivery 

When documentary proof of delivery is requested, Airborne 
provides a photocopy of the airbill or manifest signed by the 
receiver or a computerized record of delivery.  
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Additional Information for Airborne Linkage 
 
 

Services The following conditions apply when using Airborne Linkage 
to ship: 

 

~ Airborne Linkage is only allowed for U.S, Puerto Rico, and 
the U.S Virgin Islands. 

~ All packages in the same shipment MUST have the same: 

a) Packaging type 

b) Service 

c) Options 

d) Billing type 

~ Package cannot exceed the maximum weight set for 
Next Afternoon Service. 

~ Airborne Linkage does not support International 
shipments, including Canada. 

~ Home Delivery is currently not supported. 

~ The StarShip rate utility is currently not integrated with 
Airborne Linkage rates 
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STARSHIP USER’S GUIDE 
AIRBORNE EXPRESS SHIPMENTS 

 
 

Overview This chapter explains shipping options that are specific to 
Airborne Express shipments.  To ship with Airborne Express: 

 
 

# ACTION 

1 From the StarShip main toolbar, click the Ship button.                               

2 Select a source document. If you are not using a source document, type in 
the recipient information. 

See also  
Link to a Source Document 
Ship without a Source Document 

3 From the Shipping window, select Airborne from the carrier drop-down list.  
You can also select from different services and options. 

 
 

4 Enter the weight, or use a scale to read package weight.  Also, enter any 
other required shipment information, or select Package and Shipment 
options.  Add as many  packages as you need by clicking Next or Repeat.   
When you are done, click Save to save the shipment. 
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Packaging The Packaging drop-down list allows you to select Other,  
Letter, Pak or Lab Pack.   

 
 

Notes: Lab Paks must be packaged as follows: 
1. A watertight primary receptacle (blood vials, urine 

bottles, etc.) wrapped with absorbent material 
(paper toweling, sponge type, etc) 

2. INSIDE OF 
A watertight secondary package (plastic zip-lock 
bag, hard plastic casing.) containing enough 
absorbent and cushioning material to absorb the 
entire content of the secondary package. 

3. INSIDE OF (except urine) 
An outer packaging (cardboard, wood, metal, or 
rigid plastic) that will prevent against crushing of the 
primary vial or bottle. 

4. INSIDE OF 
A Lab Pack Envelope, or if its too big for the 
envelope, inside a cardboard box that has a Lab 
Pack label on it (the driver may apply the Lab Pack 
label). 

These are the basic regulations regarding Lab Paks.  It is your 
responsibilty to contact Airborne regarding further 
information, exceptions, and restrictions. 
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Dimensional 
Weight 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For some Airborne Express shipments, the freight is calculated 
using dimensional weight instead of the actual package 
weight.  The dimensional weight will be used if the 
dimensional weight is greater than the actual weight. 
Airborne Express will apply one of three rules; different rules 
may be applied to Ground vs. Express. 
 
“194 rule”: 
 
Dimensional Weight   = Length x Height x Width (in inches)    

194 
When: Domestic Dimensional Weight Factor = 194 cubic 
inches per pound; or 
(For airbills: International Dimensional Weight Factor = 166 
cubic inches per pound) 
 
You can enter the length, width, and height, and StarShip 
calculates the dimensional weight for you.  StarShip will 
automatically apply the dimensional weight to the freight 
calculation if applicable.   
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"OSR" (Over-Size Rule): 
• Packages with a length plus girth less than 85" will be 

charged at actual weight; 
• Packages with a length plus girth from 85" to 108" will 

be charged at 30 pounds or actual weight, whichever 
is greater; 

• Packages with a length plus girth exceeding 108" will 
be charged at 70 pounds or actual weight, whichever 
is greater; 

• An additional charge of $5 will be assessed to 
packages over 60" in length.; 

• An additional charge of $50 will be assessed to 
packages: 

o over 150 pounds, or  
o Length over 108", or  
o Length plus girth over 130"  

 
"FGR": 

• Packages with a length plus girth less than 84" will be 
charged at 1 pound per cubic inches or actual weight, 
whichever is greater; 

• Packages with a length plus girth from 85" to 108" will 
be charged at 30 pounds, 1 pound per 194 cubic 
inches, or actual weight, whichever is greater; 

• An additional charge of $35 will be assessed to 
packages: 

o over 150 pounds, or  
o Length over 108", or  
o Length plus girth over 130"  

Note: Girth = 2 times width plus 2 times height.  
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Box info StarShip can keep a database of frequently used box 
dimensions for you.  Click the “ … “ button and type in the 
box data.  Then, click Save. 
 

 
 

You can then select saved Box Information from the 
Dimensions drop-down list. 
 

 
 

  

Billing 
Method 
 
 

In the Billing drop-down list, you can select Sender, Recipient, 
or Third-Party.  If you select something other than Sender, 

press the  button to enter the appropriate account 
information.  

Other information: 

For more information on modifications to the billing method, 
see Change the Billing. 

For a description of the Bill Sender, Recipient, or Third Party 
tabs, see the Shipping Window Field and Tab Description 
section. 
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Consolidated 
Rates 

The purpose of consolidation is to combine shipments going 
to the same destination in order to reduce charges. These 
are the basic requirements for shipping with Consolidated 
Rates. Please contact Airborne for further information: 
 

• You must be eligible for “per shipment” pricing.  
• Shipments must be sent to the same location (e.g. 

name, address, city, state, zip).  
• Shipments must have the same service requirements 

(Express, Next Afternoon, Second Day) and special 
services (Hold at Airborne, Saturday Delivery). Any 
special service charge would be assessed only once 
for the entire shipment.  

• There may be a minimum weight requirement for the 
consolidated shipment.  

• There may be a minimum charge per piece within a 
consolidated shipment.  

• Ground service will only be allowed to consolidate >= 
200 lbs. 

 
When StarShip is using consolidated rates, (CONS) appears 
next to "Delivery Charges" on the Bill Sender tab. 
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Insured 
Value 

Airborne automatically covers each package and Letter 
Express for $100 at no additional charge. If you would like 
additional coverage, you can choose either Declared Value 
or Asset Protection (called Full Insurance in StarShip).  
The following is an explanation of both types of coverage: 
 
DECLARED VALUE (DOMESTIC) 
Declared Value is the value of a shipment over the 
automatic coverage, as stated by the shipper.  
 
ü The maximum Declared Value amount for Letter 

Express is $500.00 
ü If Declared Value is greater than $24,999.99 use Asset 

Protection instead. 
 
ASSET PROTECTION (DOMESTIC) 
Asset Protection extends the coverage to perils and 
exposures that would not otherwise be covered.  For 
example, theft, even if caused by circumstances beyond 
Airborne’s control, and acts of nature such as floods, 
earthquakes, wind storms, etc.   
 

 
 

ü The maximum coverage value is $99,999.99. The 
maximum asset protection charge is $650.00. 

ü Asset protection is not allowed for "Letter Express" or 
Ground services. 
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To set a Declared Value or Asset Protection (Full Insurance): 

 

# ACTION 

1 In the StarShip Shipping window, enter the shipment information.  

2 • To set a declared value for one package, type the amount in the 
Insured Value field. 

• To divide the declared value among packages in a shipment, click the 
“ … “ button next to the Insured Value field. Click the check box. 

• To set Asset Protection for each package individually, type the amount 
in the Insured Value field. Then click the “ … “ button and enable the 
“Full Insurance” check box. Click OK. 

• To divide Asset Protection among packages in a shipment, click the “ … 
“ button next to the Insured value field. Enable the “Divide Total 
Declared Value Among Packages” check box. Type in the amount. 
Then enable the “Full Insurance” check box. Click OK. 

 
 
Customs 
Value 

For shipments to Puerto Rico or the U.S. Virgin Islands, you must 
enter a Customs Value and Package Contents information. 

 

# ACTION 

1 To set the Customs Value: From the Service Tab, click the … button next to 
Insured Value. 
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# ACTION 

2 Set the Customs Value on the Insured Value Settings dialog box. 

 

3 Click OK. 
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Package 
Contents 

For all Airborne Linkage shipments, the Record Method will 
indicate one of four “airbill types”: CMI, PRI, PTR or COD as 
defined in Step 2.  Follow this procedure to enter Package 
Contents. 

 

# ACTION 

1 Click on the Detail Tab. 

 

2 Specify an address for each type by clicking on the appropriate button. 
§ CMI (Manifest) - Airbill type used for domestic shipments billed to the 

shipper (prepaid). 
§ PRI (Primary)- Airbill type used for multiple piece shipments, shipments 

billed to receivers (Collect) or third parties. 
Note: Ground Delivery Service shipments are always one-piece 
shipments. 

§ PTR (Puerto Rican) - Airbill type used for shipments from the U.S to 
Puerto Rico and shipments from the U.S to the U.S. Virgin Islands.  

§ COD - Airbill type used for COD shipments. 
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Airbill 
Numbers 

Airborne airbills print on pre-numbered tractor feed forms.  
When you save a shipment with the airbill number filled in, 
the next airbill number will be stored.  StarShip stores the next 
airbill number for domestic, domestic COD, and International 
airbills.  You can modify the last used airbill number by 
selecting Carriers > AEX > Properties from the main menu 
and clicking on the Airbills tab. 

If you advance your airbills manually on the dot matrix 
printer, make sure that the Airbill number on the StarShip 
Tracking tab corresponds to the Airbill number on the multi-
part form.  If the tracking number is off, you will not be able 
to track the shipment properly.  You can access the Tracking 
tab by selecting Carriers > AEX > Properties from StarShip’s 
main menu. 

Note: If you are using the Airborne Linkage option, only 
International airbills are relevant for you (if applicable).  
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STARSHIP USER’S GUIDE 
AEX LINKAGE END-OF-DAY CLOSE 

 
 

Overview This chapter explains the end-of-day Close procedure that is 
specific to Airborne Express Linkage shipments.   

 

# ACTION 

1 From the StarShip main menu, click the Close button.  

2 Select Airborne from the list and then click the Post button. 
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# ACTION 

3 Select Start. 
 

 
 

4 To display the manifest on-screen, enable the Preview Report check box. To 
send the manifest directly to a local printer, select the printer from the drop 
down list and click OK. A series of printing progress messages appear. 
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# ACTION 

5 At the Airborne Linkage Upload window, enter your Username (Airborne 
Remote ID) and Password from the Customer Linkage Set Up sheet.  Click 
the Login button. 
Note: An Internet connection is required to upload. 
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# ACTION 

6 Next, upload one file at a time, cutting and pasting the filenames from the 
list on the bottom left. Or use the Browse button to navigate to the file. 
Leave Batch ID blank. Click Upload. Wait for the screen to refresh. 
 

 

 
 

7 The screen indicates that the file has been "collected." 
 

 
 
Repeat for additional files. 
 

8 When you have uploaded all files, click Logout and then Exit.  

9 Click Exit to close the Post Shipments window, and then click Exit again. 
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STARSHIP USER’S GUIDE 
AIRBORNE LINKAGE HISTORY 

 

Overview Airborne Linkage History allows you to view past reports and re-
upload a file after posting your shipments. You can access 
Linkage History during end-of-day close as well as from 
StarShip’s main menu.   

 

# ACTION 

1 From the StarShip main menu, click Carriers > Airborne  > Airborne Linkage 
History.  Or, click the Manifest button during end-of-day close. 

 

2 Now you can: 

• reprint reports by clicking the Print Manifests button. 

• resubmit files for a given ship date by clicking Send to Airborne. This 
brings up the Airborne Linkage Upload window. 

 



  

   
   

   
 
 
 
 
 
 
 
 
 

IIInnnttteeerrrnnnaaatttiiiooonnnaaalll   SSShhhiiipppmmmeeennntttsss   
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STARSHIP USER’S GUIDE 
INTERNATIONAL SHIPMENTS 

 

¤¤  OOVVEERRVVIIEEWW  

 

International shipments consist of either Commodities or Documents. You can 
set up Commodities or Documents from the StarShip main Setup menu. 
 

 
 

This chapter shows you how to process International shipments with FedEx and 
UPS. 
 

 

For more 
information, see 
International 
Setup. 
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¤¤  FFEEDDEEXX  SSEERRVVEERR  ––  DDOOCCUUMMEENNTTSS  AANNDD  CCOOMMMMOODDIITTIIEESS  

 

Follow this procedure to ship International Documents and Commodities with 
FedEx Server. Use the field descriptions that relate to your particular shipment; 
some fields may be “grayed out” depending upon whether you are shipping a 
document or a commodity. 

 

Note: FedEx Ground only supports shipments to Canada. 

 
 

# ACTION 

1 On the Shipping window, enter the International shipment information. 
 

2 Click the International tab. If you are shipping a commodity, make sure 
Documents Only is not checked.  If shipping a document, enable the 
Documents Only check box. 
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# ACTION 

3 Select Terms of Sale, Duty Tax Payor (and type in the Account number, if 
applicable), AES Filed By, etc. 
 

 
 

 
We’ll go into more detail about the next fields on this tab because they allow 
you to add, select, and maintain information through separate dialog boxes. 

A  button next to a field usually indicates that there is additional information 
belonging to the field that can be selected or modified in some way. 
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¤ BROKER 

# ACTION 

4 The Broker field is one of the fields that allows for greater detail. Type the 

Broker directly into the field. Then, click the  button. Enter the information 
and click Save to List when you are done.  

 
 

To add more broker entries, click the “+” button.  To delete an entry, click 
the “ - ” button. When you are done, click Apply. Once you add Brokers, 
you can then select them from the Broker drop-down list in the future: 
 

 

Navigation buttons:  
First, Previous, Next,  
and Last records, 
respectively. 
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¤ COMMODITY/DOCUMENTS COUNT 

# ACTION 

5 Next to the Commodity or Documents Count field, click the  button.  If 
you selected the Documents Only check box, you’ll see the Documents 
Count field. 

This brings up the International Commodities or Documents window, which 
is used to maintain the documents or commodities for the current shipment 
only.  Select the document or commodity from the Document/Commodity 
ID drop-down list. You can also change the Quantity here, which is the 
number of pieces of this specific Commodity being shipped. (Not 
applicable when shipping Documents.) 

For additional field descriptions, please refer to International Setup. 
 

 
 

Continued… 
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# ACTION 

 You can also maintain International Documents or Commodities from this 

window by clicking the  button next to Document/Commodity ID.  

⇒ See the Documents version of this window. 

6 Press Save – F5 to add the Commodity/Document to the shipment. To add 
another item to the shipment, click the New – F7 button. A new line item is 
added, and you can select another document or commodity from the 
Document/Commodity ID list. When you are done, click Exit. 

Depending upon how many types of Commodities/Documents you added 
to the shipment, the Commodity/Document Count field will reflect the 
number of different Commodities or Documents being shipped. 
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# ACTION 

7 To enter information in addition to the document or commodity list that is 

printed on the Commercial Invoice, click the  button next to 
Commercial Invoice. Enter the appropriate information into the available 
fields and click OK when you are done. 
 

 
 

Note: If the Importer (Sold To) is different from the Ship To, uncheck the 
check box and enter the Importer information separately on the Importer 
tab.  
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# ACTION 

8 Complete other relevant information on the International tab before 
pressing Save to save the shipment.  
 

 
 

 
 
Note: FedEx International shipments usually have more than one label and there 
will be specific instructions on the label as to where you should place it. 
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¤¤  UUPPSS  ––  DDOOCCUUMMEENNTTSS  AANNDD  CCOOMMMMOODDIITTIIEESS  

Follow this procedure to ship International Documents and Commodities with 
UPS.  Use the field descriptions that relate to your particular shipment; some 
fields may be “grayed out” depending upon whether you are shipping a 
document or a commodity. 

 

# ACTION 

1 On the Shipping window, enter the International shipment information. 

2 Click the International tab. If you are shipping a commodity, make sure 
Documents Only is not checked.  If shipping a document, enable the 
Documents Only check box. 
 

 
 

3 Select the Terms of Sale, if applicable. 
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# ACTION 

4 Use the SED Filed field to enter information related to SED. Click the  
button, which is enabled when you select With Export Documents, UPS 
Prepared, or Electronic by Shipper (pre-departure). The SED Filed method 
determines the fields that appear on the resulting dialog box. 
Note: The SED will not print unless the SED Required check box is checked 
on the UPS SED tab for the Commodity. 
 

 
Note: If the Ultimate Consignee is different from the Ship To, uncheck the 
check box and enter the Consignee data on the Ultimate Consignee tab. 
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# ACTION 

5 Select the Certificate of Origin. If you select NAFTA, click the  button to 
enter a Blanket Period. Then, click OK.  Even if you don’t select None or UPS 
Prepared for Certificate of Origin, you must select Standard or NAFTA on 
the UPS Certificate of Origin tab for that Commodity in order for it to print. 
 

 
 

6 Enter a description for the document or commodity in the Description of 
Goods field. 
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# ACTION 

7 Next to the Commodity Count field, click the  button.  (If you are 
processing a documents-only shipment, you cannot add Documents here.) 
This brings up the International Commodities window, which maintains the 
commodities for the current shipment only.  Select the commodity from the 
Commodity ID drop-down list. Enter information pertaining to the item in this 
shipment, such as the Quantity. 
 

 
 

 

 

 

You can also maintain International Commodities from this window by 

clicking the  button next to Commodity ID.  



International shipments   

# ACTION 

8 Press Save – F5 to add the Commodity/Document to the shipment. To add 
another item to the shipment, click the New – F7 button. A new line item is 
added, and you can select another commodity from the Commodity ID list. 
When you are done, click Exit. 

Depending upon how many types of Commodities/Documents you added 
to the shipment, the Commodity/Document Count field will reflect the 
number of different Commodities or Documents being shipped. 
 

 
 



International shipments   

# ACTION 

9 To enter information in addition to the commodity list that is printed on the 

Commercial Invoice, click the  button next to Commercial Invoice.  
Enter the relevant information and click OK. 

 
 

Note: If the Importer (Sold To) is different from the Ship To, uncheck the 
check box and enter the Importer information separately on the Importer 
tab. 

 
 



International shipments   

# ACTION 

10 The Exporter field lists the selected Exporter. You can add and maintain 

Exporter data by clicking the  button next to the field.  

If adding data, enter the appropriate information in the available fields and 
click Save to List when you are done. To make a selection from existing 
data, use the arrow buttons at the top of the dialog box to navigate 
through Exporter entries: First, Previous, Next, and Last, respectively.  

To enter additional Exporters, click the “+” button, enter the information, 
and click Save to List after you complete each entry.  To delete an entry, 
click the “ - ” button. When you are done, click Apply. 

 

 
 

Navigation buttons:  
First, Previous, Next,  
and Last records, 
respectively. 



International shipments   

# ACTION 

11 
 

Complete any other relevant information on the International tab before 
pressing Save to save the shipment.  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



International shipments   

¤¤  AACCCCEESSSS  CCOOMMMMOODDIITTIIEESS  FFRROOMM  TTHHEE  SSHHIIPPPPIINNGG  WWIINNDDOOWW  

 

You can access commodities at any time from the Shipping window when you 
are processing an International shipment. 

 

# ACTION 

1 On the Shipping Window, while entering the International shipment, click on 
the International tab.   

2 Make sure Documents Only is not checked. 

 
3 

Next to the Commodity Count field, click the  button.  This brings up the 
International Commodities window, which is used to maintain the 
commodities for the current shipment only.   

4 To maintain the commodity list, click the  button next to the Commodity 
ID field in the International Commodities window. 
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¤¤  AACCCCEESSSS  DDOOCCUUMMEENNTTSS  FFRROOMM  TTHHEE  SSHHIIPPPPIINNGG  WWIINNDDOOWW  

You can access documents from the Shipping window when you are 
processing an International shipment. 

 

# ACTION 

1 On the Shipping Window, while entering the International shipment, click on 
the International tab.   

2 Make sure Documents Only is checked. 

 
3 

Next to the Documents Count field, click the  button.  This brings up the 
International Documents window, which is used to maintain the documents 
for the current shipment only.   

4 To maintain the document list, click the  button next to the Document ID 
field in the International Documents window.  
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STARSHIP USER’S GUIDE 
END-OF-DAY CLOSE PROCEDURES 

 

¤¤  PPOOSSTT  SSHHIIPPMMEENNTTSS  

  

StarShip allows you to post your shipments by individual carrier.  There is no limit 
to the number of times you can post per day. 

 
 

# ACTION 

1 On the StarShip toolbar, click the Close button.  StarShip reviews your 
pending shipments and carriers. 

                         
 



End-Of-Day Close Procedures   

# ACTION 

2 In the Close Current Manifest dialog box, click on a carrier to see all 
pending shipments for that carrier.  Enable the check mark beside each 
carrier that you want to close out.  You can also click the By Service tab to 
view shipment summary by Service. 

 
 

Note: If you have a shipment containing multiple carriers, you must close out 
both carriers.  If you forget, you’ll receive this error: 

 
 

3 
Click  .   

The Post Shipments dialog box appears. 

Note: This is the only place you can access the Setup Export button. 



End-Of-Day Close Procedures   

# ACTION 

4 Select or verify the posting date and click Start. 

When complete, StarShip displays posting results. 

 
 

See also Batch Print  

Setup Export 

 
 
 
 
 
 
 
 
 
 
 



End-Of-Day Close Procedures   

Batch Print 
Shipments 

StarShip allows you to batch print forms (labels, COD tags, 
waybills, etc.) for all shipments during end-of-day close.  
Normally, batch printing is used for those forms that were not 
“auto-printed” as shipments were saved.  

 
 
 

# ACTION 

1 On the StarShip toolbar, click the Close button.  StarShip reviews your 
pending shipments and carriers. 

                         
 

2 
Click the  button.  The carrier you selected dictates the forms 
show in the dialog box.  Also shown is the printer where each form will print, 
and the total package count for that particular carrier.  In this example, UPS 
is shown.  Select the form and click Print. 

 
 



End-Of-Day Close Procedures   

# ACTION 

3 Next, select a print range.  You can select to print: 

• All Labels 

• Unprinted Labels 

• By Invoice 

If you want to select a range of invoices, type in the “From” and 

“To” search criteria.  You can also search invoices by clicking . 

 
 

4 Click OK. 
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Setup 
Export 

The Setup Export feature allows you to export shipment 
information to an ASCII comma delimited file. 

 

# ACTION 

1 
During end-of-day closeout, click the   button on the Post 
Shipments window.   

2 Type a filename to which you want to export in the Export To: field.  You 
can also Browse for a file.  If you want an export to occur automatically 
each time you post, click Enable Export on Post. 

Then, decide which fields to include in the file.  The  >>  button includes all 
fields in the export file, and the  > button includes the selected (highlighted) 
field in the export file.  

 

 
 

3 Click OK. 
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STARSHIP USER’S GUIDE 
REPORTS 

 

Overview Starship provides you with standardized reports that you can 
access and run from StarShip’s main toolbar. 
The Reports feature also allows you to define new reports.  All 
reports can be printed to either a printer or a file. 
This section contains the following procedures… 
 

⇒ Print reports to a file 
⇒ Print reports to a printer 
⇒ Edit a report format  
⇒ Define a new report format  
⇒ Delete a report 
⇒ Set up the report printer 

 
…and information about the following reports: 

⇒ Print Shipment History by Customer 
⇒ Print Daily Shipments by Customer 
⇒ Insurance Report 
⇒ COD Remittance 
⇒ Freight Reports 
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Print reports to a file 
 
 

# ACTION 

1 From StarShip’s main toolbar, press the Reports button. 

2 Select the report from the Report Name drop-down list. 

3 Enable the Print to File check box. 

4 Navigate to and double-click the directory on the right, and then select the 
file from the left. If necessary, change the File Type, which defaults to Text 
Files (*.txt), to find the correct file.  You can also type in a new file name. 

5 If you would like the first line of the file to contain the field names, select the 
Include Header check box. 

6 Click Print.  
Click below for additional information about the Print Reports dialog box if 
you are printing 

⇒ Shipment History by Customer 
⇒ Daily Shipments by Customer 

7 Enter required information in the Print Reports dialog box and press OK. 

 
 

Print reports to a printer 
 

# ACTION 

1 From StarShip’s main toolbar, press the Reports button. 

2 Select the report from the Report Name drop-down list. 

3 Press Print. 

Or, to set up the Report Printer, click the  button.  When you are done 
with the setup, then press Print. 
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Edit a report format 
 
 

# ACTION 

1 In the Reports function, select the Report Name that you want to edit from 
the drop-down list. 

2 Click the Edit button. 

3 In the Setup Report dialog box (below), make the necessary changes. 

4 Click OK when you are done. 
 
 

Define a new report format 
 
 

# ACTION 

1 In the Reports function, click on the New button. 

2 Configure the Setup Report dialog box settings (below). 

3 Click OK to save the report. 

 

Use these settings to configure the Setup Report dialog box: 
• Name: Unique name for this report 
• Source: Source of data to report (Customer List, Past Shipments, Current 

Shipments, or Deferred Shipments). 
• Sort By: Select how data is sorted. 
• Field Setup: To add fields to the report, highlight the field in the Available 

list and click on the > button.  To remove fields from the report, highlight 
he field in the Print section and click on the < button.  To select more than 
one field at a time, use the Ctrl key while making your selections. 

• Print Column: Click on the Total check box if you want a grand total of 
numeric fields to print at the bottom of the report.  Click on the Subtotal 
check box if you want a subtotal of numeric fields for each group of 
records in the report. 
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Delete a report 

 
 

# ACTION 

1 In the Reports function, select the Report Name that you want to delete 
from the drop-down list. 

2 Press the Delete button. 

3 Answer Yes when prompted. 

 
 
 

Reports Printer Setup 
 
 

# ACTION 

1 Select to Print Direct to Port or Print through Driver.  
Click the Printer Setup button if you want to change the printer settings 

• For Print to Port:  
Lines Per Page - Enter the number of lines per page at which your 
printer is set. 
Code – Select the printer command.  You can enter or modify the 
associated decimal ASCII codes using the scroll window on the 
right.  Note that the Condensed On and Off will default to the 
correct values for the printer model you selected. 

• For Print through Driver: 
Configure the standard Windows printer settings. 

2 Click OK. 
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Print Shipment History by Customer 
 
The Print Reports dialog box for the Shipment History by Customer report requires 
you to enter the following information: 

• Number of Copies – Select a number using the up/down arrows. 
• Date Range – Specify the date range from which to print the report. 
• Specify Carrier – Select the carrier from the drop-down list. 

 
Print Daily Shipments by Customer 

 
The Print Reports dialog box for the Daily Shipments by Customer report requires 
you to enter the following information: 

• Number of Copies – Select a number using the up/down arrows. 
 

Insurance Report 
 
Preformatted report of Total Fees, Carrier’s rate, and Premium due to be sent with 
check to insurer. 
 

COD Remittance 
 
Preformatted report of outstanding COD shipments. 
 

Freight Reports 
 
Consists of two reports: 

• History – Prints a preformatted revenue history by date range and 
carrier. 

• Daily – Prints a preformatted daily freight report. 
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STARSHIP USER’S GUIDE 
ADDRESSES 

 

Overview Starship allows you to add customer records three ways.  Click 
on a method for more information: 

• "on-the-fly" – in the Shipping window 
• using the Addresses feature – accessible from StarShip’s 

main toolbar; uses a simple Customer Maintenance 
interface. 

• By importing a customer list  
 
The Customer Maintenance interface also enables you to 
modify and delete customer records. 
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Adding Records 
 
 

Overview StarShip makes adding customer records simple.  Add them 
“on-the-fly” while creating shipments right in the Shipping 
window, or by using the Addresses feature. 

 
 

# ACTION 

1 On the Shipping window, press the New button.  When the New Shipment 
dialog box appears, set the Document Source to Customer List.  Then, click 
Cancel.   

2 On the Recipient tab, enter a unique Customer ID.  Type in all required 
Company and Address information. 

3 Enter any other required shipment information, such as Carrier, Weight, etc. 

4 Click Save.  The customer is added to your StarShip Customer List for future 
use.  

 

When you’re not shipping, you can add customer records this way:   

 

# ACTION 

1 

On the StarShip main toolbar, press the    button.   



Addresses   

# ACTION 

2 When the Customer Maintenance window appears, type in the customer 
information.  Press Save. 

 
 

3 You can continue to add records, or click Exit.   

 

              Tip Use the Open button to bring up existing records.   
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Import Customers 
 

Overview You can import a customer list in two ways: 
 

⇒ From a comma delimited file  
⇒ From the StarShip DOS format (if you upgraded from 

that program) 
 

 
FROM A COMMA DELIMITED FILE 
 

# ACTION 

1 From StarShip’s main toolbar, click on Addresses. 

2 Select File > Import. 

3 Choose the Import From Comma Delimited File. 

4 Click on Setup. 



Addresses   

# ACTION 

5 Make the following selections from the Setup Import dialog box: 
• Duplicate Customers - Select Skip duplicate customer numbers if you 

do not want to import a customer number that already exists.  Select 
Import duplicate customer numbers if you want StarShip to import the 
customer entry if the customer number already exists. 

• Select Fields to Import - This is the list of fields that allow StarShip to 
interpret the data in your imported file.  The list of Import Fields must 
match the order of the fields in your data.  Use the up and down 
arrows to change the field order.  To add Available fields to the 
Import Fields list, select a field and click > to add it to the list of 
imported fields.  To select all fields, click >>.  To select more than one 
field, press Ctrl while selecting them and click the > button. To 
remove fields from the Import Fields list, select them and use the < 
button. 

• Skip First Row - Use the Skip check box to tell StarShip to skip row 
names (headers) when you import them with the rest of your fields. 

• Field Delimiter - This setting tells StarShip the format of the file to be 
imported.  That way StarShip knows what fields are actually imported 
by looking for the comma or tab.   

6 Click OK when you have completed setup. 

7 Type in the location of the input file or use the Browse button to select it 
from an Explorer-type window. 

8 Click Start. 
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FROM A DOS CUSTOMER LIST 
 

Overview Use this option if you migrated from DOS to Windows.  To 
convert your customer list: 

 

# ACTION 

1 From StarShip’s main toolbar, click on Addresses. 

2 Select File > Import. 

3 Choose the Import From StarShip DOS Customer List. 

4 Type in the location of the customer file or use the Browse button to select it 
from an Explorer-type window. 
Note: The DOS customer file is named CUSTOMER.DB and is located in the 
StarShip data directory.  If you don’t know where your data directory is, 
press F2 twice from the DOS main menu. 

5 Click Start. 

 



Addresses   

Modify Customer List entries 
 
 

# ACTION 

1 In the Customer Maintenance interface, press Open. 

2 Select a record and click OK. 
You can change the Search By criteria by selecting a different entry from 
the drop-down list. 

3 Modify the entry. 

4 Press Save. 

 
 
 

Delete Customer List entries 
 

# ACTION 

1 In the Customer Maintenance interface, press Open. 

2 Select a record and click OK. 
You can change the Search By criteria by selecting a different entry from 
the drop-down list. 

3 Press the Delete button. 

4 When asked if you want to delete the customer, press Yes. 
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STARSHIP USER’S GUIDE 
VIEW SHIPMENT HISTORY 

 

Overview The History feature in StarShip allows you to search for and view 
past shipments. 

 

# ACTION 

1 In the Shipping window, click the History button.  Then, select a Search By 
criterion. 

                                       
 

2 Click the  button to browse for a record.  The records are sorted by the 
search criterion you selected, which appears as the first column in the 
Search window. 

3 Select a record and click OK.  You can only view the shipment in “History” 
mode, as indicated by the lower left-hand corner of the Shipping window. 

 
 

Note: If you click the New button while in History mode, StarShip brings you back 
into “New” mode.  Or, if you click the Open button, you are returned to “Edit” 
mode. 

 
 

See also Create a New Shipment 

Open and Edit a Pending Shipment 



Track a Package   

STARSHIP USER’S GUIDE 
TRACK A PACKAGE 

 

¤¤  OOVVEERRVVIIEEWW  

You can track UPS and FedEx shipments directly from StarShip (when in History 
mode).  You can only track FedEx packages if you are using the FedEx Internet 
module to ship. 

Note: If you are tracking a UPS package for the first time and you haven’t 
registered your UPS OnLine Tools yet, you’ll be prompted to do so during the 
tracking process (in Step 3). 

 
 
 

# ACTION 

1 On the Shipping window, click the History button, and select the criteria by 
which you want to search.  For example, PO Number.   

Then, click the  button. 

 

 
 

2 Select the shipment that you want to track.  Once you click OK, you return 
to the Shipping window and the shipment you selected populates the 
window. 



Track a Package   

# ACTION 

 
 

3 From the toolbar, click the  button.  If the shipment contains multiple 
packages, each one appears separately.  You can select one and click 

the   button.  Or, to track all packages in a shipment, click the 
Track All button. 
Note: If you haven’t registered your UPS OnLine Tools, you are prompted 
to do so at this point.  Follow the UPS OnLine Tools Registration before 
continuing the tracking process. 

The tracking information populates the window. 

 

 
 

Click Cancel when you are done. 

 

See also UPS setup for tracking via Internet or modem 

UPS OnLine Tools Registration 

 
 



Track a Package   

¤¤  UUPPSS  OONNLLIINNEE  TTOOOOLLSS  RREEGGIISSTTRRAATTIIOONN  

 

The first time you track a package, you’ll be required to perform a UPS OnLine 
Tools Registration.  This occurs when you click the Track button in the Shipment 
Status and Tracking window.  When you see the following dialog box,  continue 
on to the steps below: 

 

 

 
 

# ACTION 

1 When you are asked “Register to use UPS OnLine Tools now?” click OK. 

2 The first Registration Wizard window appears; click Next. 

3 The second registration window appears; make sure you are connected to 
the Internet, and click Next.   

 
 

4 Read the license agreement on the web page, and click the I Accept 
button if you accept the terms of the agreement. 



Track a Package   

# ACTION 

5 Next, enter the required registration information in the fields provided and 
click the Submit Registration Information to UPS button. 

6 Print out the registration information supplied by UPS and click Continue. 

7 Your registration is successful and you see the following window: 

 

 
 

You can now continue tracking packages. 
 

See also Track a package 
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STARSHIP USER’S GUIDE 
ADD RECORDS TO THE CUSTOMER LIST 

 

Overview StarShip makes adding customer records simple.  Add them 
“on-the-fly” while creating shipments right in the Shipping 
window, or by using the Addresses feature. 

 
 

# ACTION 

1 On the Shipping window, press the New button.  When the New Shipment 
dialog box appears, set the Document Source to Customer List.  Then, click 
Cancel.   

2 On the Recipient tab, enter a unique Customer ID.  Type in all required 
Company and Address information. 

3 Enter any other required shipment information, such as Carrier, Weight, etc. 

4 Click Save.  The customer is added to your StarShip Customer List for future 
use.  

 

When you’re not shipping, you can add customer records this way:   

 

# ACTION 

1 

On the StarShip main toolbar, press the    button.   



Add Records to the Customer List   

# ACTION 

2 When the Customer Maintenance window appears, type in the customer 
information.  Press Save. 

 
 

3 You can continue to add records, or click Exit.   

 

              Tip Use the Open button to bring up existing records.  If you 
want to delete an existing record, select it and then click 
Delete. 
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STARSHIP USER’S GUIDE 
RATE UTILITY 

 

Overview StarShip’s Rate Utility enables you to 

§ View published rates, 

§ Add rules to published rates, 

§ View modified rates, 

§ Print both published and modified rates. 

In this chapter, we’ll first go over the Rate Utility interface to help 
you navigate easily.  Afterwards, we’ll discuss Rate Utility rules, 
and procedures for modifying them. 

  

Limitations 1. The Rate Utility does not currently support UPS 
Hundredweight and FedEx Ground Multiweight. 

2. If you are using FedEx Ground and/or FedEx Express and 
rating over the Internet, the rates will not be modified 
according to any rules you set up in the Rate Utility. 

Tip: To compensate, you can add a handling fee on the 
Shipping window. 
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Carriers 
and 
Services 

Carrier/Service Selection Tree 

The left section of the Rate Utility window displays the carriers 
and their related services.  To expand any carrier or service type, 
click on the “+” next to it.  Click on a service name to view rates.   

 
 

 

You can use the splitter bar in the center of the window to 
increase your view of the carriers/services or the rates tabs. 

 
Additional Options 

Click on Additional Options to view rates for package options 
that are available for the selected carrier.  These rates show 
extra fees in addition to the normal service charges.  You can 
also apply rules to Additional Options rates. 
 

2. Rates display here. 

1. Click on the 
service you 
wish to modify. 
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Rates tabs The right side of the Rates Utility interface has 3 tabs: 
q Standard Rates 

This tab shows published rates for the selected service.  
You cannot modify rates here, and any rules you apply 
won’t affect the rates shown in this tab. 

q Modified Rates 
This tab displays published rates for the selected service 
after rules have been applied.  You have a limited ability 
to apply some rules directly on this tab.  See Rules for 
more information.   

q Rules 
This tab is where you create, edit, and delete the rules 
that are applied to rates.  See Rules for more information. 

  

Menus The Rate Utility has 2 action menus. 
q File 

The File menu allows you to save rules to the database or 
exit the Rate Utility application. 

q Tools 
The Tools menu allows you to print the published and/or 
modified rates. 
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Rules The Rate Utility allows you to implement 5 types of rules: 
1. Flat ($) amount increase 
2. Flat ($) amount decrease 
3. Percent (%) increase 
4. Percent (%) decrease 
5. Flat ($) amount 

 
Note: Flat Amount is the only rule that may be applied directly 
on the Modified Rates tab.  
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Rate Utility Procedures 
 

View Rates You can view standard rates, modified rates, and rate rules.  

 
 

# ACTION 

1 From the StarShip main toolbar, select Carriers > Rate Utility. 

2 When the Rate Utility window appears, click the “+” next to the carrier for 
which you want to view rates.  Then, click the “+” beside the service type, 
such as Domestic, International, etc.  

3 Click on the service for which you want to view rates.  The Standard, 
Modified, and Rules tab display to the right. 
 

 
 

4 Click on the tab you want to view. 

 
 

See also Add Rules 
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Add Rules There are two ways to add rules to published rates: 
 

q Modified Rates tab 
You can directly modify fields to apply a “flat amount” 
rate rule. 

q Rules tab 
You can add all rules here. 
See Rules 
 

We’ll show you both procedures in this section. 

  

Modified 
Rates Tab 

The following steps show you how to add a flat amount rule 
using the Modified Rates tab. (This is the only tab that allows you 
to modify rates by a flat amount.) 

 

# ACTION 

1 In the Rate Utility, select the carrier/service for which you want to modify 
rates.  Click the Modified Rates tab. 

2 Click in the cell that contains the rate you want to change.  Highlight the 
amount, and type in the new amount.  Do this for each rate you want to 
change. 
 

 
 

3 When you’re finished, press the Tab key.  Then select the Rules tab to see 
the new rule(s) you applied. 
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Rules Tab The following steps show you how to add rules using the Rules 
tab.  

 

# ACTION 

1 Open the Rate Utility and select a carrier/service from the tree. 

2 On the Rules tab, click the New button. 

3 In the New Rule dialog box, select a Zone range (if applicable). 
 

 
 

4 Select the Weight range to which you want to apply the rule (if applicable). 
 

 
 

Note: The appearance of Zone and Weight range fields varies by carrier and 
service. 

5 Under Rate Change, select the type of rule to apply. 
 

 
 

6 Next, enter a new value for the rate change.  
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# ACTION 

7 If you selected Percent Increase or Percent Decrease, you can further 
define minimum and/or maximum dollar amount values for this rate 
change.  This is optional. 
Minimum Change: If the rate increase/decrease is not greater than the 
minimum change amount, then the amount you specify here is applied to 
the rate instead. 
Maximum Change: If the rate increase/decrease exceeds the maximum 
change amount, then the amount you specify here is applied to the rate. 
 

 
 

8 Click OK.  The new rule appears on the Rules tab. 
 

 
 

Repeat these steps for each new rule you want to add. 

Note: If you created Percent Increase or Percent Decrease rules with minimum 
and/or maximum values, they appear on the Rules tab, but, due to the nature 
of these rules, they are not reflected on the Modified Rates tab.  However, 
StarShip saves the rule and will apply the rate change during shipping. 

 

               Tip To view how rates are affected by the rules, click on the 
Modified Rates tab. 
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Additional 
Options 
Rules 

To add a rule to a carrier’s additional options, click the 
Additional Options under that carrier and repeat the previous 
steps for adding rules on the Rules tab.  The only difference is 
that in the New Rule dialog box, you select an option instead of 
a zone or weight.  Then enter the rate change as usual, and click 
OK. 
 

  
  

  

Change the 
Rule Order 

If you want to apply several rules to the same carrier/service rate 
area, you can set the order in which StarShip applies them.  So, 
to have one rule take precedence over another, move it higher 
in the Rules list.  
To do this, highlight the rule on the Rules tab.  Press the Up button 
to move it higher in the list, or Down to move it lower in the list.  
The selected rule is then reapplied to rates accordingly. 
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Edit Rules You can also edit an existing rule(s). 

 

# ACTION 

1 In the Rate Utility, select the carrier/service for which you want to edit rules.  
Then select the Rules tab. 

2 Select the rule you want to edit by clicking on it, and press the Modify 
button. 

3 In the dialog box, modify the settings for the rule. Click OK. 
Repeat this procedure for each rule you want to modify. 
Changes are reapplied to rates, which you can see in the Modified Rates 
tab. 

 
 

Delete 
Rules 

To delete existing rules: 

 

# ACTION 

1 In the Rate Utility, select the carrier/service for which you want to delete 
rules.  Then select the Rules tab. 

2 Click on the rule you want to delete. 

3 Press the Delete button. 
You can view how your changes affect rules on the Modified Rates tab. 
Repeat this process for each rule you want to delete. 
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Print Rates You can access the print dialog in a number of ways. 
q Select a carrier or service.  From the Tools menu, select 

Print Rates. 
q Select a carrier and right-click in the carrier/service tree. 

The print dialog displays all services for that carrier, which 
are selected by default.  

q Select a service and right-click in the carrier/service tree. 
The service is automatically selected in the print dialog. 

q Right-click in the Standard Rates tab to print standard 
rates for the currently selected service. 
The service is automatically selected in the print dialog. 

q Right-click in the Modified Rates tab to print modified 
rates for the currently selected carrier/service. 
The carrier or service is automatically selected in the print 
dialog.  The Modified Rates setting is also enabled.  If 
modified rates are the same as standard rates (i.e. no 
rules have been applied), then you cannot select 
Modified vs. Standard rates. 

 
Note: The Modified rates setting is only enabled if one of the 
“checked” carriers has rules applied to standard rates. 

  

See also For more information about print settings, see the Print Dialog 
section. 



Rate Utility   

Print Dialog 
 

 
 
 

  

Other 
Printing 
Options 

You can also print rates from the StarShip Carriers menu.  Simply 
click the Carriers menu, select the carrier, and click Print Rates. 

   

 
 
 

Select 
service 

Select all 
services 

Select 
printer 

Select the 
rates to print 

Prints your selections Exit without printing 



Rate Utility   

View Standard and/or Modified Rates in the Shipping window 
 

Overview While in the StarShip Shipping window, you can display standard 
rates, modified rates, or both simultaneously.  Rates are applied 
depending upon the shipment properties. 

 

# ACTION 

1 In the Shipping window, click the View menu.  Select the rates you want 
StarShip to display during shipping. 

 
 

2 Enter the shipment information.  Once the weight and zip code are 
entered, the rates display in the Bill tab.  If you selected Show Both Rates, 
two columns (Modified and Standard) appear in the Bill tab.   
 

 
 

See also Rate Utility Overview 
Rate Utility Procedures 
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Reports 
 

Freight 
Reports 

StarShip now provides additional standardized reports: 
 

q History Freight Report 
q Daily Freight Report 

 
To access and run these reports, click the Reports button on the 
StarShip main toolbar.  Then select the desired report from the 
Name drop-down list and click Print.  
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STARSHIP USER’S GUIDE 
APPENDIX A – KEY WORDS  

 

Key Words This appendix lists the key words that StarShip recognizes when 
interpreting input values from the Shipping window.   

Note that StarShip ignores upper/lower case letter when 
interpreting the input fields. 

  

Country StarShip looks at the Country field before interpreting the Ship 
Via/Service fields. 

 
Input Value Interpreted As 

USA, U.S.A, U.S., United 
States 

USA 

Canada Canada 

(any other value) 
Country other than the USA or Canada, select from 
the Country drop-down list. 
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Ship Via 
Values 

These tables show StarShip’s interpretation of the following Ship 
Via values: 

 
 
Carrier 
 

Input Value Interpreted As 
UPS, U.P.S UPS 

FDXG, FDX G, FEDEXG, FEDEX 
G, RPS, R.P.S 

FedEx Ground            

USPS, PARCEL POST, MAIL USPS             

FEDEX, FDX, FEDERAL FedEx Express            

AIRBORNE, AEX Airborne Express     

SPEE-DEE, SPD Spee-Dee Delivery Service        

User-Defined Short Name, 
User-Defined Long Name 

User-defined Carrier 1-10 

 
 
Contract Service 
 

Input Value Interpreted As 
(DEFAULT) STANDARD          

100, HWT, MWT UPS HWT/FDXG MWT 
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UPS Domestic 
 

Value Interpreted As 
(DEFAULT) GROUND           

3, THREE 3 DAY           

2 & AM, 2 & A.M, SECOND & 
AM, SECOND & A.M, BLUE & 
AM, BLUE & A.M 

2ND DAY A.M.     

2, SECOND, BLUE 2ND DAY          

1 & SAV, NEXT & SAV, RED & 
SAV 

NEXT DAY SAVER   

1, NEXT, RED NEXT DAY         

EARLY EARLY A.M.       

 
 
UPS Canada 
        

Value Interpreted As 
(DEFAULT) STANDARD 

EXPEDITE, BLUE EXPEDITED 

AIR, EXPRESS, RED EXPRESS 

 
 
UPS International 
      

Value Interpreted As 
(DEFAULT) EXPEDITED 

EXPRESS, RED EXPRESS   
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FedEx Ground Domestic 
 

Value Interpreted As 
(DEFAULT) GROUND 

 
 
FedEx Ground Canada 
 

Value Interpreted As 
(DEFAULT) GROUND 

 
 
USPS Domestic 
  

Input Value Interpreted As 
1ST, FIRST FIRST CLASS 

(DEFAULT) PARCEL POST 

PRIORITY PRIORITY 

PF PRIORITY FLAT 

EXPRESS EXPRESS 

BOOK, SP, 4 MEDIA MAIL        

BOUND BOUND PRINTED MATTER 
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USPS International 
 

Input Value Interpreted As 
PP SURFACE, PARCEL POST 
SURFACE, PARCEL POST, 
ECONOMY 

PARCEL POST ECONOMY 

PP AIR, PARCEL POST AIR, 
AIRMAIL 

PARCEL POST AIRMAIL      

LP SURFACE, LETTER POST 
SURFACE, LETTER POST 
ECONOMY 

LETTER POST ECONOMY      

LP AIR, LETTER POST AIR LETTER POST AIRMAIL      

PUBLISH, PERIODICAL PUBLISHERS' PERIODICALS 

EXPRESS GLOBAL EXPRESS MAIL      

PRIORITY GLOBAL PRIORITY MAIL    
 
 
USPS Options 
   

Input Value Interpreted As 
DC DELIVERY CONFIRMATION    

RRM RETURN RECEIPT FOR MDSE 

RD RESTRICTED DELIVERY 

SH SPECIAL HANDLING         

CERTIFIED CERTIFIED MAIL          

REGISTERED REGISTERED MAIL          

RETURN RETURN RECEIPT 
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FedEx Domestic 
   

Input Value Interpreted As 
XPR EXPRESS SAVER       

2, TWO, ECON 2ND DAY             

(DEFAULT) STANDARD OVERNIGHT 

PRI PRIORITY OVERNIGHT 

1ST, FIRST FIRST OVERNIGHT     

 
 
FedEx International 
  

Input Value Interpreted As 
(DEFAULT) PRIORITY OVERNIGHT 

2, ECON ECONOMY 
 
 
Airborne Domestic 
  

Input Value Interpreted As 
2, TWO, SECOND, SELECT SECOND DAY       

NEXT, AFTER NEXT AFTERNOON   

(DEFAULT) EXPRESS 
 
Airborne International 
   

Input Value Interpreted As 
(DEFAULT) EXPRESS 
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Airborne Options 
  

Input Value Interpreted As 
SATR SATURDAY RED    

SATB SATURDAY BLACK 
 
Spee-Dee 
 

Input Value Interpreted As 
(DEFAULT) GROUND 

 
 
Packaging 
 

Input Value Interpreted As 
(DEFAULT) OTHER 

LETTER, LTR LETTER 
 
 
Saturday 
   

Input Value Interpreted As 
(DEFAULT) NON-SATURDAY DELIVERY 

SAT SATURDAY DELIVERY      

 
 
Bill Freight (This is the input value of the Billing field. )  
 

Input Value Interpreted As 
RECIPIENT COLLECT, CLT 

 

Note If you are using UPS OnLine, Bill Freight=Credit Card is not available. 
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STARSHIP USER’S GUIDE 
B - FEDEX INTERNET API FIELDS TABLE 

 
 

Overview The following tables list all transactions and fields sent from 
StarShip to the FedEx Internet API.  The StarShip Source column 
indicates the location of the StarShip field.  The Transaction 
Number and Name are shown before the transaction table. 

 

007 Close Request 

 

FIELD NO. 
TAG 

FIELD NAME STARSHIP SOURCE 

0 Transaction Code Fixed value: 007 

1 
Customer Transaction 
Number 

Internally generated 

10 
Sender FedEx Account 
Number 

Carriers/ 
FedEx/Properties or FedEx Ground/Properties, 
General tab 

498 Meter Number 
Carriers/ 
FedEx/Properties or FedEx Ground/Properties, 
Internet tab 

3025 Carrier Code Ship Screen, Service tab, Carrier field 

Close 

1007 Close/Manifest Date System Date 

1366 Close/Manifest Time System Time 

1371 
Manifest Only Request 
Flag 

Y if FedEx Ground Manifest button on close 
screen or N if posting  

Transaction Terminator 

99 End of Record N/A 
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021 Ship a Package Request 

 

FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

0 Transaction Code ALL Fixed value: 021 

1 
Customer Transaction 
Number ALL Internally Generated 

10 
Sender FedEx Account 
Number 

ALL 

Carriers/ 
FedEx/Properties or  
FedEx Ground/Properties, 
General tab 

498 Meter Number ALL 

Carriers/ 
FedEx/Properties or  
FedEx Ground/Properties, 
Internet tab 

3025 Carrier Code ALL 
Ship Screen, Service tab, Carrier 
field 

Origin 

4 Sender Company ALL 
Ship screen, Sender tab, 
Company field 

32 Sender Contact Name ALL 
Ship screen, Sender tab, 
Contact field 

5 Sender Address Line 1 ALL 
Ship screen, Sender tab, Address 
1 field 

6 Sender Address Line 2 ALL 
Ship screen, Sender tab, Address 
2 field 

7 Sender City ALL 
Ship screen, Sender tab, City 
field 

8 Sender State ALL 
Ship screen, Sender tab, State 
field 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

9 Sender Postal Code ALL 
Ship screen, Sender tab, ZIP 
Code field 

10 Sender Account ALL 

Carriers/ 
FedEx/Properties or  
FedEx Ground/Properties, 
General tab 

38 Sender Department ALL 
Ship screen, Reference tab, 
Department field 

117 Sender Country Code ALL Always 'US' 

183 Sender Phone number ALL Ship screen, Sender tab, Phone 

498 Meter Number  ALL 

Carriers/ 
FedEx/Properties or  
FedEx Ground/Properties, 
Internet tab 

1139 Sender IRS EIN Number ALL 
Always blank 
  

1201 Sender E-Mail Address ALL Not Supported 

1341 Sender Pager Number ALL Not Supported 

1103 Sender Fax ALL Not Supported 

Destination 

11 Recipient Company ALL 
Ship screen, Recipient tab, 
Company field 

12 
Recipient Contact 
Name 

ALL 
Ship screen, Recipient tab, 
Attention field 

13 
Recipient Address Line 
1 

ALL 
Ship screen, Recipient tab, 
Address Line 1 field 

14 
Recipient Address Line 
2 

ALL 
Ship screen, Recipient tab, 
Address Line 2 field 

15 Recipient City ALL Ship screen, Recipient tab, 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

City field 

16 Recipient State ALL 
Ship screen, Recipient tab, 
State field 

17 Recipient Postal Code ALL 
Ship screen, Recipient tab, 
ZIP Code field 

18 
Recipient Phone 
Number 

ALL 
Ship screen, Recipient tab, 
Phone field 

50 
Recipient Country 
Code 

ALL Always 'US' 

118 
Recipient IRS EIN 
Number ALL Not Supported 

1145 Recipient Department ALL 

Ship screen, Recipient tab 
Address Line 3 (1st 10 characters, 
as that is the maximum length 
supported for this field by FedEx) 

1202 
Recipient E-mail 
address 

ALL Not Supported 

1324 
Recipient Pager 
Number 

ALL Not Supported 

2254 Recipient Fax Number ALL Not Supported 

Broker – this section not currently supported 

Importer – this section not currently supported 

Shipment Date/Time Stamp 

24 Ship Date ALL 

If Future Ship Date is checked on 
Ship screen, Package Options 
tab, then the Ship Date on the 
Future Ship Date tab will be sent; 
If not, the System Date will be 
used. 

1115 Ship Time ALL System Time 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

Payment 

20 Payer Account Number ALL 
Ship screen, Service tab, Billing 
field 

23 Pay Type ALL 
Ship screen, Service tab, 
Account field 

68 
Customs/Declared 
Value Currency Type 

ALL Fixed value "USD" 

70 Duties Pay Type FDXE Not Supported 

71 
Duties Payer Account 
Number 

FDXE Not Supported 

1032 
Duties Payer Country 
Code 

FDXE Not Supported 

1195 Payer Country Code FDXE Not Supported 

Shipment/Package Information 

25 Reference Information ALL Not Supported 

57 Dim Height ALL 
Ship screen, Service tab, Height 
("H") field 

58 Dim Width ALL 
Ship screen, Service tab, Width 
("W") field 

59 Dim Length ALL 
Ship screen, Service tab, Length 
("L") field 

72 Terms of Sale FDXE Not Supported 

73 Parties To Transaction FDXE Not Supported 

74 
Country Of Ultimate 
Destination 

FDXE Not Supported 

75 Weight Units ALL Always LBS 

1411 Total Customs Value ALL Not Supported 

190 Document Flag FDXE Not Supported 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

413 NAFTA Flag FDXE Not Supported 

1116 Dim Units ALL Always I=Inches 

1118 
Release Authorization 
Number 

FDXE 
Carriers/FedEx/Properties, 
General tab 

1273 FedEx Packaging Type ALL 
Ship screen, Service tab, 
Packaging field 

1274 FedEx Service Type ALL 

Ship screen, Service tab, Service 
field; 
Supported for FedEx Express: 
Priority, 2day, Standard 
Overnight, First Overnight, 
Express Saver; 
Supported for FedEx Ground: 
Ground, Home Delivery 

1401 Total Package Weight ALL 
Ship screen, Service tab, Weight 
field 

1415 
Declared 
Value/Carriage Value 

ALL 
Ship screen, Service tab, Insured 
Value field 

3001 
FedEx Ground 
Purchase Order 
Number 

FDXG 
Ship screen, Reference tab, P.O. 
Number field 

3002 
FedEx Ground Invoice 
Number 

FDXG 
Ship screen, Reference tab, 
Invoice/Order Number field 

3003 
FedEx Ground 
Customer Reference 
Number 

FDXG 
Ship screen, Recipient tab, 
Customer ID field 

3025 Carrier Code ALL 
Ship screen, Service tab, Carrier 
field 

COD Remittance (only passed in the 021 request transaction for a COD single-piece 
shipment 

439 COD Return Contact FDXE Setup/Company, 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

Name Company Name 2 field 

1237 COD Return Phone FDXE 
Setup/Company, 
Phone Number field 

1238 COD Return Company FDXE 
Setup/Company, 
Company Name 1 field 

1239 
COD Return 
Department 

FDXE Not Supported 

1240 COD Return Address 1 FDXE 
Setup/Company, 
Address 1 field 

1241 COD Return Address 2 FDXE 
Setup/Company, 
Address 2 field 

1242 COD Return City FDXE 
Setup/Company, 
City field 

1243 COD Return State FDXE 
Setup/Company, 
State field 

1244 COD Return Zip FDXE 
Setup/Company, 
Zip field 

Special Service – COD 

27 COD Flag ALL 
Ship screen, Package Options 
tab, "C.O.D." check box 

1409 COD Collect Amount ALL 
Ship screen, Package Options 
tab, "Package Actual Amount" 
on the "C.O.D." option tab 

186 COD Add Freight Flag ALL Always "N" 

3000 COD Collection Type ALL 
Ship screen, Package Options 
tab, C.O.D. Type field 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

Special Service – Home Delivery 
Note: for Home Delivery service, the Ship screen, Service tab, Service field must be 
"Home Delivery." You must enable Home Delivery from Carriers/Settings/FedEx 
Ground on the Internet tab. The Residential checkbox on the recipient tab must be 
checked and the ship-to ZIP code must be in the list of valid Home Delivery 
destinations provided by FedEx. 

3019 
Home Signature 
Delivery Flag 

FDXG 
Ship screen, Package Options 
tab, "Signature Required" check 
box 

3020 Home Delivery Type FDXG 

Ship screen, Package Options 
tab, "Delivery Options" check 
box. When checked, you can 
choose the Delivery Type from 
the "Home Delivery Premium 
Options" tab 

3023 Home Delivery Date FDXG 

Ship screen, Package Options 
tab, "Delivery Options" check 
box. When checked, from the 
"Home Delivery Premium 
Options" tab, choose Delivery 
Type of Date Certain and 
choose the Delivery Date from 
the drop down box below. 

3024 
Home Delivery Phone 
Number 

FDXG 
Ship screen, Recipient tab, 
Phone field 

Special Service – Alcohol – this section not currently supported 

Special Service – Hold at Location 

44 HAL Address FDXE 
Ship screen, Package Options 
tab, Address field on the "Hold At 
Location" option tab  

46 HAL City FDXE 
Ship screen, Package Options 
tab, City field on the "Hold At 
Location" option tab 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

47 HAL State FDXE 
Ship screen, Package Options 
tab, State field on the "Hold At 
Location" option tab 

48 HAL Postal Code FDXE 
Ship screen, Package Options 
tab, ZIP Code field on the "Hold 
At Location" option tab 

49 HAL Phone Number FDXE 
Ship screen, Package Options 
tab, Phone field on the "Hold At 
Location" option tab 

1200 HAL Flag FDXE 
Ship screen, Package Options 
tab, "Hold At Location" check 
box 

Special Service – Dangerous Goods 

1331 Dangerous Goods Type FDXE 

Ship screen, Package Options 
tab, "Dangerous Goods" check 
box. Choose Accessible or 
Inaccessible from the 
"Dangerous Goods" option tab  

Special Service – Dry Ice 

1406 Dry Ice Weight FDXE 
Ship screen, Package Options 
tab, Weight field on the "Dry Ice" 
option tab 

1268 Dry Ice Flag FDXE 
Ship screen, Package Options 
tab, "Dry Ice" check box 

Special Service – Ship Alert 

1203 
Ship Alert Optional 
Message ALL 

Ship Screen, Package Options 
Tab, Memo field for Ship Alert 1 
or Ship Alert 2 



B - FedEx Internet API Fields Table   

FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

1204-# 
Ship Alert E-mail 
Address 

FDXE 

1204-1 is Ship Screen, Package 
Options Tab, E-Mail field for Ship 
Alert 1 option; 
1204-2 is Ship Screen, Package 
Options Tab, E-Mail field for Ship 
Alert 2 option 

1204-1 
Ship Alert E-mail 
Address 

FDXG 
Ship Screen, Package Options 
Tab, E-Mail field if Ship Alert 1 is 
checked and E-Mail is selected 

1206 
Ship Alert Notification 
Flag 

ALL 
Ship Screen, Package Options 
Tab, Ship Alert 1 or Ship Alert 2 is 
checked 

Special Service – Other 

51 Signature Release Flag FDXE 
Ship Screen, Package Options 
tab, "Signature Release" check 
box 

440 
Residential Delivery 
Flag 

FDXG 
(FDXE only for 

Freight 
services) 

Ship Screen, Recipient tab, 
Residential check box 

1119 
Future Day Shipment 
Flag 

ALL 
Ship Screen, Package Options 
tab, "Future Day Ship" check box 

1120 Inside Pickup Flag FDXE Not Supported 

1121 Inside Delivery Flag FDXE Not Supported 

1174 BSO Flag FDXE Not Supported 

1208 
No Indirect Delivery 
Flag 

FDXE Not Supported 

1248 Sunday Delivery Flag FDXE 
Ship Screen, Package Options 
tab, "Sunday Delivery" check box 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

1266 Saturday Delivery Flag FDXE 
Ship Screen, Package Options 
tab, "Saturday Delivery" check 
box 

1267 Saturday Pickup Flag FDXE 
Ship Screen, Package Options 
tab, "Saturday Pickup" check 
box 

1333 Drop Off Type FDXE Always "Regular Pickup" 

3008 Autopod Flag FDXG 
Ship Screen, Package Options 
tab, "Auto Proof of Deliv" check 
box 

3009 AOD Flag FDXG 
Ship Screen, Package Options 
tab, "Acknowledge Deliv" check 
box 

3018 
Nonstandard Container 
Flag 

FDXG 
 

Ship screen, Package Options, 
"Additional Handling" option 

Forms/Printers 

113 
Commercial Invoice 
Flag 

FDXE Not Supported 

1368 Label Type ALL Always 1 (Standard label) 

1369 Label Printer Type ALL Based on printer settings 

1370 Label Media Type ALL Based on printer settings  

Commodity – this section not currently supported 

Commercial Invoice – this section not currently supported 

Transaction Terminator – this section not currently supported 

99 End of Record ALL N/A 
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022 Rate a Package Request  

 

FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

0 Transaction Code ALL Fixed value: 022 

1 
Customer Transaction 
Number ALL Fixed value: 100022 

10 
Sender FedEx Account 
Number 

ALL 

Carriers/ 
FedEx/Properties or 
FedEx Ground/Properties, 
General tab 

498 Meter Number ALL 

Carriers/ 
FedEx/Properties or 
FedEx Ground/Properties, 
Internet tab 

3025 Carrier Code ALL 
Ship Screen, Service tab, 
Carrier field 

Origin 

8 Sender State ALL 
Ship screen, Sender tab, State 
field 

9 Sender Postal Code ALL 
Ship screen, Sender tab, ZIP 
Code field 

117 Sender Country Code ALL Always 'US' 

Destination 

16 Recipient State ALL 
Ship screen, Recipient tab, 
State field 

17 Recipient Postal Code ALL 
Ship screen, Recipient tab, ZIP 
Code field 

50 
Recipient Country 
Code ALL Always 'US' 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

Shipment Date/Time Stamp 

24 Ship Date ALL 

If Future Ship Date is checked 
on Ship screen, Package 
Options tab, then the Ship 
Date on the Future Ship Date 
tab will be sent. If not, the 
System date is used. 

Payment 

23 Pay Type ALL 
Ship screen, Service tab, 
Account field 

1195 Payer Country Code FDXE Not Supported 

Shipment/Package Information 

57 Dim Height ALL 
Ship screen, Service tab, 
Height ("H") field 

58 Dim Width ALL 
Ship screen, Service tab, Width 
("W") field 

59 Dim Length ALL 
Ship screen, Service tab, 
Length ("L") field 

68 
Customs/Declared 
Value Currency Type 

ALL Fixed value: always 'USD' 

75 Weight Units ALL Always LBS 

116 Package Total ALL Always 1 

1116 Dim Units ALL Always I=Inches 

1273 FedEx Packaging Type ALL 
Ship screen, Service tab, 
Packaging field 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

1274 FedEx Service Type ALL 

Ship screen, Service tab, 
Service field; 
Supported for FedEx Express: 
Priority, 2day, Standard 
Overnight, First Overnight, 
Express Saver; 
Supported for FedEx Ground: 
Ground, Home Delivery 

1401 Total Package Weight ALL 
Ship screen, Service tab, 
Weight field 

1415 
Declared 
Value/Carriage Value 

ALL 
Ship screen, Service tab, 
Insured Value field 

Special Service 

27 COD Flag ALL 
Ship screen, Package Options 
tab, "C.O.D." check box 

186 COD Add Freight Flag ALL Always "N" 

440 
Residential Delivery 
Flag 

FDXG 
(FDXE only for 

Freight services) 

Ship Screen, Recipient tab, 
Residential check box 

1120 Inside Pickup Flag FDXE Not Supported 

1121 Inside Delivery Flag FDXE Not Supported 

1174 BSO Flag FDXE Not Supported 

1200 HAL Flag FDXE 
Ship screen, Package Options 
tab, "Hold At Location" check 
box 

1248 Sunday Delivery Flag FDXE 
Ship Screen, Package Options 
tab, "Sunday Delivery" check 
box 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

1266 Saturday Delivery Flag FDXE 
Ship Screen, Package Options 
tab, "Saturday Delivery" check 
box 

1267 Saturday Pickup Flag FDXE 
Ship Screen, Package Options 
tab, "Saturday Pickup" check 
box 

1268 Dry Ice Flag FDXE 
Ship screen, Package Options 
tab, "Dry Ice" check box 

1331 Dangerous Goods Type FDXE 

Ship screen, Package Options 
tab, "Dangerous Goods" check 
box. Choose Accessible or 
Inaccessible from the 
"Dangerous Goods" option tab 

1409 COD Collect Amount ALL 
Ship screen, Package Options 
tab, "Package Actual Amount" 
on the "C.O.D." option tab 

3000 COD Collection Type ALL 
Ship screen, Package Options 
tab, C.O.D. Type field 

3019 
Home Signature 
Delivery Flag 

FDXG 
Ship screen, Package Options 
tab, "Signature Required" 
check box 

3020 Home Delivery Type FDXG 

Ship screen, Package Options 
tab, "Delivery Options" check 
box. When checked, you can 
choose the Delivery Type from 
the "Home Delivery Premium 
Options" tab 

1333 Drop Off Type FDXE Always "Regular Pickup" 

3008 Autopod Flag FDXG 
Ship Screen, Package Options 
tab, "Auto Proof of Deliv" 
check box 
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FIELD NO. 
TAG 

FIELD NAME 
APPLICABLE 

CARRIER 
STARSHIP SOURCE 

3009 AOD Flag FDXG 
Ship Screen, Package Options 
tab, "Acknowledge Deliv" 
check box 

3018 
Nonstandard Container 
Flag ALL 

Ship screen, Package Options, 
"Additional Handling" option 

3035 Ship Alert Fax Number FDXG 
Ship Screen, Package Options 
Tab, Fax Number field for Ship 
Alert 1 option 

Transaction Terminator – this section not currently supported. 

99 End of Record ALL N/A 
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023 Delete a Package Request 

 

FIELD NO. 
TAG FIELD NAME STARSHIP SOURCE 

0 Transaction Code Fixed value: 023 

1 
Customer Transaction 
Number 

Internally generated 

10 
Sender FedEx Account 
Number 

Carriers/ 
FedEx/Properties or FedEx Ground/Properties, 
General tab 

498 Meter Number 
Carriers/ 
FedEx/Properties or FedEx Ground/Properties, 
Internet tab 

3025 Carrier Code Ship Screen, Service tab, Carrier field 

Tracking 

29 Tracking Number Ship Screen, Detail tab, Tracking # field 

Transaction Terminator 

99 End of Record N/A 

 
 

211 Subscribe Request 
 

FIELD NO. 
TAG 

FIELD NAME STARSHIP SOURCE 

0 Transaction Code Fixed value: 211 

1 
Customer Transaction 
Number Internally generated 

10 
Sender FedEx Account 
Number 

Carriers/FedEx/Properties or  
Carriers/FedEx Ground/Properties, General tab 
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FIELD NO. 
TAG 

FIELD NAME STARSHIP SOURCE 

Subscriber 

4003 
Subscriber Contact 
name 

Setup/Preferences/Company tab,  
Contact Name field 

4007 
Subscriber Company 
Name 

Setup/Preferences/ Company tab,  
Company Name field 

4008 
Subscriber Address Line 
1 

Setup/Preferences/Company tab,  
Address 1 field 

4009 
Subscriber Address Line 
2 

Setup/Preferences/Company tab, 
Address 2 field 

4011 Subscriber City Name Setup/Preferences/Company tab, City field 

4012 Subscriber State Code Setup/Preferences/Company tab, State field 

4013 Subscriber Postal Code Setup/Preferences/Company tab, ZIP field 

4014 
Subscriber Country 
Code Always 'US' 

4015 
Subscriber Phone 
Number 

Setup/Preferences/Company tab, Phone 
Number field 

4017 
Subscriber Pager 
Number 

Not supported 

4018 
Subscriber Email 
Address 

Not supported 

4022 Subscriber Fax Number Not supported 

Transaction Terminator 

99 End of Record N/A 
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STARSHIP USER’S GUIDE 
C – INSTALL DIAL-UP NETWORKING (RAS) 

 

Overview RAS must be installed before FXRS can be installed. If RAS is not 
installed, follow the steps below.   

 

# ACTION 

1 On the Windows desktop, click the Start button. 

2 Select Programs > Accessories > Dial Up Networking. 

3 At the Dial-Up Networking window, click Install. 

4 Place the CD in the CD-ROM drive when prompted. 

5 Close the Windows NT window when it appears. 

6 At the Files Needed window, click OK. 

7 At the Add RAS Device window, click OK. 

8 When the Remote Access Setup window appears, click Configure. 

9 Select Dial-Out from the Port Usage section. 

10 Click OK. 

11 Click Network. 

12 Deselect the:  

• IPX check box in the Dial out Protocols section; 

• IPX check box in the FXRS Settings section. 

13 Click OK. 

14 At the RAS Server TCP/IP Configuration window, click Cancel. 

15 Click Continue. Then, click Restart. 
 

See also Go back to FSM Server Installation Notes 
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[BETA] The following terms have been utilized in this User’s Guide. 

 
 

AA  
adapter. An adapter is often built into a card that can be inserted 

into a slot on the computer's motherboard. 
AutoPrint. A StarShip feature that allows you to set up a carrier 

form (label, COD tag, etc) to automatically print when 
you save a shipment. Also available when editing, 
deferring, or undeferring shipments. 

 
 

BB  
CC  

 
 

DD  
dedicated phone line. A dedicated line is a telecommunications path between 

two points that is available 24 hours a day for use by a 
designated user (individual or company). 

 
 

EE  
ethernet. Ethernet is a physical and data link layer technology for 

LAN networking. See also Adapter 
 
 
 
 
 



Terms   
 
 
 

FF  
FSM Server. The FSM Server (FedEx Ship Manager Server) is current 

FedEx software that transparently processes a FedEx 
shipment, validates it, performs freight calculations, 
assigns a tracking number and routing code, and prints 
a shipping label.  It then sends all information 
calculated on the shipment back to StarShip.  StarShip 
updates the shipment with the freight and tracking 
number and completes the “Save” operation.   When a 
shipment is modified or deleted from StarShip, the FSM 
Server is also updated. 
 

FXRS. FedEx Remote Server, former name of the FSM Server. 
 
 

GG  
GTC. StarShip uses the GTC (Generic Transaction 

Coordinator) to process carrier transactions. You should 
only install the GTC on one computer. 

  
HH  

 
 

II  
IP address. An identifier for a computer or device on a TCP/IP 

network. Networks using the TCP/IP protocol route 
messages based on the IP address of the destination. 
The format of an IP address is a 32-bit numeric address 
written as four numbers separated by periods. Each 
number can be zero to 255. For example, 1.160.10.240 
could be an IP address. 

 
 

JJ  
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KK  
  
LL  

LAN. A local area network (LAN) is a group of computers 
and associated devices that share a common 
communications line and typically share the resources 
of a single processor or server within a small 
geographic area (for example, within an office 
building). Usually, the server has applications and data 
storage that are shared in common by multiple 
computer users. 

 
 

MM  
Modem driver. See testing notes 

 
 

NN  
NetBEUI. NetBEUI (NetBIOS Extended User Interface) is a new, 

extended version of NetBIOS, the program that lets 
computers communicate within a local area network. 

 
 

OO  
 
 

PP  
port number. In TCP/IP networks, a port is an endpoint to a logical 

connection. The port number identifies what type of 
port it is. 

proxy server. A server that sits between a client application, such as a 
Web browser, and a real server. It intercepts all requests 
to the real server to see if it can fulfill the requests itself. 
If not, it forwards the request to the real server. 
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QQ  
 
 

RR  
RAS. Short for Remote Access Services, a feature built into 

Windows NT that enables users to log into an NT-based 
LAN using a modem, X.25 connection or WAN link. 
RAS works with several major network protocols, 
including TCP/IP, IPX, and Netbeui.  
 
To use RAS from a remote node, you need a RAS client 
program, which is built into most versions of Windows, 
or any PPP client software. For example, most remote 
control programs work with RAS. 

reboot. To restart the computer. 
 
 

SS  
Schedule B. Schedule B is a statistical classification of domestic and 

foreign commodities that are exported from the United 
States. All of these commodities must be assigned a ten-
digit Schedule B number. The first 6 digits of the 
Schedule B number are Harmonized. The harmonized 
system is a worldwide classification method in which 
the same 6-digit number is assigned to a good 
regardless of its origin or the language in which it is 
described. 

surge protector. A device that protects a power supply and 
communications lines from electrical surges. All 
computers come with some surge protection built into 
the power supply, but it is a good idea to purchase a 
separate device. 
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TT  
TCP/IP. Transmission Control Protocol/Internet Protocol, the suite 

of communications protocols used to connect hosts on 
the Internet. 

 
 

UU  
UNC. The UNC (Uniform Naming Convention) format is used 

in IBM PC networking to completely specify a directory 
on a file server.  The basic format is:   
\\servername\sharename 
where “servername” is the hostname of the network file 
server, and “sharename” is the name of a networked or 
shared directory. 
 

URSA file. A monthly file used by the server for routing packages. 
 
 

VV  
WW  
XX  
YY  
ZZ  

 
 
 
 
 
Sources http://whatis.techtarget.com/ 

 
http://www.webopedia.com/ 
 
V-Technologies, LLC 

 

http://whatis.techtarget.com/definitionsCategory/0,289915,sid9,00.html
http://www.webopedia.com/
http://www.vtechnologies.com
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